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Chapter 1. Introduction

IBM OpenLink is a data integration, transformation, cleansing, and maintenance
platform that reduces the complexity of integrating back office applications with
the IBM Omni-Channel Merchandising suite.

IBM OpenLink is a data integration, transformation, cleansing, and maintenance
platform that reduces the complexity of integrating back office applications with
the IBM Omni-Channel Merchandising suite.

IBM OpenLink allows DBAs, Pricing Analysts, and Pricing Managers to:
v Integrate to back-office applications and data warehouses seamlessly
v Import, validate, and approve data files provided in customer-specific format
v Aggregate or parse categories to analyze cross-category cannibalistic or

complementary relationships
v Content cleanse products to create more accurate data
v Demand model categories to produce coefficients used in predicting optimized

results
v Deliver prices to stores efficiently with minimal user intervention

Related Topics

“Audience”
“Prerequisite Knowledge”
“Translations” on page 2
“Screen Captures and Illustrations” on page 2
“Before You Begin” on page 2
“System Requirements” on page 2
“Logging Into OpenLink” on page 4

Audience
IBM OpenLink is designed for four primary audiences: Merchandising Executives,
Category Managers, Account Representatives, and IT Administrators.

IBM OpenLink is designed for four primary audiences: Merchandising Executives,
Category Managers, Account Representatives, and IT Administrators.

Prerequisite Knowledge
Refer to this section for prerequisite knowledge for using IBM OpenLink.

You should have some experience using web browsers, the internet, and the
Microsoft Windows operating systems. You should be comfortable with navigating
through menus, using a variety of buttons, working with spreadsheets and reports,
and navigating through web pages.

As you work through the concepts and tasks, it is assumed that you are familiar
with Microsoft Excel.

© Copyright IBM Corp. 2002, 2016 1



Translations
IBM® Openlink is available in multiple national language versions.

The Openlink application interface is available in the following national languages:
v Brazilian Portuguese
v Chinese
v French
v German
v Japanese
v Russian
v Spanish

IBM OpenLink is multicurrency and supports international currencies in the
localized versions.

Screen Captures and Illustrations
The screen captures and illustrations are intended to provide a visual
representation of what you may see when using this product.

The screen captures and illustrations are intended to provide a visual
representation of what you may see when using this product. They may vary
depending on your platform, or how your system is customized. It is therefore
recommended that you consider these illustrations as examples.

Before You Begin
Before you begin using OpenLink, make sure that you review the requirements for
your system.

Before you begin using OpenLink, make sure that you review the requirements for
your system.

Related Topics

“System Requirements”
“About IBM Omni-Channel Merchandising Services” on page 3

System Requirements
Use this reference to learn about the standard system requirements for using IBM
Omni-Channel Merchandising services.

The following details standard system requirements for using the IBM
Omni-Channel Merchandising services.

Note: These resource requirements apply to the IBM Omni-Channel Merchandising
services only. Running other applications simultaneously may negatively affect
system performance. You may need to refer to their requirements and make
additional adjustments on your computer.

Minimum Recommended Not Supported
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RAM 1 GB 1.5 GB < 1 GB

CPU 1 Ghz 2 Ghz < 900 Mhz

Free Disk Space 50 MB 100 MB < 50 MB

OS Windows XP Windows XP or
Windows 7

Non-Windows,
Windows 2000,
Windows 95/ME,
Windows 8

Browser* Internet Explorer 11

The browser must
have support for 128
bit encryption
enabled.

Internet Explorer 11,
or Mozilla Firefox

The browser must
have support for
128-bit encryption
enabled.

Netscape, Internet
Explorer 11 in
Enterprise Mode,
Internet Explorer 10
or lower, Opera,
Safari

Export Applications Adobe Acrobat
Reader 7

MS Office 2002 (XP)
(Excel .xls file format)

Adobe Acrobat
Reader 7 or higher

MS Office 2003 or MS
Office 2007

(Excel .xls or .xlsx file
format)

Adobe Flash Adobe Flash 10.3.181 Adobe Flash 11 or
higher

Adobe Flash 9 or
lower

Screen Resolution 1024 x 768 1024 x 768 > 1900 x 1200

Connection T1 T1 Dial-up, less than T1

Mouse Two-button Three-button with
scroll feature

-

Note: These browsers are certified and supported for Microsoft Windows
operating systems only.

About IBM Omni-Channel Merchandising Services
The performance of IBM OpenLink can be impacted by the following.

IBM Omni-Channel Merchandising services are accessed through the web browser.
Each time a button is clicked in OpenLink, you are sending a request for data via
the World Wide Web. As such, the speed of OpenLink can be impacted by the
following:
v Volume on the web
v Bandwidth of the retailer's network
v Firewalls or other web-accessibility restrictions imposed by the retailer
v Number of rows displayed on a page

Related Topics

“Displaying Your Corporate Logo”

Displaying Your Corporate Logo
IBM can display your corporate logo, or corporate branding, on the top right-hand
corner of every application page.
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IBM can display your corporate logo, or corporate branding, on the top right-hand
corner of every application page. This adds a more personal feel to the
applications. To request to display your logo, open a Technical Support issue with
the image file attached.

Use the following guidelines for formatting the image file before sending:
v The logo should not be any larger than 24 pixels high.
v All white space around the logo should be removed.
v The background of the logo should preferably be transparent, or can be white.
v GIF and JPG are the preferred image formats.

IBM may make slight adjustments to the image to ensure that it is well-balanced
and visually appealing on the application pages.

Logging Into OpenLink
Before you start using IBM OpenLink, you must first log into the IBM
Omni-Channel Merchandising system with your user name and password.

About this task

Before you start using IBM OpenLink, you must first log into the IBM
Omni-Channel Merchandising system with your user name and password.

If you are a new user without log in information, you can open a support case
from the log in page to request a user name and default password. Support will
generate a unique user name based on the email address that you submit to IBM.
After logging in with the password provided by Support, you will be prompted to
change your default password before continuing. See “Logging in as a New User”
on page 7 for more information.

Note: To comply with your security requirements, IBM Customer Support will
specify a range of computer IP addresses from where users in your organization
can log in to IBM Omni-Channel Merchandising. Any user attempting to log in
from an IP address that is not in the permitted list of IP addresses will be denied
access to all IBM Omni-Channel Merchandisingapplications. Contact Customer
Support for more information.

To start OpenLink:

Procedure
1. Open Internet Explorer.
2. Enter the IBM Omni-Channel Merchandising Products web address

(https://mydt.demandtec.com or https://companyname.demandtec.com) in
the address field in the browser, and press Enter. The log in page will display.
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3. Enter your user name and default password in the log in page, and click Log
in. If you have forgotten your password, see “Resetting Your Password” on
page 10.

4. The My Account page opens where you are required to change your default
password to a password with the following requirements:
v At least eight characters
v At least one letter
v At least one number (0 - 9)
v At least one symbol (!@#$%^_+- ={}[]:;?|) (recommended, but not required)

5. Re-enter your password in the Enter Again field.
6. Select a security question, and provide an answer for your question. The

answer must have at least four characters.
7. Click Save. In the confirmation page that appears, click the Continue to login

link to navigate back to the log in page.
8. Enter your user name and new password in the log in page, and click Log in.

If you have access to only one company instance (organization), you will be
navigated to one of the following pages:
v IBM Omni-Channel Merchandising Home page

Chapter 1. Introduction 5



v Deal Management Home page for Deal Management users
v My Account page for both types of users where the user can select

Promotion Planning and Management. See “My Account Page” on page 10
for more information about this page.

However, if you have access to more than one organization, an initial Select
Organization page will show the organizations that you can access. After
selecting an organization, you will then be navigated to one of the pages
listed above.

Note:

v For security purposes, you will be required to change your password after
every 13 weeks. If it is not changed, you will be locked out from using the
log in page, and you will need to contact Customer Support for further
instructions.

v IBM recommends that you bookmark the IBM Omni-Channel
Merchandising Home page to your Internet Explorer Favorites. You can
also bookmark a Customer Trade Planning page. When you select a page
from your list of Favorites, you will be navigated directly to that page after
logging in.

9. In the IBM Omni-Channel Merchandising Home page, click Price,
Promotion, Markdown, or OpenLink in the primary navigation drop-down to
open an application.

10. Click Admin to navigate to overview pages that contain links to
administrative tasks and components common to all the applications.

Related Topics

“Logging in as a New User” on page 7
“Resetting Your Password” on page 10
“My Account Page” on page 10
“Logging Out of IBM OpenLink” on page 11
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Logging in as a New User
If you do not have your log in information, you will need to sign up for a new
IBM Omni-Channel Merchandising Network ID from the login page.

About this task

If you do not have your log in information, you will need to sign up for a new
IBM Omni-Channel Merchandising Network ID from the login page. After signing
up for a new account, the Customer Support team will enable your account to
access Promotion and any other services your company has purchased and enabled
for you.

To sign up for a new account:

Procedure
1. Open Internet Explorer.
2. Enter the IBM Omni-Channel Merchandising Products web address

(https://mydt.demandtec.com or https://companyname.demandtec.com) in
the address field in the browser, and press Enter. The IBM Omni-Channel
Merchandisingsystem log in page will display.
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3. Click the New User Login Request link to request a new account.

4. Enter your contact information, company, and work e-mail address. IBM will
send all account-related information to the e-mail address you provide.
Choose the Login ID you will use to log in to IBM Omni-Channel
Merchandising services.

5. Click Submit to create your new account. After submitting your request, you
should receive an e-mail with a temporary password for your account at the
e-mail address you provided.

6. Read the Terms of Use and click I Agree to continue creating your account.
You will then be asked to change your password and set a security question.
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7. Change your randomly generated password, choosing a new password that
meets the following requirements:
v At least eight characters
v At least one letter
v At least one number (0 - 9)
v At least one symbol (!@#$%^_+- ={}[]:;?|) (recommended, but not required)

8. Re-enter your password in the Enter Again field.
9. Select a security question and provide an answer for it. The answer must have

at least four characters.
10. Click Save. In the confirmation page that appears, click the Continue to login

link to navigate back to the login page.
11. Enter your user name and new password in the log in page, and click Log in.
12. Once your account has been created, Support will be automatically notified,

and will provision your account with all appropriate application permissions.
Once this provisioning process is complete, you will receive an e-mail at the
address associated with your account.

Note:

v For security purposes, you will be required to change your password after
every 13 weeks. If it is not changed, you will be locked out from using the
log in page, and you will need to contact Customer Support for further
instructions.

v We recommend that you bookmark the IBM Omni-Channel Merchandising
Home page to your Internet Explorer Favorites. You can also bookmark a
IBM Omni-Channel Merchandising Service page. When you select a page
from your list of Favorites, you will be navigated directly to that page after
logging in.

13. In the IBM Omni-Channel Merchandising Home page, click the OpenLink
section in the primary navigation drop-down to open IBM OpenLink.

14. Click Data or Admin to navigate to overview pages that contain links to
administrative tasks and components common to all the applications.
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Resetting Your Password
Use this procedure to reset your current password.

About this task

To reset your current password:

Procedure
1. In the IBM Omni-Channel Merchandising log in page, click Forgot Password.

The Recover Password page displays.

2. Enter your user name and type the words in the CAPTCHA image, then click
Send New Password.

Note: If your user name is not recognized or if you are not able to receive
e-mail at the specified address, you will need to contact IBM Customer
Support.

3. Check your e-mail Inbox for a temporary account password. After you log in
with your temporary password, you will be required to choose a new password
for your account.

My Account Page
The My Account page is where you can change or modify information related to
your account.

About this task

Once logged in, the My Account page is where you can change or modify
information related to your account. For example, if you have access to several
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instances, you can switch to a different instance. You can also open a IBM
Omni-Channel Merchandising service from the list of available products for the
instance.

Note: Several browser windows may be open at a time but all windows will be
accessing the same instance. You cannot access two instances at the same time in a
session.

The page includes these additional links:
v An Edit link is located next to Security settings to enable you to change your

existing password or security questions, while remaining logged in to IBM.
v A Support link is located on the far right side of the My Account page that

opens the web support site for entering support tickets for IBM Customer
Support.

To change instances or services:

Procedure
1. Click the My Account link at the top of the page to open the My Account

page.

2. To change the instance, click the Change link next to Current instance. You will
return to the Select Instance page to select a different instance.

3. To switch to a different IBM Omni-Channel Merchandising application, select a
service from the My products list. You will be navigated to the initial page of
the application.

Logging Out of IBM OpenLink
You can exit IBM OpenLink by simply clicking the Logout link at the top of any
page.
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You can exit IBM OpenLink by simply clicking the Logout link at the top of any
page. All saved settings will be preserved for the next log in. After logging out,
you will return to the initial log in page.

If you close the browser window or navigate to a different web page instead of
logging out, you will be automatically logged out after 30 minutes of inactivity,
and will need to log back in from the log in page.

Note: IBM Customer Support can configure a different session timeout value, such
as 15, 60, 120, or 180 minutes based on your organization's usage patterns and
security policies.

Note: You should log out when you are not using the applications to maintain
security and free up system resources.

OpenLink Overview Page
The Overview page displays all of the functionality within the OpenLink
application, groups the functionality by sub-type, and provides a description of
each function.

When you choose OpenLink from the services drop-down menu, you are
navigated to the OpenLink Overview page. The Overview page displays all of the
functionality within the OpenLink application, groups the functionality by
sub-type, and provides a description of each function. You can also access the same
pages from the OpenLink drop-down menu.

Note that this guide only discusses the pages and tasks necessary for the product
attributing process. Attributing is a series of tasks to prepare the product
information for the modeling and optimization processes.
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Importing Data
Use this procedure to import data into IBM OpenLink.

About this task

Data is imported into IBM OpenLink using these methods:

Procedure
1. Data (in text .txt files) is received through the IBM OpenLink application. This

is the most common method for importing new data. Customers send their
data to IBM Omni-Channel Merchandising each week (through FTP) for sales,
locations, products, competitive prices, and product cost changes. This data is
received in OpenLink, which uses automated validations to ensure data
cleanliness. There is very little manual, or user, intervention in these files. The
imported files are monitored using the Import Dashboard report. See “Viewing
Import and Export Activity” on page 14 for more information.
Larger sets of data should be sent through OpenLink to take advantage of
automated data accuracy screening. OpenLink is a tool used to prevent
inaccurate or corrupted data from entering the applications. The data is put
into a standard format and then validated. The validation checks for errors, and
flags the errors. The errors are fixed, and validation is run again. The final
output from this process is clean and accurate data.

2. The Product Information File (PIF) export/import process. This process allows
you to export the PIF in OpenLink to an MS Excel file, attribute the products,
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and re-import the information back to the system. See Chapter 4, “Attributing
Overview,” on page 77 for more details.
Related Topics

“Viewing Import and Export Activity”

Viewing Import and Export Activity
Using OpenLink to import and export files in IBM Omni-Channel Merchandising
enables you to manage data files automatically, updating product information as it
becomes available.

Using OpenLink to import and export files in IBM Omni-Channel Merchandising
enables you to manage data files automatically, updating product information as it
becomes available. As your imports and exports become more complex, tracking
them can be a complex task.

To address this challenge, OpenLink includes intuitive import and export
dashboards, which provide visibility into scheduled and on-demand data transfer
activities.

Note: The Import Dashboard page replaces the Imports, Approved Imports, and
File Upload pages in versions 10.1 and earlier.

You can control the cadence and setup of various batch imports using the Import
Data Control page. This report displays the file patterns, volumes, historical
ranges, data load time thresholds, and other import information. Contact your IBM
Representative for more information about accessing and using this page.

Related Topics

“Import Dashboard”
“Export Dashboard” on page 16

Import Dashboard
The Import Dashboard consolidates all import-related status information onto one
page, while allowing for single-file upload.

The Import Dashboard consolidates all import-related status information onto one
page, while allowing for single-file upload via the Import File button. The
dashboard shows the real-time status of each import process currently running, as
well as successes, failures, and import characteristics of previous imports:
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As each file is processed by OpenLink, you can use the Import Dashboard to view
batch status, import process, and any errors that might have occurred during
import. The dashboard is a read-only grid containing information about each
import. This grid contains the following columns:
v Batch Type: The data type of the data file that is in the pipeline
v Filename: The filename of the data file
v Batch Status: The state of the data in the pipeline. The values of the status

should be:
v Received: The file has been transferred into the appropriate OpenLink folder but

has not been picked up by the data load process. There is no batch associated
with this file.

v Ready for Load (Manual): This sub-status should show if the file was manually
loaded via the ‘Import File’ button.

v Processing: The file has been picked up by the data loading process and is
currently in progress.

v Sub status: Sub–status information within Processing can also be shown.
Example: Processing – Validation, Processing – DB load.

v Loaded: The file has been successfully loaded into the database. All the records
have been successfully loaded.

v Loaded with Errors: Some of the records in the file were not loaded into the
database but there were other records that did load successfully. The rejected
records are available in the reject file.

v Failed: No records were loaded into the database. This state is a result of a Level
1 error.

v Staging Batch Id: The batch ID, if available, for the data file. If the file has not
been marked for loading, this field will be empty.

v Total Records: The total number of records in the data file that was received
v Total Rejected: The total number of records rejected due to errors
v Level 1 Errors: Number of records that caused major errors resulting in a failed

import
v Level 2 Errors: Number of records that caused serious errors, resulting in a

failure to load those records
v Level 3 Errors: Number of records with minor errors, resulting in warnings
v Start Date: Date and time when the data file was picked up by the data load

process
v End Date: Date and time when the data load process for the file completed
v Load Time: The total elapsed time in minutes between the Start Date and End

Date
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v Avg. Load Time: The average load time for data of the same type based on the
last N data loads weighted by the number of records in the data file. ‘N’ is a
configurable value that is set in the Import Data Control page for each data
type. This is an optional field that is not visible in the dashboard by default but
can be added through the Edit Preferences page.

v Volume Variance: The difference in the number of records between the input file
and the average number of records for the same data type in the last N data
loads. This is an optional field that is not visible in the dashboard by default but
can be added through the Edit Preferences page.

v Approved By: The username that initiated the data load process. If the process
was automated, the user will be ‘Internal User’.
Related Topics

“Importing Data” on page 13

Export Dashboard
The Export Dashboard shows all export activity from OpenLink, allowing you to
monitor your company’s scheduled and on-demand exports

The Export Dashboard shows all export activity from OpenLink, allowing you to
monitor your company’s scheduled and on-demand exports. To view the Export
Dashboard, navigate to OpenLink > Export Dashboard. The basic dashboard view
is shown below:

All fields in the Export Dashboard page are read-only. The dashboard is comprised
of the following columns:
v Type: The export type: Price, Promotion Details, Markdown, etc.
v Export Name: The user-defined name or description for the export
v Division: The division that is attached to the export
v Status: The state of the data in the pipeline. The Status column may display

several values:
v Scheduled: The export has been scheduled but not yet executed
v Extracting: The export is extracting data from the database
v Exported: The data has been extracted from the DB and any post-processing

scripts attached to the exports have been successfully executed
v Error: The export failed
v # Records: The total number of records exported
v Start Time: Date and time when the export started
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v End Time: Date and time when the export completed
v Elapsed Time: The total elapsed time in minutes between the Start Date and

End Date
v Exported By: The username that initiated the data export process. If the process

was automated, the user will be ‘Internal User’.

“Exporting data” on page 75

“Checking export status” on page 76

User administration permissions
User administration permissions are listed here.
v Administer Calendar Period Definitions - Allows users to modify default

calendar periods in the Calendar Administration section of the Admin page,
and to upload new calendar period definition files.

v Administer Company Wide UI Preferences- Allows the user to set default
report settings in the Edit Report pages for all users within a company.

v Administer Display Setup - Allows the user to load display templates,
configure the Display Planning tool, and manage display characteristics.

v Administer Job Scheduler - Allows the user to edit jobs in the Job Scheduler
queue. These are the behind-the-scenes processes that run.

v Administer Notification Aliases- Allows the user to create, delete, or edit
notification aliases for groups of users to receive alerts.

v Administer Organization - Allows IBM Omni-Channel Merchandising Support
and IBM Omni-Channel Merchandising Operations to set up a new company
and edit company information.

Note: Administer Organization should be selected for IBM Omni-Channel
Merchandising Support and IBM Omni-Channel Merchandising Operations users
only. The application may be unstable if the database properties are set
improperly.

v Administer Task Scheduler - Allows the user to create and manage tasks in the
Task Scheduler.

v Edit Permissions - Allows the user to edit all user permissions. At least one user
in each organization must have this function.

v Edit System Configuration - Allows IBM Omni-Channel Merchandising Support
and IBM Omni-Channel Merchandising Operations to edit the system
configuration for a company.

Note: Edit System Configuration should be selected for IBM Omni-Channel
Merchandising Support and IBM Omni-Channel Merchandising Operations users
only. The application may be unstable if the system properties are set
improperly.

v Edit Users - Allows the user to create, edit, and delete users.
v OpenLink Administration - Allows IBM Omni-Channel Merchandising Support

and IBM Omni-Channel Merchandising Operations to administer IBM
Omni-Channel Merchandising OpenLink.

v View Jobs - Allows the user to view jobs in the Job Scheduler que.
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Chapter 2. Navigation within the application

The IBM Omni-Channel Merchandising workspace allows you to access all
applications for which you have the correct permissions. Most applications and
pages share similar navigation features, such as searches, reports, and paging. All
features work the same way on every page and in every application.

Your access to certain areas of IBM Omni-Channel Merchandising depends on your
permissions.

Related Topics

“Finding reports” on page 20
“Editing in a report” on page 23
“Data aggregation” on page 24
“Searching” on page 24
“Searching within report columns” on page 24
“Moving across multiple pages” on page 26
“Sorting the items list” on page 26
“Customizing the reports” on page 26
“Adding or removing columns” on page 26
“Changing column order” on page 27
“Sorting columns” on page 27
“Filtering columns” on page 28

Application Pages

From many pages in IBM Omni-Channel Merchandising, you can access the
features below.

Related Topics

“Actions”
“Finding reports” on page 20
“Searching to find information on a page” on page 20
“Selecting items” on page 21
“Refreshing” on page 21
“Troubleshooting slow data retrieval” on page 21
“Clearing the cache” on page 21

Actions
New activities are executed by clicking on an Action button.

New activities are executed by clicking on an Action button. For example, you
create a new product group by clicking the New Product Group action button. You
can click the Save button to save your new activities and changes.
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Finding reports
Reports are pre-defined ways of filtering information. Different reports are
available in different screens.

For example, several reports are available in the Product Group page including the
Product Groups report.

Searching using quick link search
Use the Quick Search to quickly navigate around the application.

You can use the search field to quickly navigate to other areas of the application.
As you type in the search box, coinciding pages in the application will
automatically populate the drop-down menu. You can click to select a page to
navigate to it.

Searching to find information on a page
IBM Omni-Channel Merchandising offers several ways to find information on a
page.

You can perform a search on letters, words, numbers, or characters such as >, <, or
=. The wildcard character * can be used to find items containing certain words. For
example, *Yogurt* will return Light Yogurt, Plain Yogurt, and Yogurt Drinks.
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Selecting items
The Shift and Ctrl keys are used for selecting multiple items on a page.

To select multiple items, select one or more items, hold down the Shift or Ctrl key,
and select another item.
v Shift key: Allows for continuous selection of items
v Ctrl key: Allows for non-continuous selection of items

Refreshing
Pages within IBM Omni-Channel Merchandising need to be refreshed to update
their status.

To refresh the screen, press F5, or click the Refresh button in the Internet Explorer
browser toolbar.

Troubleshooting slow data retrieval
Data retrieval in IBM Omni-Channel Merchandising web-based applications is
processed when you select buttons such as OK, Save, or Sort Ascending.
Sometimes the applications appear frozen while retrieving information. Here are a
few troubleshooting tips when pages appear to be frozen during data retrieval.

Procedure
1. Check the lower left corner of the Internet Explorer browser window to ensure

that Ready is displayed. You can also try refreshing the page.
2. If a page cannot be accessed or data cannot be changed, check that you have

the correct certificate, the certificate is installed correctly, and the certificate has
the correct permissions associated with it.

Clearing the cache
Use this procedure to clear the cache.

About this task

As you navigate through the World Wide Web, your computer caches, or saves
pages that you have accessed to remember where you have been. Pages are stored
as a history, which makes it easier and faster to view the pages on subsequent
visits.

As enhancements are made to a page, you may not see the updated page because
of the history that your computer has stored.

Procedure
1. Open Internet Explorer.
2. Choose Tools > Internet Options. The Internet Options dialog box displays.
3. In the center of the dialog box, click Delete Files.
4. Click OK in the Delete Files message box that appears. This clears the cache. If

you have never or rarely cleared the cache, the process may take a few minutes
to complete
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Moving between applications
The application drop-down menu provides quick access to individual applications
and areas within each application. Use the cascading menus to navigate to
application pages and complete primary tasks.

Moving between main pages
The menu bar allows you to move between main pages within an application. The
example shown below is from Promotion Planning & Execution.

Your access to specific areas of the application is controlled by permissions.

Navigating using breadcrumbs
A breadcrumb trail is a hierarchy of the pages within an application that you
navigated through to get to the current page. The breadcrumb trail displays at the
top of many pages. You can quickly link directly to a particular page in the
hierarchy, or you can navigate back through to your starting point.

The current page is the final element in the hierarchy. You must save any entered
data before leaving a page; however, any search criteria that you entered on a
previous page will be preserved if you navigate back to that page using the
breadcrumb trail.

Alert inbox
The Alert Inbox allows you to view the alerts that you are subscribed to that are
generated by various events and activities in the applications.

You can receive alerts for activities that only you have initiated or alerts when
anyone in the company has initiated the activity. Examples of events are when new
product costs are imported into IBM Omni-Channel Merchandising OpenLink, or a
promotion is predicted. The alerts are stored in a message dialog box where they
can be viewed.

In addition to receiving alerts in the IBM Omni-Channel Merchandising
application, you can also receive alerts via email using the email address stored in
your user profile.

A New Alert notification icon will display at the top right-side of the IBM
Omni-Channel Merchandising application when you have received new messages.
The number that displays in the icon indicates the number of new messages.
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Move the mouse over the icon, and then click Go to Inbox in the pop-up to open
the Alert Inbox dialog box. If you dismiss the icon instead, the icon will not
appear until a new message arrives. The alert inbox is also available as an option
in the Tools menu.

In the Alert Inbox dialog box, double-click a message, or select Open from the
right-click menu to open and view it in the Message Details dialog box. You can
also right-click on one or several messages to delete, or mark them as read. The
inbox stores a maximum of 100 messages.

Administrators can also subscribe other users within the company from the Users
page. You must have the Administer Alert Subscriptions permission enabled to
subscribe users to alerts.

Using and managing reports
Reports can be customized to fit your needs. You can search, sort, filter, and
customize the reports (add or remove columns).

Related Topics

“Finding reports” on page 20
“Editing in a report”
“Data aggregation” on page 24
“Searching” on page 24
“Searching within report columns” on page 24
“Sorting the items list” on page 26
“Customizing the reports” on page 26
“Adding or removing columns” on page 26
“Changing column order” on page 27
“Re-sizing columns” on page 27
“Sorting columns” on page 27
“Filtering columns” on page 28
“Clearing report changes” on page 28
“Setting company preferences” on page 28
“Creating personalized reports” on page 29

Editing in a report
Use this procedure to edit a field from inside a report.

About this task

Many fields can be edited directly in a report by clicking on the field, and entering
a new value. Fields that are editable in this manner will show a small bracket
symbol in the upper, right corner of the column heading. Once you have changed
a value, you cannot retrieve the previous value.

Procedure
1. Click on the field you want to edit or select multiple rows using the Shift (for

sequential rows) and Ctrl (for non-sequential rows) keys.
2. Enter the new value in the field.
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3. Click Save. The new value will show in bold typeface until it has been saved.

Data aggregation
Some reports allow you to view data at different aggregation levels.

To change a report's aggregation, select the level from the Aggregation drop-down
menu. The page refreshes and the data is shown at the selected level.

Searching
Use this procedure to search column for words, letters, numbers, or characters.

About this task

You can perform searches using the (>, <, <=, >=, =) signs to limit the search. You
can use a comma to search for multiple items, such as two UPCs (000419392402,
00014124214). In addition, you can use a comma to search for values outside of a
specified range, such as items with a volume change > or < 10% (>.10, < -.10). Use
quotes to enclose a value that contains a comma, for example, "John, Scenario1".

Searches containing the wildcard character, *, are also allowed. In this example, the
following searches can be conducted for the UPC 00012345678910:
v *78910 will find the UPC that ends in 78910
v 00012345* will find all UPCs which start in 00012345. This is useful when

searching for all items for a manufacturer or vendor.
v *5678* will find all UPCs which contain 5678

Procedure
1. Select a column from the Search drop-down menu. The column you select is

where the search will be performed. You can only search on visible columns.
2. Enter the word, letter, or character you want to search for.

3. Click Find. The search results will appear. You cannot search again within the
results. Only one search can be performed at a time. To clear a search, click
Clear Search. The items list will revert back to the pre-search list of items.

Searching within report columns
In addition to the Search field at the top of the pages, you can use the Advanced
Filter feature for searching and filtering report items.

About this task

The Advanced Filter is a drop-down list of the values within each report column.
This list is accessible from the left-click context menu for column headings in
reports that display a filter symbol in the first column heading. You can select one
or more values to include in the filter.

Most of the operations that are supported in the Search field are also supported.
See “Searching” for more information about using the Search field.
v The (>, <, <=, >=, =) signs limit the search.
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v You can use a comma to search for multiple items, such as two UPCs
(000419392402, 00014124214). In addition, you can use a comma to search for
values outside of a specified range, such as items with a volume change greater
than or less than 10% (>.10, < -.10). You should enclose any values containing a
comma (,) with double quotes, for example, "My Scenario February 12, 2007".

v Searches containing the wildcard character (*) are allowed for values in text
columns, including UPCs.

A list of your current search values in the Advanced Filter is stored for reference
in a separate view. You can keep this list updated by clearing all or individual
search values. The page will refresh as the values are updated.

Note: To search certain Boolean column types, you must use the Search field
instead of the Advanced Filter. The following lists the Boolean column types that
can be searched in the Advanced Filter:
v Checkbox (Yes, No appears in Advanced Filter)

v Locked checkbox (Yes, No appears in Advanced Filter)

v Discontinued/Active (Discontinued, Active appears in Advanced Filter)

v Yes/No (Yes, No appears in Advanced Filter)

v Warning exclamation point symbols (Yes, No appears in Advanced Filter)

To search using the Advanced Filter:

Procedure
1. Left-click on a column heading in a report, and select Apply Filter. A separate

dialog box opens with the column values that are in the current page of the
report.

2. Select one or more values from the list. Use the Shift or Ctrl key to select
multiple items. Select the value "(Blank)" in the list to search for blank report
cells. IBM Omni-Channel Merchandising considers cells with only Space
characters as blank. Select the value "(Not Blank)" to show only report cells
which are not blank.

3. Click OK. The search results will appear. Click Cancel to close the dialog box
without performing the search. You can search again within the results. All
searches are retained until they are cleared, the report is changed, or the
aggregation is changed.

4. To view a list of all the current search values, mouse-over the left-most column
with the green filter symbol in the heading. The Advanced Filter values will
display. Any Report Filter values entered in the Edit Report page will also
display (see “Filtering columns” on page 28). The view will close when you
move the pointer away from the filter symbol.

5. To clear the filter values, click the 'x' button in front of an individual filter, or
the 'x' button in front of Advanced Filter Values to clear all filters at once.
The report filters can also be cleared. You can also clear the Advanced Filter
values by selecting Clear Filter in the column heading left-click context menu.
Related Topics

“Searching” on page 24
“Filtering columns” on page 28
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Moving across multiple pages
Use this procedure to move across multiple pages.

Procedure
1. Click on the Page arrows. The number of items listed on each page is set in

User Preferences (Tools > User Preferences).

2. Click the double arrow button to go to the last page or first page in the set.

Sorting the items list
Use this procedure to sort the item list by a column header.

Procedure
1. Left-click on the column header you want to sort.
2. Choose Sort Ascending or Sort Descending. The list will refresh and the items

will appear in the order you set.

Customizing the reports
Use this procedure to customize reports.

For each report, you can add or remove columns from the list, change the column
order, and sort and filter within each column in the Edit Report page. You can also
save your customizations into separate, personalized reports. These reports will be
available to choose from the report drop-down list in the edited application page.

In addition to setting personal report preferences, administrators can also set
default preferences for a company. These preferences will be the default report
settings for all users in that company.

Related Topics

“Adding or removing columns”
“Changing column order” on page 27
“Re-sizing columns” on page 27
“Sorting columns” on page 27
“Filtering columns” on page 28
“Clearing report changes” on page 28
“Setting company preferences” on page 28
“Creating personalized reports” on page 29

Adding or removing columns
Use this procedure to add or remove columns.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Select or deselect the Visible checkbox next to each column name.
v Selecting the checkbox will make the column visible in the groups list
v Deselecting it will remove the column
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3. Click Save. The changes will appear on the page.

Changing column order
Use this procedure to change the column order.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Click the order number next to each column name that you want to change.

The order text box appears.
3. Enter a number in the order text box. 1 represents the first column that will

appear on the left side of the window, 2 represents the second column, for
example.

4. Press Return after you change one column to automatically adjust the rest of
the column order.

5. Click Save. The changes will appear on the page.

Re-sizing columns
Use this procedure to manually re-size a column.

About this task

The report columns can be manually re-sized by dragging a column's right
boundary back and forth, or can be set to a specific width in pixels that you
specify.

In the report, drag the boundary on the right side of the column heading until the
column is the width that you want. All other column widths will remain the same.
Changes are automatically saved in your preferences for the report.

The specific column width (in pixels) will be automatically set in the Width field in
the Edit Report page for the report. You can adjust the width either manually, or
by increasing or decreasing the value of the column width.

Procedure
1. Locate the report name.
2. Click Edit. The Edit Report page appears.
3. Click the Width field for each column that you want to re-size, and enter a

number between 7 and 500. This value represents the column width in pixels. If
any columns were manually re-sized, their column width will also display in
the Width field.

4. Click Save. The changes will appear in the report.

Sorting columns
Use this procedure to sort columns.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Click in the Sort column next to a report column name. The Sort drop-down

menu displays.
3. Select Ascending, Descending, or None from the Sort drop-down menu.
4. Enter a number in the Sort text box for each column that you set a sort type

for. 1 is the first sort that will be used; 2 is the second sort that will be used, for
example. 0 means that no sort order is used.
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5. Click Save. The page will appear with the changes.

Filtering columns
Use this procedure to filter columns.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Click in the Filter column next to a report column name. The Filter text box

displays.
3. Enter the word, character, or symbol that you want to filter the column by in

the Filter text box. For example, entering A in the Filter text box for the
column Name will filter the column so that only those items with A in their
name will appear in the groups list.

4. Click Save. The page will appear with the changes.
5. Click Clear Filters to remove all filters from the report.

Clearing report changes
Use this procedure to clear changes from a report.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Click Reset. The page saves and refreshes with all the original report settings

for the company. If no preferences have been set at the company level, the
report will reset with the original system settings. The report will appear with
the changes.

Setting company preferences
Use this procedure to set the default company preferences for reports. The
Administer company wide UI preferences permission is required for defining
default report preferences for a company.

About this task

Administrators can set default report preferences for every user within their
company at once. All users within that company will view the reports as defined
with the selected columns, sorted columns, and the columns in a determined order,
for example. Users can overwrite these company settings with their own personal
settings in the Edit Report pages. However, users can later reset them to the
company defaults.

The Administer company wide UI preferences permission is required for defining
default report preferences for a company. See “User administration permissions”
on page 17.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. Click the Company Preferences tab to define report preferences for the

company. Then, choose one of the following options from the Save drop-down
list:
v Save & Exit to save the company preferences and navigate back to the report

with your personal preferences.
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v Save & View Company Preferences to save the company preferences and
view the report with the company preferences. This is a temporary view of
that report, and the report will revert back to your personal preferences
when you click away.

You can also reset the company preferences in this tab by choosing one of the
following options from the Reset drop-down list:
v Reset to IBM Omni-Channel Merchandising default to reset the company

preferences with the original system settings
v Reset to Personal Preferences to reset the company preferences with your

personal preferences
3. Click the Personal Preferences tab to set personal report preferences.
4. Click Save to save the changes, or Reset to reset the report with the company

preferences. If no preferences have been set at the company level, the report
will reset with the original system settings.

Creating personalized reports
Use this procedure to create and save a personalized report.

Procedure
1. Click Edit, which appears by the report name. The Edit Report page appears.
2. After setting up the column format in the Personal Preferences tab of the

report, such as applying filters, sorts, and setting the column order, enter a
unique name in the Personalize field, and click Save As. The report will appear
in alphabetical order at the bottom of the report drop-down list in the
application page. You can continue creating multiple versions of the newly
created report, or of the original report. The number of reports that can be
created is unlimited.

Note: Only the edits made to the columns in the Edit Report page are
persisted to the custom reports. Any entries added to the Advanced Filter in a
report will not be copied.

Data maintenance reports
Data in IBM Omni-Channel Merchandising applications can be viewed or updated
in reports.

All Data Maintenance reports are available at the Division or Chain level, and
many are available at various aggregation levels. The reports are either populated
from OpenLink, or from Excel spreadsheets that you create and import.
Related concepts:
Price management & optimization reports
Promotion planning & execution reports
Markdown optimization reports
Viewing reports
Product analyzer utility
Reports
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Using context menus
Use this procedure to access context menus. Context menus let you quickly access
commands related to the workspace you are working in.

Procedure
1. Right-click in the window. The context menu for the selected window will

appear. If you right-click on a report item, the context menu (with commands
such as Edit or Delete) for that item will appear.

2. Left-click on a command from the context menu.

Editing user preferences
Use this procedure to edit user preferences.

About this task

Editing User Preferences involves setting defaults for the pages, such as the
number of rows that appears in the items lists and the default display category.

User preferences are shared across all IBM Omni-Channel Merchandising
applications. If you change a user preference in one application, the change will
also be applied when you log in to another application.

Procedure
1. Click the tool icon and select User Preferences from the drop-down menu. The

User Preferences dialog box appears.
2. Enter the number of rows you would like to appear in each item list (such as

the number of product groups in the Product Groups page). More rows may
increase the load time of the page.

3. Choose the default Ad Zone to appear in pages.
4. Choose the default Division, such as Chain, to appear in pages.
5. Choose the default Category to appear in pages.
6. You can set the Date Range on the pages and reports to always use your

company defaults, or to use the dates from your last session.
7. You can select the IBM Omni-Channel Merchandising application tabs to

appear at the top of the home page. You can also change the order in which
they appear by clicking in the Order column and entering new values.

8. If you want to restore the original settings, click the Reset button.

9. Click OK. The dialog box closes, and the preferences that you set are applied to
all pages in IBM Omni-Channel Merchandising.
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Chapter 3. Importing and exporting data

Data can be imported into the IBM Omni-Channel Merchandising services and
exported to an Excel file to review or edit. You can also track the status of all
imports and exports.

Related Topics

“Importing data”
“Data File Formats” on page 33
“Checking import status” on page 74
“Exporting data” on page 75
“Checking export status” on page 76
“Deleting an export” on page 76

Importing data
Use this procedure to import data. Data is imported into the IBM Omni-Channel
Merchandising services in one of three ways.

Procedure
1. Received through the IBM Omni-Channel Merchandising OpenLink application.

This is the most common method for importing new data. Customers send
their data (in text .txt files) to IBM Omni-Channel Merchandising each week
(through FTP) for sales, locations, products, competitive prices, and product
cost changes. This data is received in IBM Omni-Channel Merchandising
OpenLink, which uses automated validations to ensure data cleanliness. There
is very little manual, or user, intervention in these files. The imported files are
monitored using the Import Dashboard report in IBM Omni-Channel
Merchandising OpenLink.
Larger sets of data should be sent through IBM Omni-Channel Merchandising
OpenLink to take advantage of automated data accuracy screening. IBM
Omni-Channel Merchandising OpenLink is a tool used to prevent inaccurate or
corrupted data from entering the applications. The data is put into a standard
format and then validated. The validation checks for errors, and flags the
errors. The errors are fixed, and validation is run again. The final output from
this process is clean and accurate data.

Note: When new vendor costs or competitive prices come in through IBM
Omni-Channel Merchandising OpenLink and exceed thresholds, they are sent
to the New Data Approval page in the pricing application and must be
manually approved.

2. Directly into IBM Omni-Channel Merchandising services using Excel
Spreadsheets or DB IV formats, such as Microsoft Access. This is usually done
after your data has been imported for editing purposes, or for importing small
amounts of new data. Note that importing data directly from an Excel
spreadsheet mitigates IBM Omni-Channel Merchandising OpenLink automated
data validations. See “Using Excel spreadsheets” on page 32 for more
information.
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Note: When data is imported using a IBM Omni-Channel Merchandising
service other than IBM Omni-Channel Merchandising OpenLink, the only
validation is to see if the data file conforms to the standard format. As a result,
you can potentially import invalid or bad data. Make sure you check the data
thoroughly before importing through a IBM Omni-Channel Merchandising
service. You will typically export data from the application, edit the data, and
then import it back in.

3. Directly into the IBM Omni-Channel Merchandising Data Maintenance page
using editable fields in Data Maintenance reports. For example, if you receive
new vendor cost or new competitive data which requires immediate
implementation, the new data can be entered directly into the Price/Cost or
Competitive Products report in the Data Maintenance page. See “Data
maintenance reports” on page 29 for more information.
Related Topics

“Using Excel spreadsheets”

Using Excel spreadsheets
Using Excel spreadsheets is a quick and easy method for importing records directly
into IBM Omni-Channel Merchandising services.

After you manually input records in an Excel spreadsheet, you import the
spreadsheet. The data is viewable in the Data Maintenance reports and other
reports, such as Product Groups or Store Groups.

Data can be inserted, which adds new data to the database, or it can be updated,
which changes data already in the database.

You may not have access to all data imports. You may only be able to import
specific sets of data, or none at all. You must have the Import data to applications
user permission to import data from an Excel file into the application.

Related Topics

“Creating a spreadsheet example”

Creating a spreadsheet example
Example of an excel spreadsheet.

In an Excel spreadsheet, you enter the column names and data as described in the
table in “Data File Formats” on page 33. In most cases, you will create a separate
spreadsheet for each data type, such as Store Groups. After it is complete, you
import it into IBM Omni-Channel Merchandising services to populate the reports,
as described in “Importing data” on page 31.

The following example shows the spreadsheet data columns for the Multiple Price
Points data type. In this case, any price between .48 and .52 would automatically
recommend 2 for $1.00. IBM Omni-Channel Merchandising will automatically
calculate the per-selling-unit price point as .50.
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Related Topics

“Data File Formats”
“Importing data” on page 31

Additional spreadsheet tips
Here are some additional tips for creating spreadsheets.
v Category names used in the spreadsheet must match the category names in the

pricing application, including cases (upper and lower case). Check the category
names in IBM Omni-Channel Merchandising (Edit > Data Maintenance, choose
the IBM Omni-Channel Merchandising Categories report) before importing.

v Enter the field names in the top row of the data file. The top row of data is
ignored during import.

v Every column must be present in the data file. If you are not importing a
column, leave it empty, but still include it in the file.

v Records can be deleted by placing a blank in the column.
v Custom formatted data cells will not import.
v Many of the field names are followed by another name in parenthesis (Store

Number (CustomerLocationKey)). The name without parentheses is the name of
the field that appears in the IBM Omni-Channel Merchandising service. The
name in the parentheses is the actual field name that appears in the database. If
there are no parentheses following the name, it is the name used in the database,
as well as the service.

Data File Formats

Each data type has a specific set of fields that the file must contain. Also, the
column order must be in a specific order.

Each data type that you can import is listed in the table below with the required
fields, column order, unique key, and type of import that can occur (update data,
insert new data, or both). For example, for some data types, only new data can be
inserted. Records that are currently in a IBM Omni-Channel Merchandising service
will not be updated for those data types. The IBM Omni-Channel Merchandising
service that requires the data type is also included.

Some fields require a single quote (') before the value to save it in text format in
Excel. When you enter a code such as UPC code "000012345678", Excel tries to
clean up the data by removing the leading zeros. The resulting value would be
"12345678". This would fail in the IBM Omni-Channel Merchandising system
because each character is required for UPC codes. Fields that require a single quote
(') before the value are noted in the table.
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Ad execution defaults -
product group

Update default headline
copy, body copy and images
for an existing product group

v Promotion Planning &
Execution

Ad execution defaults -
promoted product group

Update default headline
copy, body copy and images
for an existing promoted
product group

v Promotion Planning &
Execution

Anchor class Update existing records v Price Management

v Price Optimization

Anchor price Update existing records v Price Management

v Price Optimization

Anchor price by zone Update existing records v Price Management

v Price Optimization

Base cost1 Update existing records v Price Management

v Price Optimization

Base cost1 by zone Update existing records v Price Management

v Price Optimization

Base cost2 Update existing records v Price Management

v Price Optimization

Base cost2 by zone Update existing records v Price Management

v Price Optimization

Base cost3 Update existing records v Price Management

v Price Optimization

Base cost3 by zone Update existing records v Price Management

v Price Optimization

Base costs Update existing records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Base costs by zone Update existing records v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Base prices Update existing records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Base prices by zone Update existing records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Base to Bonus Products Map Update existing records v Price Management

v Price Optimization

Brand class and family Update existing records v Price Management

v Price Optimization

Brand rule override Update existing records v Price Management

v Price Optimization

Category group Update existing records v Price Management

v Price Optimization

Category-zone competitors Insert new records

Update existing records

v Price Management

v Price Optimization

Competitive prices Insert new records

Update existing records

v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Comp prices by zone Insert new records

Update existing records

v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Comp prices by zone - line Insert new records

Update existing records

v Price Management

v Price Optimization

Cost configuration -
line/zone

Update existing records v Price Management

v Price Optimization

Cost configuration -
SKU/chain

Update existing records v Price Management

v Price Optimization

Cost configuration -
SKU/division

Update existing records v Price Management

v Price Optimization

Cost family Update existing records v Price Management

v Price Optimization

Cost margin (for CP
customers)

Update existing records v Price Management

v Price Optimization

v Customer Trade Planning
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Current prices Update existing records v Price Management

v Price Optimization

v Markdown Optimization

Current prices by zone Update existing records v Price Management

v Price Optimization

v Markdown Optimization

Custom relationships Update existing records v Price Management

v Price Optimization

Express price overrides by
store - SKU

Update existing records v Price Management

v Price Optimization

Express price overrides by
zone - line

Update existing records v Price Management

v Price Optimization

Express price overrides by
zone - SKU

Update existing records v Price Management

v Price Optimization

Last digits Insert new records

Update existing records

v Price Management

v Price Optimization

Line prices Update existing records v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Line to line relationship Update existing records v Price Management

v Price Optimization

Line to line relationship by
zone

Update existing records v Price Management

v Price Optimization

Location group class
assignment

Update existing records v Promotion Planning &
Execution

v Customer Trade Planning

Location group class store
mappings

Update existing records v Promotion Planning &
Execution

v Customer Trade Planning

Locked prices Update existing records v Price Management

v Price Optimization

Locked prices by division Update existing records v Price Management

v Price Optimization

Locked prices by zone Update existing records v Price Management

v Price Optimization

Markdown data Update existing records v Markdown Optimization

Multiple price points Insert new records v Price Management

v Price Optimization
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Other class and family1 Update existing records v Price Management

v Price Optimization

Other class and family2 Update existing records v Price Management

v Price Optimization

Pre-prices flag Update existing records v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Price overrides Update existing records v Price Management

v Price Optimization

Price overrides - line Update existing records v Price Management

v Price Optimization

Price overrides by zone Update existing records v Price Management

v Price Optimization

Price overrides by zone - line Update existing records v Price Management

v Price Optimization

Product group Insert new records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Product link Update existing records v Price Management

v Price Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Product status Update existing records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Product status by zone Update existing records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Product to product
relationship

Update existing records v Price Management

v Price Optimization
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Product to product
relationship by zone

Update existing records v Price Management

v Price Optimization

Promoted product group -
LU

Create new promoted
product groups

Add new logistical units to
existing product groups

v Promotion Planning &
Execution

Promoted product group -
SU

Create new promoted
product groups

Add products to existing
promoted product groups

v Promotion Planning &
Execution

Size class and family Update existing records v Price Management

v Price Optimization

SKU attributes Update existing records

Update existing records with
null values

v Price Management

v Price Optimization

SKU/Zone attribute Update existing records with
a maximum of six (6)
attributes

v Price Management

v Price Optimization

Store attributes Update existing records

Update existing records with
null values

v Price Management

v Price Optimization

Store group Insert new records v Price Management

v Price Optimization

v Markdown Optimization

v Promotion Planning &
Execution

v Customer Trade Planning

Store price zone Update existing records v Price Management

v Price Optimization

v Markdown Optimization

Tier class and family Update existing records v Price Management

v Price Optimization

Transfer prices by store Add or modify transfer price
for an existing UPC

v Price Management

v Price Optimization

Transfer prices by zone Add or modify transfer price
for an existing UPC

v Price Management

v Price Optimization

Zone exception Update existing records v Price Management

v Price Optimization

Zone group assignment Insert new records

Update existing records

v Price Management

v Price Optimization

v Markdown Optimization
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Data Type Available Actions
IBM Omni-Channel
Merchandising Service

Zone override Update existing records v Price Management

v Price Optimization

Zone-location mapping Update existing records v Price Management

v Price Optimization

v Markdown Optimization

ABC product direct costs
ABC product direct costs data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before value

20 digit UPC code

Customer Location Key Required, use single quote (') before value

Store number or identifier

Distribution Center Key Required, unique key, use single quote (')
before value

Distribution center number or identifier

AvgWklyCase Average number of weekly cases handled by
a distribution center

BagCost Total shopping bag cost for a product in a
distribution center's region

Checkout Cost Per Pkg Cost per package to complete a checkout

DC Inv Cost Per Pkg Inventory cost per package at a distribution
center

DC Labor Cost Per Pkg Labor cost per package at a distribution
center, given the receiving method

SumOfAvgWklyCase Sum of the average number of weekly cases
handled by the distribution center

Count Location Number of distribution centers

AvgOfDCInvDays Average number of inventory days

AvgOfCaseCube Average number of case cubes

DC Space Calculation of inventory days and number
of case cubes

DC Cube Average amount of space occupied by a
given cube at the distribution center

DC Space Cost Per Store Calculates the space cost of servicing a store
depending on the product storage type

HQ Inv Proc Invoice processing cost divided by product
case pack

AvgDeliveryFreq Average of the location delivery frequency

AvgCaseCube Average of product case cube

Location Cube Calculation of product case cube, average
weekly case, and location delivery frequency
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Ad execution defaults - product group
Ad Execution Defaults - Product Group data columns and descriptions are listed
here.

Data Column (in order from first to last) Description

Product Group Name Required; if the product group specified
does not exist, the row does not import.

Name of product group

Product Group Code 20 character maximum

Code for the product group

Category ID Identification number for the product
category

Headline Copy Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default headline copy for the product group

Body Copy Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default body copy for the product group

Image 1 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Image 2 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Image 3 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Ad execution defaults - promoted product group
Ad execution defaults - promoted product group data columns and descriptions
are listed here.

Data Column (in order from first to last) Description

Product Group Name Required; if the promoted product group
specified does not exist, the row does not
import.

Name of promoted product group

Product Group Code 20 character maximum

Code for the product group

Headline Copy Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default headline copy for the promoted
product group
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Data Column (in order from first to last) Description

Body Copy Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default headline copy for the promoted
product group

Image 1 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Image 2 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Image 3 Required; if left blank, IBM Omni-Channel
Merchandising deletes any existing default.

Default image for the product group

Anchor class
The imported set of brand families and brand classes populates the Anchor Class
report. Only one brand class under the same brand family can be the anchor class.
If more than one brand class is set as the anchor in the import file, the anchor class
defined last will override the ones previously defined. Anchor class data columns
and descriptions are listed here.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category to which the competitor
data will apply

Brand Family (BrandFamily) Use single quote (') before the value

Brand family name

Brand Class (BrandClass) Use single quote (') before the value

Brand class name

IsAnchor 1 means the brand class is anchored; 0
means the brand class is not anchored

Anchor price
The imported set of anchor prices populates the Anchor Price report. Any existing
anchor prices for all products and stores in the category will be overwritten.
Anchor price data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code
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Data Column (in order from first to last) Description

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Anchor Price Anchor prices are a set of prices for a
category that you can create a Price Drift
rule against. This rule constrains the price to
be within a certain range from the anchor
price.

Anchor price by zone
The imported set of anchor prices populates the Anchor Price report. Any existing
anchor prices for all products and stores in the category will be overwritten.
Anchor price by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Anchor Price Anchor prices are a set of prices for a
category that you can create a Price Drift
rule against. This rule constrains the price to
be within a certain range from the anchor
price.

Base cost1
Base Cost1 data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Base Cost1 Unit cost of product (user-defined)
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Base cost1 by zone
Base Cost1 by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Base Cost1 Unit cost of product (user-defined)

Base cost2
Base Cost2 data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Base Cost2 Unit cost of product (user-defined)

Base cost2 by zone
Base Cost2 by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Base Cost2 Unit cost of product (user-defined)
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Base cost3
Base Cost3 data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Base Cost3 Unit cost of product (user-defined)

Base cost3 by zone
Base Cost3 by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Base Cost2 Unit cost of product (user-defined)

Base costs
Base Costs data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Avg Unit Cost (UnitCost) Unit cost of product

Base costs by zone
Base Costs by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code
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Data Column (in order from first to last) Description

Division Required

Division name

Zone Required

Zone name

Avg Unit Cost (UnitCost) Unit cost of product

Base prices
Base Prices data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Multiple Required

Multiple amount; for example, if product is
3 for $1, you would enter 3 in this column.

MultiplePrice Required

Multiple price; for example, if product is 3
for $1, you would enter 1 in this column.

Base prices by zone
Base Prices by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Multiple Required

Multiple amount; for example, if product is
3 for $1, you would enter 3 in this column.

MultiplePrice Required

Multiple price; for example, if product is 3
for $1, you would enter 1 in this column.
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Brand class and family
Brand class and family data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Brand Class (BrandClass) Use single quote (') before the value

Brand class name

Brand Family (BrandFamily) Use single quote (') before the value

Brand family name

Brand rule override
Brand rule override data columns and descriptions are listed here.

Use this import to override brand rules for specific product pairs.

Data Column (in order from first to last) Description

Name Required, use single quote (') before the
value

Name of the brand rule you are overriding
for these two products

Description Description of the rule

Product Category (ProductCategory) The specific product category to which the
products belong. To specify "all categories,"
use null.

Parent Brand Rule (ParentBrandRule) Name of the parent brand rule (found in the
Price Rules page)

LeftUPC Required

20 digit UPC code

RightUPC Required

20 digit UPC code

Brand Rule % Lower (MinValue) Required

Lower bound amount for the price range

Brand Rule % Upper (MaxValue) Upper bound amount for the price range

Category group
Category group data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Category Group Use single quote (') before the value

Category Group name

Product Category (ProductCategory) Product category in the Category Group
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Category-zone competitors
Category-zone competitors data columns and descriptions are listed here.

You must first enter the competitor names in the Competitors page before
importing.

Data Column (in order from first to last) Description

Division Required

Division Name

Product Category (ProductCategory) Required

Product category to which the competitor
data will apply

Zone Group Zone group name

Zone Required

Zone name

Primary Competitor (Primary Comp) Required, unique key

Primary competitor name or ID

Secondary Competitor (Secondary Comp) Required, unique key

Secondary competitor Name or ID

Tertiary Competitor (Tertiary Comp) Required, unique key

Tertiary competitor name or ID

Competitive prices
You must enter the competitor names in the Competitors page before importing.
This data set is also used for the compliance prices. Competitive prices data
columns and descriptions are listed here.

If the prices are blank in the Excel file, and the records exist for the given
UPC/Store/Competitor, IBM Omni-Channel Merchandising deletes the competitive
information from the application upon import. A warning message will alert you
that the records will be deleted.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Customer store number or identifier

v Multiple (SuggestedMultiple)- multiple
amount. For example, if product is 3 for
$1, you would put 3 in this column.

v MultiplePrice

v (PriceType)- SHELF or 0. Use a single
quote (') before the type.

v StartDate - effective start date of the
competitive price you are importing
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Data Column (in order from first to last) Description

Competitor (CompetitorKey) Required, unique key

Competitor Name or ID

Multiple (SuggestedMultiple) Multiple amount; for example, if product is
3 for $1, you would put 3 in this column.

MultiplePrice Multiple price; for example, if product is 3
for $1, you would enter 1 in this column.

(PriceType) Use single quote (') before the value

Enter SHELF or 0

StartDate Effective start date of the competitive price
you are importing

Comp prices by zone
You must enter the competitor names in the Competitors page before importing.
Comp prices by zone data columns and descriptions are listed here.

If the prices are blank in the Excel file, and the records exist for the given
UPC/Division/Zone/Competitor, then the competitive information will be deleted
from the application upon import. A warning message will alert you that the
records will be deleted.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Competitor (CompetitorKey) Required, unique key

Competitor name or ID

Multiple (SuggestedMultiple) Multiple amount; for example, if product is
3 for $1, enter 3 in this column.

MultiplePrice Multiple price; for example, if product is 3
for $1, enter 1 in this column.

StartDate Effective start date of the competitive price
you are importing

Comp prices by zone - line
You must enter the competitor names in the Competitors page before importing.
Comp prices by zone - line data columns and descriptions are listed here.
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If the prices are blank in the Excel file, and the records exist for the given
UPC/Line/Division/Zone/Competitor, then the competitive information is deleted
from the application upon import. A warning message alerts you that the records
will be deleted.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category to which the competitor
data will apply

Line (LineGroup) Use single quote (') before the value

Name of the line group

Division Required

Division name

Zone Required

Zone name

Competitor (CompetitorKey) Required, unique key

Competitor name or ID

Multiple (SuggestedMultiple) Multiple amount; for example, if product is
3 for $1, enter 3 in this column.

MultiplePrice Multiple price; for example, if product is 3
for $1, enter 1 in this column.

StartDate Effective start date of the competitive price
you are importing

Cost configuration - line/zone
Cost configuration - line/zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category to which the cost type will
apply

Division Required

Division name

Line (LineGroup) Required, use single quote (') before the
value

Name of the line group

Zone Required

Zone name
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Data Column (in order from first to last) Description

Cost Source Cost source used for the product at the
SKU/chain level

Cost configuration - SKU/chain
Cost configuration - SKU/chain data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Cost Source Cost source used for the product at the
SKU/chain level

Cost configuration - SKU/division
Cost configuration - SKU/division data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Cost Source Cost source used for the product at the
SKU/division level

Cost family
Cost family data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Cost Family (CostFamily) Use single quote (') before the value

Cost family name

Cost margin
This table is for CP customers only. Cost margin data columns and descriptions are
listed here.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category name
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Data Column (in order from first to last) Description

Division Required

Division name

Manufacturer Required

Manufacturer name or asterisk (*) for the
wildcard character

Brand Required

Brand name or asterisk (*) for the wildcard
character

Cost Margin Required

Cost margin percentage value; for example,
5.0%

Use Cost Margin Required

Enter 0 if you do not want to use the
entered cost margin until later; enter 1 to
use the cost margin

Current prices
Cost prices data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Multiple Multiple amount; for example, if product is
3 for $1, enter 3 in this column.

CurrentPrice Individual product price or multiple price

If entering multiples prices, enter the total
price for the number of products entered in
the Multiple column. For example, if
product is 3 for $1, enter 1 in this column.

Current prices by zone
Current® prices by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code
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Data Column (in order from first to last) Description

Division Required

Division name

Zone Required

Zone name

Multiple Multiple amount; for example, if product is
3 for $1, enter 3 in this column.

CurrentPrice Individual product price or multiple price

If entering multiples prices, enter the total
price for the number of products entered in
the Multiple column. For example, if
product is 3 for $1, enter 1 in this column.

Custom relationships
This import creates product relationships that are specific to your company. Users
can then utilize these relationships to create Custom Relationship rules to use in
pricing actions. Custom relationships data columns and descriptions are listed
here.

Data Column (in order from first to last) Description

Relationship Type Required

User-defined field to set the type of
relationship

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Custom Family User-defined custom family name

Custom Class User-defined custom class name

Note: To delete a Custom Relationships record from the application, re-import the
data with the Custom Family and Custom Class fields blank.

Express price overrides by store - SKU
Express® price overrides by store - SKU data columns and descriptions are listed
here.

Data Column (in order from first to last) Description

( Express Pricing RunID) Required, unique key

Express pricing run ID; this ID is located in
the Express Pricing page for each run and
appears automatically if you export first. Do
no alter this column.
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Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Override Multiple Multiple amount associated with the
override price; for example, if product is 3
for $1, enter 3 in this column.

Override Price Required

Override price that will be used as the
Express Price

Override Cost Required

Price Effective Date Effective start date of the override price you
are importing

Express price overrides by zone - line
Express price overrides by zone - line data columns and descriptions are listed
here.

Data Column (in order from first to last) Description

(Express Pricing RunID) Required, unique key

Express pricing run ID; this ID is located in
the Express Pricing page for each run and
appears automatically if you export first. Do
no alter this column.

Product Category (ProductCategory) Required

Product category name

Line (LineGroup) Required, use single quote (') before the
value

Line group name

Division Division name

Zone Required

Zone name

Override Multiple Multiple amount associated with the
override price; for example, if product is 3
for $1, enter 3 in this column.

Override Price Required

Override price that will be used as the
Express Price

Override Cost Override cost

Price Effective Date Effective start date of the override price you
are importing
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Express price overrides by zone - SKU
Express price overrides by zone - SKU data columns and descriptions are listed
here.

Data Column (in order from first to last) Description

(Express Pricing RunID) Required, unique key

Express pricing run ID; this ID is located in
the Express Pricing page for each run and
appears automatically if you export first. Do
no alter this column.

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Zone Required

Zone name

Override Multiple Multiple amount associated with the
override price; for example, if product is 3
for $1, enter 3 in this column.

Override Price Required

Override price that will be used as the
Express Price

Price Effective Date Effective start date of the override price you
are importing

Last digits
Last digits data columns and descriptions are listed here.

Use this import to set specific last digits for prices.

Data Column (in order from first to last) Description

Name Required, use single quote (') before the
value

Description Description of the rule

Product Category (ProductCategory) The specific product category to which the
products belong. To specify "all categories,"
use null.

Multiple Required

Multiple amount; for example, if product is
3 for $1, enter 3 in this column.

Last Digits (LastDigitsString) Use single quote (') before the value

Last digits that prices are allowed to end in;
for example, 95, 45
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Line prices
Line prices data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Line (LineGroup) Use single quote (') before the value

Line group name

Line to line relationship
Line to line relationship data columns and descriptions are listed here.

This imports line group to line group relationship data used for the Product or
Line Relationship rule.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category to which the Product or
Line Relationship rule will apply

Line(1) Line group name

Line(2) Line group name

Relationship Type Enter Multiplier or Relative.

v Multiplier: The value is multiplied with
the optimized price of Line(1).

v Relative: The value is added to the
optimized price of Line(2).

If the Relationship Type field is blank in the
import file, the relationship will not appear
in IBM Omni-Channel Merchandising. If the
relationship already exists, IBM
Omni-Channel Merchandising will delete it.

Relationship Value Numeric value (greater than zero for
multipliers) used to determine the new price
of Line(2), as in the following calculations:

v Price of Line(2) = Price of Line(1) *
Multiplier Value

v Price of Line(2) = Price of Line(1) + Relative
Value

Line to line relationship by zone
This imports line group to line group relationship data by zone used for the
Product or Line Relationship rule. Line to line by zone relationship data columns
and descriptions are listed here.
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Data Column (in order from first to last) Description

Product Category (ProductCategory) Required

Product category to which the Product or
Line Relationship rule will apply

Zone Required

Zone name

Line(1) Line group name

Line(2) Line group name

Relationship Type Enter Multiplier or Relative.

v Multiplier: The value is multiplied with
the optimized price of Line(1).

v Relative: The value is added to the
optimized price of Line(2).

If the Relationship Type field is blank in the
import file, the relationship will not appear
in IBM Omni-Channel Merchandising. If the
relationship already exists, IBM
Omni-Channel Merchandising will delete it.

Relationship Value Numeric value (greater than zero for
multipliers) used to determine the new price
of Line(2), as in the following calculations:

v Price of Line(2) = Price of Line(1) *
Multiplier Value

v Price of Line(2) = Price of Line(1) + Relative
Value

Location group class assignment
Contact an Integration Services representative for assistance updating location
groups.

Location group class store mappings
Contact an Integration Services representative for assistance updating location
groups.

Locked prices
This import locks the prices of all UPCs listed in the file. Locked prices data
columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division
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Data Column (in order from first to last) Description

Zone (Name) Use single quote (') before the value

Name of the store zone (found in Data
Maintenance > Store Zone report)

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Store number or identifier

Locked Override (Is UserLocked) Locks the price; use 0 to unlock and 1 to
lock.

A lock icon appears next to locked prices in
the IBM Omni-Channel Merchandising user
interface.

Note: For divisional customers, a fifth data column is required, labeled Division.

Locked prices by division
This import locks the prices of all UPCs listed in the file. Locked prices by division
data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Locked Override (Is UserLocked) Locks the price; use 0 to unlock and 1 to
lock.

A lock icon appears next to locked prices in
the IBM Omni-Channel Merchandising user
interface.

Locked prices by zone
This import locks the prices of all UPCs listed in the file. Locked prices by zone
data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name
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Data Column (in order from first to last) Description

Zone Required

Zone name

Locked Override (Is UserLocked) Locks the price; use 0 to unlock and 1 to
lock.

A lock icon appears next to locked prices in
the IBM Omni-Channel Merchandising user
interface.

Markdown data
Markdown data data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Customer store number or identifier

Customer OutDate Final date that the product is available to
sell on the store shelf

Mkd StartDate Date that the markdown starts for the
product-location (MM/DD/YYYY format)

Customer MkdCode 10 character maximum

Indicator of product status; for example, C is
candidate for markdown and M is one or
more markdowns have occurred.

Inventory Units available to sell at a location as of the
inventory date

Inventory Date Date on which the inventory amount is
applicable (MM/DD/YYYY format)

Multiple price points
Multiple price points columns and descriptions are listed here.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Specific product category into which IBM
Omni-Channel Merchandising will insert the
multiple price point

Minimum Unit Price (MinUnitPrice) Lowest new price that is assigned the
multiple price point

Maximum Unit Price (MaxUnitPrice) Highest new price that is assigned the
multiple price point

Multiple Multiple amount; for example, if product is
3 for $1, enter 3 in this column.
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Data Column (in order from first to last) Description

Price Point (PricePoint) Price value; for example, if the product is 3
for $1, enter $1 in this column.

Other class and family1
Other class and family1 data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Other1 Class (Other1Class) Use single quote (') before the value

Class name

Other1 Family (Other1Family) Use single quote (') before the value

Family name

Other class and family2
Other class and family2 data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Other2 Class (Other2Class) Use single quote (') before the value

Class name

Other2 Family (Other2Family) Use single quote (') before the value

Family name

Pre-priced flag
Pre-priced flag data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

PrePrice (IsPrePriced) Required

0 means the product is not pre-priced; 1
means the product is pre-priced

Price overrides
This imports a file that overrides a scenario's optimized prices. Typically, you will
export the Price Overrides report. Price overrides data columns and descriptions
are listed here.
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See “Exporting data” on page 75, make price changes, and import the file back into
IBM Omni-Channel Merchandising.

Data Column (in order from first to last) Description

(ScenarioRunID) Required, unique key

Scenario ID; this ID is contained in the URL
on the Scenario Details page and appears
automatically if you export first. Do not alter
this column.

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Store number or identifier

Multiple (OverOptMultiple) Multiple associated with the override price;
do not alter this column.

Manual Override (OverOptMultiplePrice) Required

Override price that will replace the
optimized price

Price Effective Date Effective start date of the override price you
are importing

Transfer Price Override Multiple Multiple associated with the override
transfer price - visible only to Franchise
Pricing users.

Transfer Price Override Override transfer price specified for the UPC
- visible only to Franchise Pricing users.

Related Topics

“Exporting data” on page 75

Price overrides - line
This imports a file that overrides a scenario's optimized prices. Typically, you will
export the Price Overrides report. Price - line overrides data columns and
descriptions are listed here.

See “Exporting data” on page 75, make price changes, and import the file back into
IBM Omni-Channel Merchandising.
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Data Column (in order from first to last) Description

(ScenarioRunID) Required, unique key

Scenario ID; this ID is contained in the URL
on the Scenario Details page and appears
automatically if you export first. Do not alter
this column.

Line (LineGroup) Use single quote (') before the value

Line group name

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Store number or identifier

Multiple (OverOptMultiple) Multiple associated with the override price;
do not alter this column.

Manual Override (OverOptMultiplePrice) Required

Override price that will replace the
optimized price

Price Effective Date Effective start date of the override price you
are importing

Transfer Price Override Multiple Multiple associated with the override
transfer price - visible only to Franchise
Pricing users.

Transfer Price Override Override transfer price specified for the Line
Group - visible only to Franchise Pricing
users.

Related Topics

“Exporting data” on page 75

Price overrides by zone
This imports a file that overrides a scenario's optimized prices. Typically, you will
export the Price Overrides report. Price overrides by zone data columns and
descriptions are listed here.

See “Exporting data” on page 75, make price changes, and import the file back into
IBM Omni-Channel Merchandising.
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Data Column (in order from first to last) Description

(ScenarioRunID) Required, unique key

Scenario ID; this ID is contained in the URL
on the Scenario Details page and appears
automatically if you export first. Do not alter
this column.

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Zone Required

Zone name

Multiple (OverOptMultiple) Multiple associated with the override price;
do not alter this column.

Manual Override (OverOptMultiplePrice) Required

Override price that will replace the
optimized price

Price Effective Date Effective start date of the override price you
are importing

Transfer Price Override Multiple Multiple associated with the override
transfer price - visible only to Franchise
Pricing users.

Transfer Price Override Override transfer price specified for the
UPC/Zone - visible only to Franchise
Pricing users.

Related Topics

“Exporting data” on page 75

Price overrides by zone - line
This imports a file that overrides a scenario's optimized prices. Typically, you will
export the Price Overrides report. Price overrides by zone - line data columns and
descriptions are listed here.

See “Exporting data” on page 75, make price changes, and import the file back into
IBM Omni-Channel Merchandising.

Note: IBM Omni-Channel Merchandising is also able to configure automatic
loading of override prices at the Line/Zone aggregation level via OpenLink. For
details, consult your IBM Omni-Channel Merchandising representative.
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Data Column (in order from first to last) Description

(ScenarioRunID) Required, unique key

Scenario ID; this ID is contained in the URL
on the Scenario Details page and appears
automatically if you export first. Do not alter
this column.

Line (LineGroup) Use single quote (') before the value

Line group name

Zone Required

Zone name

Multiple (OverOptMultiple) Multiple associated with the override price;
do not alter this column.

Manual Override (OverOptMultiplePrice) Required

Override price that will replace the
optimized price

Price Effective Date Effective start date of the override price you
are importing

Transfer Price Override Multiple Multiple associated with the override
transfer price - visible only to Franchise
Pricing users.

Transfer Price Override Override transfer price specified for the
Line/Zone - visible only to Franchise Pricing
users.

Related Topics

“Exporting data” on page 75

Product group
Product group data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Name Required, 50 character maximum

Product group name

Product link
Product link data columns and descriptions are listed here.
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IBM Omni-Channel Merchandising does not create product links upon import if
the following errors occur. The errors will appear in the Import Status dialog box.
See “Checking import status” on page 74.
v The new product UPC and mature product UPC are invalid
v The mature product does not have any modeling coefficients

Data Column (in order from first to last) Description

New Product UPC Required, unique key, use single quote (')
before the value

20 digit UPC code of new product

Mature Product UPC Required, unique key, use single quote (')
before the value

20 digit UPC code of mature product

Link Type v LINEEXT: Line extension; the new
product will be introduced as an
extension of an existing line group that
includes the mature product.

v DIRECTREP: Direct replacement; the new
product will be replacing the mature
product in the assortment.

v null; the new product will not be
extending an existing line group or
replacing the mature product.

Estimated Weekly Volume Estimated weekly volume for the new
product when the mature product is
discontinued

Incremental Volume Percentage Estimated incremental volume percentage
for the new product when the mature
product is discontinued

Related Topics

“Checking import status” on page 74

Product status
Product status data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Prod Status (pIncPrd) Status of the product; 1 means the product is
active; 0 means the product is discontinued.
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Product status by zone
Product status by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Prod Status (pIncPrd) Status of the product; 1 means the product is
active; 0 means the product is discontinued.

Product to product relationship
This imports product to product relationship data used for the Product or Line
Relationship rule. Product to product relationship data columns and descriptions
are listed here.

Data Column (in order from first to last) Description

UPC(1) Required, unique key, use single quote (')
before the value

20 digit UPC code

UPC(2) Required, unique key, use single quote (')
before the value

20 digit UPC code

Relationship Type Enter Multiplier or Relative.

v Multiplier: The value is multiplied with
the optimized price of UPC(1).

v Relative: The value is added to the
optimized price of UPC(1).

If the Relationship Type field is blank in the
import file, the relationship will not appear
in IBM Omni-Channel Merchandising. If the
relationship already exists, IBM
Omni-Channel Merchandising will delete it.

Relationship Value Numeric value (greater than zero for
multipliers) used to determine the new price
of UPC(2), as in the following calculations:

v Price of UPC(2) = Price of UPC(1) *
Multiplier Value

v Price of UPC(2) = Price of UPC(1) + Relative
Value
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Product to product relationship by zone
This imports product to product relationship data used for the Product or Line
Relationship rule. Product to product relationship by zone data columns and
descriptions are listed here.

Data Column (in order from first to last) Description

Division Required

Division name

Zone Required

Zone name

UPC(1) Required, unique key, use single quote (')
before the value

20 digit UPC code

UPC(2) Required, unique key, use single quote (')
before the value

20 digit UPC code

Relationship Type Enter Multiplier or Relative.

v Multiplier: The value is multiplied with
the optimized price of UPC(1).

v Relative: The value is added to the
optimized price of UPC(1).

If the Relationship Type field is blank in the
import file, the relationship will not appear
in IBM Omni-Channel Merchandising. If the
relationship already exists, IBM
Omni-Channel Merchandising will delete it.

Relationship Value Numeric value (greater than zero for
multipliers) used to determine the new price
of UPC(2), as in the following calculations:

v Price of UPC(2) = Price of UPC(1) *
Multiplier Value

v Price of UPC(2) = Price of UPC(1) + Relative
Value

Promoted product group - LU
Promoted product group - LU data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Product Group Name Required, 50 character maximum

Promoted product group name; if the
specified name does not exist, IBM
Omni-Channel Merchandising creates a new
promoted product group.
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Data Column (in order from first to last) Description

Product Group Code 20 character maximum

Unique code for the promoted product
group

Logistical Item Identifier 30 character maximum

Logistical unit code; if a logistical unit you
select (or a UPC linked to that logistical
unit) already belongs to another promoted
product group, IBM Omni-Channel
Merchandising ignores the row.

Promoted product group - SU
Promoted product group - SU data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Name Required, 50 character maximum

Promoted product group name; if the
specified name does not exist, IBM
Omni-Channel Merchandising creates a new
promoted product group.

Code 20 character maximum

Unique code for the promoted product
group

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code; if a UPC you select
already belongs to another promoted
product group, IBM Omni-Channel
Merchandising ignores the row.

Size class and family
Size class and family data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Size Class (SizeClass) Use single quote (') before the value

Size class name; allowable size class formats
are size classes defined for the category. If
the classes have not yet been defined, use
the defaults (XXX-LARGE, XX-LARGE,
X-LARGE, LARGE, MEDIUM, SMALL,
X-SMALL, XX- SMALL XXX-SMALL) which
you can later update in IBM Omni-Channel
Merchandising.

Size Family (SizeFamily) Use single quote (') before the value

Size family name
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SKU attributes
SKU attribute data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Attribute0 SKU attribute name; if left blank, you can
assign an attribute to a product in the Data
Maintenance > SKU/Zone Attribute report
after the import.

The report contains 10 attribute fields
(Attribute<0-9>). Your company may choose
not to use these fields or to only use some of
them.

SKU/Zone attribute
SKU/Zone attribute data columns and descriptions are listed here.

A maximum of six attributes can be defined.

Note: You must first contact IBM Omni-Channel Merchandising Support before
importing your own attributes to replace the system default CPI attributes (Ultra
Notable, Notable, Partially Notable, Not Notable, Undefined1, Undefined2).

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Group Required

Zone group name

Zone Required

Zone name

CPI Attribute Enter one of the following or leave blank:

v Ultra Notable

v Notable

v Partially Notable

v Not Notable

v Undefined1

v Undefined2

68 IBM OpenLink: Users' Guide



Data Column (in order from first to last) Description

Attribute0 SKU/zone attribute name; if left blank, you
can assign an attribute to a product in the
Data Maintenance > SKU/Zone Attribute
report after the import.

The report contains 5 attribute fields
(Attribute<0-4>). Your company may choose
not to use these fields or to only use some of
them.

Store attributes
Store attributes data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Level1 Descr This report contains Level<1-12> Descr
columns. Each column holds the description
for a different store attribute. These
attributes are only used for reporting
purposes. Your company may choose not to
use them or to use only some of the fields.

Level1 Code This report contains Level<1-12> Code
columns. Each column holds the code for a
different store attribute. This code relates to
the description field. These attributes are
only used for reporting purposes. Your
company may choose not to use them or to
use only some of the fields.

Attribute1 Company defined store attribute; this value
is optional and used only for reporting
purposes.

The import contains four attribute fields
(Attribute<1-4>).

Store group
Store group data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Name Required, unique key, use single quote (')
before the value

Store group name

Division Division name
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Store price zone
Store price zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Division Division name

Store Number (CustomerLocationKey) Required, unique key, use single quote (')
before the value

Store number or identifier

Name Required, use single quote (') before the
value

Store group name

Tier class and family
Tier class family data columns and descriptions are listed here.

You must have the Manage Tiered Pricing permission to import tier classes and
families. See Price permissions.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Tier Class (TierClass) Use single quote (') before the value

Tier class name

Tier Family (TierFamily) Use single quote (') before the value

Tier family name

Time series product status
Time series product status data columns and descriptions are listed here.

Time Series Product Status enables you to specify effective dates for each Product
loaded into IBM Omni-Channel Merchandising. For more information about
applying effective dates, please contact your IBM Omni-Channel Merchandising
representative.

Data Column (in order from first to last) Description

UPC (ProductUPC) Required, unique key, use single quote (')
before the value

20 digit UPC code

Location Key (LocationKey) The unique location, location group, or
location group class key

Status Code (StatusCode) Status code for the product status, as
defined in the Data > Product Status
Mapping report

Effective Date (EffectiveDate) Date at which the specified status code will
become effective for the UPC, in
mm/dd/yyyy format
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Transfer prices by store
You must have the Franchise Pricing permission to import transfer prices. Transfer
prices by store data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Store Number Use single quote (') before the value

Store number or identifier

Transfer Multiple Required

Multiple amount; for example, if product is
3 for $1, you would enter 3 in this column.

Transfer Price Required

Price at which the item is sold to a
franchisee; if you use multiples pricing,
enter the price for the number of units in the
Transfer Multiple field.

Transfer prices by zone
You must have the Franchise Pricing permission to import transfer prices. Transfer
prices by zone data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Required

Division name

Zone Required

Zone name

Transfer Multiple Required

Multiple amount; for example, if product is
3 for $1, you would enter 3 in this column.

Transfer Price Required

Price at which the item is sold to a
franchisee; if you use multiples pricing,
enter the price for the number of units in the
Transfer Multiple field.
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Zone exception
Zone exception data columns and descriptions are listed here.

Data Column (in order from first to last) Description

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Division Division name

Zone (Name) Store zone

Store Number (CustomerLocationKey) Use single quote (') before the value

Store number or identifier

Zone Override (IsZoneException) Enter 0 if the product does not have a zone
override; enter 1 if the product has a zone
override.

Zone group assignment
Zone group assignment data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Product Category (ProductCategory) Product category to which the zone group
will apply

Division Division name

Zone Group Zone group name

Zone override
This imports a file that overrides a scenario's optimized prices. Typically, you will
export the Price Approval report. Zone override data columns and descriptions are
listed here.

See “Exporting data” on page 75, make the price changes, and import the file back
into IBM Omni-Channel Merchandising.

Data Column (in order from first to last) Description

(ScenarioRunID) Required, unique key

Scenario ID; this ID is contained in the URL
on the Scenario Details page and appears
automatically if you export first. Do not alter
this column.

UPC Required, unique key, use single quote (')
before the value

20 digit UPC code

Zone Required

Zone name

Multiple (OverOptMultiple) Multiple associated with the override price;
do not alter this column.
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Data Column (in order from first to last) Description

Manual Override (OverOptMultiplePrice) Required

Override price that will replace the
optimized price

Price Effective Date Effective start date of the override price you
are importing

Related Topics

“Exporting data” on page 75

Zone-location mapping
This import maps locations to zones. If the zone does not exist, a new zone will be
created after import. Also, if the zone is set to empty/null in the import file, the
current mapping will be deleted, meaning that the store will be unassigned from
any zones. Zone-location mapping data columns and descriptions are listed here.

Data Column (in order from first to last) Description

Division Required

Division name

Zone Group Required

Zone group name

Zone (Name) Store zone

Store Number (CustomerLocationKey) Required, use single quote (') before the
value

Store number or identifier

Importing data files
Use this procedure to import data files. You must have the Import data to
applications user permission to import data from a local file into the applications.

About this task

Data can be imported into IBM Omni-Channel Merchandising services using the
Import dialog box.

Procedure
1. Choose Data > Import to open the Import dialog box.
2. Select the type of data that you are importing from the Data Type drop-down

menu.
3. Enter a description of the file in the Description text box. This will help you

identify the type of data you are importing. Use descriptions that tell you what
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category you are importing, or the types of edits you made, for example. The
description will be the best way for you to find your file in the Import Status
dialog box.

4. Enter the file name in the Upload File section. Make sure your file name
contains 8 characters or less. The import will fail if it contains more characters.

5. Click Import.
6. When the import data process completes, the Import Status dialog box opens

with your import listed.
Related Topics

“Checking import status”

Checking import status
You will only be able to view your data imports. The View all imports user
permission enables administrators to view imports of all users. Use this procedure
to check import file status.

About this task

When a data file is imported into a IBM Omni-Channel Merchandising service, the
import process checks for the valid number of columns, the correct type of data
(text or numeric in the appropriate records), the required fields, and if the records
are allowed to be inserted or updated.

You can check the status in the Import Status dialog box. The data file will either
be in the queue to be imported, in the process of being imported, completed, or
have errors. If the file has errors, you must fix the errors in your original file, and
then re-import.

Procedure
1. Choose Data > Import Status. The Import Status dialog box opens.

Each import is listed with a numeric ID, file name (typically your username),
status, and the description that you typed in when you imported the file.
The status is one of the following:
v Pending - The file is in the queue, waiting for import to begin.
v Importing - The file is being imported.
v Finished - The file is successfully imported and can be viewed in the

appropriate pages (product group data appears in the Product Group page,
for example).

v Error - The file was not imported successfully. Check the import log to view
the errors. To view the import log, click on the file name (the underlined
link). The Import Log dialog box opens. All of the errors are listed on this
dialog box per line. If there are errors, you can go to the correct line in your
original file, fix the error, and then start a new import.

2. Once imports are done, you can delete them from the Import Status dialog box
to reduce clutter. To delete an import, right-click on the import, and select
Delete. A dialog box appears asking if you are sure that you want to delete;
click Yes. The page refreshes and your import is deleted.

Setting alert subscriptions
Use this procedure to subscribe to receive alerts when you Import Market or New
Product from Excel.
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About this task

When you Import Market or New Product from Excel, you can subscribe to receive
alerts when an import Started, Failed, and/or Completed.

Procedure
1. Click on the toolbox icon at the top navigation bar on any of the pages. The

Alert Subscription pop-up window opens.
2. Click the Assortment tab.
3. Using the check-boxes, select the type of import alerts you would like to

receive.
v Checking a box under the Email column will send the alert to the email

address registered to the application.
v Checking a box under Inbox will send the alert to your Alert Inbox.
v If you check a box for the Assortment Import failed notification, you will

receive email with the link to the Import Error Log file.
4. When you are done selecting the type of alerts you would like to receive, click

Done.

Exporting data
You must have the Export data to applications user permission to export data
from the applications. Use this procedure to export data.

About this task

Data can be exported from IBM Omni-Channel Merchandising services to edit in
Excel, or to review. You can export data files, such as product groups, and reports,
such as Data Maintenance reports.

Procedure
1. Choose Data > Export. The Export dialog box opens.
2. Select the type of data that you want to export from the Report drop-down

menu.
3. Enter a description of the file in the Description text box using up to 8

characters. This will help you identify the type of data that you are exporting,
and will be the best way for you to find your file in the Export Status page.

4. Select the file type that you want exported: Excel 97-2003 (.xls), Excel 2007
(.xlsx), or CSV. CSV format is recommended for exporting large amounts of
data (above 130,000 records), since performance may vary with different
memory configurations on your computer. You can click the Get Record Count
button to view the total number of records that are in the report before
exporting. The following describes the formatting of report fields when
exported to a CSV file:
v Double quotes are not appended to fields, unless they need to be used for

the delimiter (a comma appearing in one of the numeric fields, for example,
as a decimal separator).

v All numeric/decimal number types will show a minimum of two decimal
places and a maximum of three. For IBM Markdown Optimization, five
digits are allowed before the decimal point.

v Currency fields are displayed based on the locale Decimal and thousands
separators are based on the locale.
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v All dates are displayed in short format (mm/dd/yy or dd/mm/yy) and are
formatted per locale If the date needs to be displayed with the time, it will
be displayed in short format Large CSV files should be opened using
Notepad or another text editor, instead of Excel. If you must use Excel to
view the CSV file, import the file into the Excel application.

5. Select the division that you want to export from the Division drop-down
menu. The Division drop-down menu will only display if the report requires a
division for exporting. You can select multiple divisions using Shift-click or
Ctrl-click for certain reports.

6. Select the product category that you want to export from the Export Category
drop-down menu. The Export Category drop-down menu will only display if
the report requires a product category for exporting. You can select multiple
categories using Shift-click or Ctrl-click, or select All Categories for certain
reports.

7. Select the store group that you want to export from the Export Store Group
drop-down menu. The Export Store Group drop-down menu will only display
if the report requires a store group for exporting.

8. Click Export. The Export Status dialog box opens, and your export is listed.

Checking export status
Use this procedure to check data export status, after a data export has started. You
will only be able to view your data exports. The View all exports user permission
enables administrators to view exports of all users.

About this task

Procedure

Choose Data > Export Status. The Export Status dialog box opens.
Each export is listed with a numeric ID, file name (typically your username),
status, and the description that you typed in when you imported the file.
The status is one of the following:
v Exporting - The file is being exported.
v Finished - The file is successfully exported. You can view the file by clicking on

the file name (underlined link). The file will open in an Excel browser window.
You can print, edit, or save the file from this window.

v Error - The file was not exported successfully.

Once exports are done, you can delete them from the Export Status dialog box to
reduce clutter.

Deleting an export
Use this procedure to delete an export.

Procedure
1. Right-click on the export.
2. Select Delete. A dialog box opens asking if you are sure you want to delete.
3. Click Yes. The page refreshes and your export is deleted.
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Chapter 4. Attributing Overview

The product attributing process is a series of tasks in IBM OpenLink to prepare the
product information for the modeling and optimization processes.

The product attributing process is a series of tasks in IBM OpenLink to prepare the
product information for the modeling and optimization processes. Attributing
involves correcting errors and inconsistencies in the product attributes, such as
size, brand, and unit of measure. These attributes are used to associate SKU data in
a Demand Group with existing pricing history in the same Demand Group.
Demand Groups are assigned to SKUs so that a statistical analysis technique called
Bayesian Inference can borrow information from products with a detailed demand
history to help build the demand curves for other products with insufficient
demand data.

A Demand Group is a set of highly substitutable products. For a typical consumer,
these are products that are chosen based on price and product attributes. Some
examples include paper towels and liquid laundry detergent. All products in a
Demand Group will exhibit cannibalization.

The application provides two options to attribute products:
v Product Information File (PIF) export/import process - This process allows you

to export the PIF to an MS Excel file, attribute the products, and re-import the
information back to the system.

v Attributing UI - You can set up rules for attributing at the category level directly
in the application.

The PIF is described in more detail since it is currently the most common process.
Related Topics

“How Attributing Works”
“Understanding the Category Manager Workspace” on page 80

How Attributing Works
Use this reference to learn about the attributing process in OpenLink.

The attributing process is part of the overall OpenLink process:
v Import data, such as POS, data warehouse, supply chain, and legacy systems
v Convert the data to the proper format for the OpenLink staging database
v Validate, check for errors, and approve data
v Attributing - Prepare the data for the modeling and optimization processes.

Involves categorizing all products in your merchandise category, assigning
values to attributes, and validating attributes such as size, unit of measure, and
brand. For Everyday Price Optimization and Everyday Price Management
optimizations, you will add values for Line Groups, pre-prices, Size Family/Size
Class, Brand Family/Brand Class, and Other Family/Other Class.

v Demand model the data
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Related Topics

“Attributing Process”

Attributing Process
The Attributing process is usually completed using both IBM OpenLink and
Microsoft Excel

The Attributing process is usually completed using both IBM OpenLink and
Microsoft Excel. The following is a high-level overview of each step in the process.

Step Description Notes® Tool

1 Approve/reject
category moves (if
applicable)

Review if products
are moving
categories. Check
Uncategorized
category for
orphaned products.

OpenLink

2 Run Product Status
Resolver (if store
level status is not
being sent)

Be sure to run the
PSR before
conducting the Price
Update process to
ensure products have
an updated status;
some customers may
want to run the PSR
following the POS
file approval each
week in OpenLink.

OpenLink
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3 Export PIF Access the PIF via
the automated email
message sent by
OpenLink upon PIF
Export completion.
Click on the link or
copy and paste the
link into a new
Internet Browser
window.

OpenLink

4 Edit content using
PIF

a. Demand Group

b. Size

c. UOM

d. Brand

e. Included in Model

f. Size Class/Family**

g. Brand
Class/Family**

h. Line Group**

i. Pre-Price

j. Other
Class/Family1**

k. Other
Class/Family2**

A PIF (Product
Information File) is
an Excel spreadsheet
and should be
treated as such. Do
not delete columns
from the PIF, but
columns can be
moved (re-ordered)
without incident. If
products should not
be modeled, drop
them from the PIF by
changing include in
model to No.

Opt for smaller
demand group
structures and more
Demand Groups
relationships. (Avoid
single product
demand groups, if
possible).

Note: Line group,
Pre-Price, Size
Family/Size Class,
Brand Family /
Brand Class and
Other Family/Class
values can be
included in the PIF
and imported into
OpenLink, but these
values are used for
optimizing in
Everyday Price
Optimization and
Everyday Price
Management and are
not needed for the
modeling process.

Excel PIF

5 Import PIF Ensure all formatting
and additional
worksheets are
removed. Limit the
length of the file
name for import.

OpenLink
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6 Run Equivalent Units Be sure that # with
POS to be
equivalized is 0
before submitting PIF
for modeling.

OpenLink

7 Conduct integrity
checks

Use the Category
Breakdown reports -
Brand and Demand
Group aggregation.
Accept or fix errors
as needed.

OpenLink

8 Edit content (if
applicable)

Double check brand
names and fix issues
from Equiv. Units as
necessary. This step
may prompt several
steps above to be
completed again.

OpenLink

9 Complete Demand
Groups Relationships

We suggest Demand
Groups relationships;
verify and update, if
needed.

OpenLink

10 Mark products as
attributed

Marks products as
attributed. This also
"resets" the # of
Unattributed column
to zero so that new
products can be
easily identified after
initial attributing is
sent to IBM
Omni-Channel
Merchandising
statistician.

OpenLink

11 Set Category Status Alerts the IBM
Omni-Channel
Merchandising
statistician that the
category is ready to
be modeled.
Statistician receives
an email if
subscribed to receive
this alert notification.

OpenLink

Understanding the Category Manager Workspace
The Category Manager displays the imported categories and the general statistics.
You use it to manage attributing processing, such as running Product Status or
Equivalent Units.

The Category Manager displays the imported categories and the general statistics.
You use it to manage attributing processing, such as running Product Status or
Equivalent Units.
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The Basic tab displays some of the most commonly viewed columns in the page,
such as the category name, total number of products in the category, number of
unattributed products in the category, and the date of the last scan within the
category. The Detailed tab displays these columns and more information about the
category.

The Data Characteristics tab shows information about each category, including
information relevant to modeling, as well as reporting metrics that show basic
information about category performance, such as volume ratios when on ad, as
well as information about data sparsity, such as the Missing Weeks Count.

You can view the individual products within a category by right-clicking on the
category, and selecting Edit Content or Category Workspace. You can also view all
the products by category in the Sellable Items report, available within Data
Maintenance.

Note: You must have the Enable Category Manager permission set to access the
Category Manager page.
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“Viewing Category Changes” on page 83

“Moving Uncategorized Products to Categories” on page 144

“Running Product Status Resolver” on page 87

“Exporting the PIF” on page 91

“Editing Content and Attributing” on page 95

“Conducting Final Checks” on page 113
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Chapter 5. Preparing to Attribute

Some tasks must be completed to prepare the content for attributing in the product
information file (PIF).

Some tasks must be completed to prepare the content for attributing in the product
information file (PIF).

Related Topics

“Viewing Category Changes”
“Moving Uncategorized Products to Categories” on page 84
“Running Product Status Resolver” on page 87

Viewing Category Changes
Use this procedure to view Category Changes.

About this task

Products often change categories when new category hierarchy structures are
approved. Some category changes are due to anomalous data. You must approve
or reject these system-generated product category changes. Category changes
initiated by the user would not require a review. You can either view changes for a
particular category, or view changes across all categories.

To view category changes:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.

Note: To view changes across all categories, choose Category > View Product
Category Changes to open the Product Category Changes page described in
Step 4.

2. Look for categories that have a value other than zero in the # of Products
Entering Category column in the Detailed tab. This value is the number of
new products in the category.

3. Right-click on a category for which you want to view category changes. The
context menu displays.
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4. Select View Product Category Changes. The Product Category Changes page
displays all products that are designated to enter the category.

5. Click Approve All or Reject All if all products are acceptable or not acceptable.

Note: When you select specific items that you want to submit for category
change approval, the Approve All option will be disabled. This will protect
you from accidentally approving all of the eligible category changes.

6. To select individual products, set either the Accept or Reject checkbox next to
each product.

7. Click Submit. The approved products are added to the category.

Moving Uncategorized Products to Categories
If the application does not recognize a new product hierarchy from the product
file, the products are labeled as Uncategorized.

Once all product data has been imported into OpenLink, any subsequent re-loads
of the product file will use the IBM Omni-Channel Merchandising categories and
not the original retailer product hierarchy. If the application does not recognize a
new product hierarchy from the product file, the products are moved to the default
optimization category, UNCATEGORIZED. You can assign them to a category in
either the Edit Content page or the Category Workspace page.

During the product file import into OpenLink, a new product hierarchy validation
will flag all products that belong to UNCATEGORIZED. If this validation is
ignored, all of the products will get routed to UNCATEGORIZED and will remain
there until you manually move them.

In addition, any POS, Cost, or Price data for unknown products (products without
a previous product record) will cause a "dummy" product record placed in the
UNCATEGORIZED category and must also be manually moved.

If you are moving products into a category that has been attributed, you will need
to ensure that the attributing process is conducted for the new products. This
includes re-running PSR (as needed), assigning Demand Groups, checking the size,
unit of measure, brand, and equivalent units.

Note: You must have the Enable Attributing permission set to access the Edit
Content and Category Workspace pages.
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Related Topics

“Using the Edit Content Page”
“Using the Category Workspace Page” on page 86

Using the Edit Content Page
Use this procedure to move uncategorized products to categories in the Edit
Content page.

About this task

To move uncategorized products to categories in the Edit Content page:

Procedure
1. In the Category Manager page, right-click on an UNCATEGORIZED category

with the products that you want to move, and select Edit Content from the
context menu. The Edit Content page displays.

2. Choose the All Products report from the Report drop-down menu.
3. For the products that you want to move, click in the Opt Category column to

select a new category from the drop-down list of categories. This will assign the
products to the new optimization category.

4. Click Save in the upper right corner of the Edit Content page. The products are
moved into the destination category and into the default model group and
default model category for the new optimization category.
In the Category Manager page, you will see the items you have moved listed
in the new destination category. The number of products for the destination
category will increase based on the number of products that you have moved.
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Using the Category Workspace Page
Use this procedure to move uncategorized products to categories in the Category
Workspace page.

About this task

To move uncategorized products to categories in the Category Workspace page:

Procedure
1. In the Category Manager page, right-click on an UNCATEGORIZED category

with the products that you want to move, and select Category Workspace from
the context menu. The Category Workspace page displays.
The UNCATEGORIZED category will be highlighted in the Category panel,
and all of the products will be listed in the Unassigned Products panel since
they are stored in the category’s Default Demand Group.

2. For the products that you want to move, select and drag each product from the
Unassigned Products panel to a category in the Category panel. When you see
the product name projected over the category that is underneath the bolded
line, release the mouse button. The product will be added to the destination
category in its Default Demand Group, and you will notice an increase in the
number of products.
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Note: The Status column shows whether the category has errors, if the Product
Status Resolver is running, or if the Product Status Resolver ran successfully.
Mouse over the status indicator icon to see the status message or number of
errors.

3. With the destination category selected, you can move products from the Default
Demand Group to a specific Demand Group in the Demand Group panel
using drag-and-drop functionality.
See “Editing Content in the Category Workspace Page” on page 120 for more
information about this page.

Running Product Status Resolver
Product Status Resolver identifies products within a category as either active or
discontinued.

About this task

Product Status Resolver identifies products within a category as either active or
discontinued. The status appears in the product information. Both active and
discontinued products will be modeled, but only active products will be included
in forecasts. During the optimization process, products with a discontinued status
will not receive optimized prices.

Note: If you have sent a SKU-Store status location file to IBM Omni-Channel
Merchandising (which is preferred), you do not need to run Product Status
Resolver. If you do initiate the task in this situation, the task will run but will not
update status values that were loaded via the status file by default. A system
setting (PSR_Overrides_Status_Files) can be configured to control the overwriting
behavior. Contact your IBM representative for more information.

By default, the following criteria are used to determine the current product status:
v If an item is a seasonal product, the item is active if it has sold in the last 365

days. Otherwise, it is discontinued.
v If an item is not a seasonal product, the item is active if it has sold in the last 90

days. Otherwise, it is discontinued.
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You can run Product Status Resolver either manually for a selected category, or as
an automated process in the Task Scheduler for one or more categories at set time
intervals.

To manually run Product Status Resolver:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category for which you want to run the Product Status

Resolver. The context menu displays.

3. Select Run Product Status. The Product Status Job Log page displays all
categories in the Product Status process. The data is shown at the store/SKU
level.

4. Press F5, or click the refresh button on the browser to refresh the screen for
updated job statuses.

5. Once the Product Status process is complete, the job status in the Job Status
column will change to Complete, and the number of status updates (from
active to discontinued, or discontinued to active) will display in the #of
Updates column.
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6. To view the products in the category that changed status (from active to
discontinued, or discontinued to active), right-click on the category, and select
View Prod. Status Details. The Product Status Change Details page opens.

7. Click View Log to return to the Product Status Job Log page.
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Chapter 6. Attributing for Modeling

Attributing involves assigning Demand Groups, size, unit of measure, and other
attributes to products in a product information file (PIF).

Attributing involves assigning Demand Groups, size, unit of measure, and other
attributes to products in a product information file (PIF). This process prepares the
product categories for demand modeling.

Related Topics

“Exporting the PIF”
“Editing Content and Attributing” on page 95
“Importing the PIF” on page 111
“Conducting Final Checks” on page 113
“Creating Demand Group Relationships” on page 124
“Marking Categories as Attributed” on page 129
“Notifying Modelers” on page 132
“Auto-Assigning Demand Groups to New Products” on page 133

Exporting the PIF
You can export the product information into a Microsoft Excel file called a product
information file (PIF) to attribute the products.

You can export the product information into a Microsoft Excel file called a product
information file (PIF) to attribute the products. The PIF is exported from OpenLink,
manipulated, and then imported back into OpenLink. The current values from the
product database will populate the attribute columns in the PIF, which you can
edit. Those columns with missing values will appear as blank, in which you can
enter your own values. After exporting, it is important that you do not change the
PIF column structure in the Excel file due to data integrity and importing
restrictions. See “Attribute Table” on page 97 for detailed information about the
attribute columns.

You can select the product attribute columns and determine their order in the PIF
output. The selected attribute columns will also display in the Edit Content page.
The attribute columns that can be selected are considered optional and are not
required for modeling. For example, columns such as Brand Class and Size Class
are primarily used for IBM Price Optimization rules, and the Level1Code/Descr
columns are customer product hierarchy levels often used as a reference for setting
up Demand Groups.

Products can be automatically assigned to Line Groups, and Size Classes and Size
Families as part of the PIF export process. If you choose to also keep the existing
values, the products will be added to existing groups. Any existing assignments
will also remain. If you do not keep the existing values, new Line Groups will be
created using brand, volume of measure, and base cost/price; Size relationships
will be created using product name/description, brand, and volume of measure.
This feature will be most valuable when there are no pre-existing values in the
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application, and you are setting up Line or Size relationships for the first time. See
“Auto-Assigning Line Groups and Size Relationships” on page 94 for more
information. Note that products can also be assigned by choosing the Assign
Product Relationships right-click menu option in the Category Manager page.

Note: Before you export, be sure of the following:
v Product Status Resolver has been run
v The last scan date is recent. You can check the last scan date in the Last Scan

column in the Category Manager page (OpenLink > Category Manager)

.
v The last Summary Statistics run date is recent. Summary Statistics include

statistics for sales and volume, for example. If Summary Statistics has not been
run recently, you can update them as an automated process in the Task
Scheduler for one or more categories.

Note: Summary Statistics should initially be run once from the Task Scheduler.
This full run will update the Summary Statistics based on two years of POS data.
Subsequently, they will be automatically updated after each new POS data load,
and there will be no need to schedule a job. You can view the last Summary
Statistics run date in the Last Summary Stats Run column in the Category
Manager page (OpenLink > Category Manager) in the Detailed tab.
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Related Topics

“Attribute Table” on page 97
“Auto-Assigning Line Groups and Size Relationships” on page 94
“Exporting the PIF to Excel”

Exporting the PIF to Excel
Use this procedure to export the PIF.

About this task

To export the PIF:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category to export, and select Export Data. The Export Data

dialog box displays with the Drop Outdated Products and Hide Dropped
Products options set by default.

3. Keep Drop Outdated Products checked to remove outdated products from the
modeling task. These products will not be included in the export file. Outdated
products are those products that last scanned before the modeling period (104
weeks by default). If you clear the checkbox, all products assigned to the
category will be exported and their status will not be changed.

4. Keep Hide Dropped Products checked to remove products that have been
dropped from the category from the exported PIF. If you clear this checkbox,
previously dropped products will be included in the exported PIF file.
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5. Set the Auto-Assign Line Groups, Auto-Assign Size Relationships
checkboxes, or both to assign products from the product database to Line
Groups, Size Classes, and Size Families. Set Don’t overwrite existing line
groups to keep the existing assignments and assign the products to the existing
groups. If you would prefer to discard existing line group information and
attempt to auto-generate all line groups, select Auto-Assign All. OpenLink will
create new line or size relationships based on product attributes and POS
statistics.

6. Click Continue. An automated email will be sent to your email account (the
user who exported the PIF), the Alert Inbox in the top right of the application,
or to both if you have subscribed to receive an alert when the PIF has
completed exporting. The email will contain a link to the PIF. See “Alert inbox”
on page 22 for more information about subscribing to the alerts.

7. Select the link to download and open the PIF.

Auto-Assigning Line Groups and Size Relationships
Products can be automatically assigned to Line Groups, and Size Classes and Size
Families as part of the PIF export process.

Products can be automatically assigned to Line Groups, and Size Classes and Size
Families as part of the PIF export process, or by choosing the Assign Product
Relationships option in the Category Manager page. For a general overview of
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this feature, see “Exporting the PIF” on page 91; for instructions on enabling this
feature in the Export Data dialog box, see “Exporting the PIF to Excel” on page 93.

Note: When Line or Size relationships are auto-assigned in a PIF export, the
database is updated with these values, and then read into the PIF. If you want to
clear out or change any recommended values, you must edit them in the PIF and
then import the PIF, which will then update the database. If you run this process
from the Category Manager, the database will also update. To remove or change
any recommended values, you must edit them in the Edit Content page and save
the report.

New Line Groups are created using brand, volume of measure, and base
cost/price. Size relationships are created using product name/description, brand,
and volume of measure. The following describes the logic behind how the Line
Groups and Size Relationships are assigned:
v Line Group - Two products fall in the same Line Group when they have the

same brand, similar cost (up to 5% variation), and similar volume (up to a 2%
variation).

v Size Family - Two products fall in the same Size Family when they have the
same brand and similar product description. The product description is matched
using the following steps:

v Each product description is split into a list of valid words. A valid word is one
that is not a brand or unit of measure, length >= 3, and special characters like *,
%, etc. are removed.

v Valid words between products are "fuzzy matched". Fuzzy match is a natural
language processing on words. Basically, it is matching MILK to MLK, etc.

v Best matching scores for each product are picked, as long as the score is >= 2,
for example, when two or more words match between product descriptions. The
brands need to match as well.

v Size Class - Size Class is assigned within a Size Family with a 10% variation in
size. For example, say we have three products of size 2, 4, 8 in a Size Family,
and we assign Small, Medium, and Large respectively. If it is 20, 40, 80, we still
assign the same way. If we have 20, 40, we assign Small and Large respectively.
If we have 2, 4, 8, 16, then we have X-Small, Small, Large, X-Large respectively.
A medium size is assigned only when the number of products in a Size Family
is odd.
Related Topics

“Exporting the PIF” on page 91
“Exporting the PIF to Excel” on page 93

Editing Content and Attributing
Attributing a PIF essentially involves assigning Demand Groups, size, unit of
measure, and other attributes to products in a PIF.

Attributing a PIF essentially involves assigning Demand Groups, size, unit of
measure, and other attributes to products in a PIF. You also edit and scrub content
in the PIF to maintain consistencies and correct errors. These tasks will help ensure
accurate modeling.
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Note: It is important that you do not delete any of the columns in the PIF. Any
new columns that you add will not be recognized and will be ignored in the
modeling process.

Note: PIFs are not required for Markdown Optimization.
Related Topics

“Getting Familiar With the PIF”
“Attribute Table” on page 97
“Understanding the Category” on page 100
“Dropping Products” on page 100
“Populating Demand Group Structures” on page 101
“Equivalizing Size and UOM” on page 102
“Scrubbing Brand Names” on page 103
“Everyday Price Optimization and Everyday Price Management Attributes” on
page 103

Getting Familiar With the PIF
The product information file (PIF) is an Excel spreadsheet that contains the product
attribute information required for the modeling process.

The product information file (PIF) is an Excel spreadsheet that contains the product
attribute information required for the modeling process. It is a convenient format
for attributing the content.

The column header prefix in the PIF indicates where the information is going, such
as the modeling or optimization database. Sometimes information flows into two
areas simultaneously.

This is an example of an exported PIF:

Note: The Ref column prefix nomenclature indicates that the information is
reference only, and must not be changed.

Related Topics

“Attribute Table” on page 97

96 IBM OpenLink: Users' Guide



Attribute Table
Refer to the following table for the attribute column descriptions, allowable values,
and from where the pre-populated data on the PIF comes from.

Refer to the following table for the attribute column descriptions, allowable values,
and from where the pre-populated data on the PIF comes from. Highlighted rows
indicate attributes that are editable or should be completed in the PIF.

Attribute Name Attribute Description Allowable Values for
Category - how to
complete PIF

Data Source - where
is pre-populated data
coming from?

Ref UPC UPC from retailer Do not change UPC as defined by
the retailer

Ref Customer
Product Key

Retailer product
numbering system. If
not available, will
default to UPC.

Do not change UPC or retailer ID as
defined in map

Unapproved Indicates if the
Demand Group that
was auto-assigned to
a new product since
the category was last
modeled was
approved or not (see
“Auto-Assigning
Demand Groups to
New Products” on
page 133)

Yes or No Model Demand
Group in the
Demand Group
column. This can be
changed to a
different Demand
Group before
approving.

Displays only if you
have the Enable
Auto-Assign Product
to Demand Groups
permission to view
the auto-assigned
products.

Auto Assigned Date The date that the
Demand Group was
auto-assigned to the
new product (see
“Auto-Assigning
Demand Groups to
New Products” on
page 133)

Do not change Demand Group is
auto-assigned based
on how the new
product's attributes
align with existing
Demand Groups.

Displays only if you
have the Enable
Auto-Assign Product
to Demand Groups
permission to view
the auto-assigned
products.

Include in Model Indicates whether a
product should be
included in the
Price/Promotion
modeling or not

Yes, or No (when the
model status for a
product is
Discontinued)

Model status of
product

Description Product Description
to be sent to
Everyday Price
Management

Numerical/
Alphabetic

Retailer description.
If retailer has more
than one description,
check with map.
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Demand Group A collection of highly
substitutable
products

Alpha-numeric, 50
characters maximum.

Default is
DEFAULT_demand
group

Size Size (Volume of
Measure) to be used
for modeling at the
retailer/division/
category level. This
size can be inferred.

Numerical. If free or
bonus product,
includes base size +
amount free. (Ensure
Size Class code is
grouped with the
base product VOM
for free products).

Retailer's product file

UOM Unit of Measure to
be used for modeling
and optimization at
the retailer/category
level. UOM should
be consistent within a
Demand Group.

Alphabetic CT, OZ,
LOAD, SHEET, LB

Retailer's product file

Brand Corrected/inferred
brand to be used for
modeling. Brands can
be streamlined in the
PIF or on the
OpenLink Category
Breakdown page.

Alphabetic, no illegal
characters (&, /, *)

Retailer's product file

Manufacturer User-defined
manufacturer of the
product. This can be
defined in the PIF or
on the Edit Content
screen.

Alphabetic, no illegal
characters (&, /, *)

N/A

Ref DT Status Determined by
aggregating the
results of the Product
Status Resolver rules.
If the product is
scanned in any
location, the
Ref_DT_Status is
active.

Do not change From the results of
the Product Status
Resolver, if run.

Ref Customer Status The product status as
it is sent from the
retailer

Do not change Retailer's location
status file; defaults to
ACTIVE if no value
is sent

Ref Current Retail Average of Current
Retail Price across
stores over the last 12
months, if loaded

Do not change From retailer POS
scan data

Ref Avg Scan Price Volume-weighted
Average Scan price
over the last 12
months derived from
POS data

Do not change From retailer POS
scan data

Ref Price per UOM Ref Avg Scan
Price/Size

Do not change N/A
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Ref Cost Volume-weighted
Average Scan price
over the last 12
months derived from
POS data

Do not change From retailer POS
scan data

Ref Avg Weekly
Volume

Average Weekly
Volume over the last
12 months across all
stores at chain level.
If IBM Omni-Channel
Merchandising does
not have a record for
a week, the volume
is not counted as
zero.

Do not change From retailer POS
scan data

Ref Total Revenue Total revenue of the
product

Do not change From retailer POS
scan data

Ref First Scan Date The first time a
product in the
category (across all
stores) was scanned

Do not change From retailer POS
scan data

Ref Last Scan Date The last time a
product in the
category (across all
stores) was scanned.
If the last POS file
was received on
Monday, 1/20/2003
and the last time a
product scan was
Friday, 1/10/2003,
the Last Scan Date =
1/10/2003.

Do not change From retailer POS
scan data

Ref Customer Level 1
Descr - Level 6 Descr

Description for the
Ref Customer Level 1
- Level 6 code. Very
useful for assigning
Demand Group
names as sometimes
the customer's
hierarchy emulates a
Demand Group
structure.

Do not change From retailer product
data

Has Attributes Indicates whether a
product has
attributes or not.

1 - Yes 0 - No Attributing status of
product.

This will be
populated if the
product's category
has been marked as
attributed in the
Category Manager
page, or if the
Attributed column
has already been set
for the product in the
Edit Content page.
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Ref ProductId An assigned unique
SKU ID

Do not change Systematically
generated

Ref ProductCategory The retailer's
category name

Do not change From retailer product
data

Related Topics

“Auto-Assigning Demand Groups to New Products” on page 133

Understanding the Category
You can use the following resources to research the product and category.

Review the entire PIF to understand the products and category. It is a good idea to
get a sense of the equivalent units, sizes, and customer buying habits for the
products. You can use the following resources for your research:
v Category Manager interview - The Category Manager is a great source of

information. Conducting a store walk-through or an interview with the Category
Manager is a good way to get to know a category before the attributing process
begins. It is a helpful way to understand the product, see product placement,
and identify unknown or new products within the category.

v Store walk-through - The store walk-through can provide some valuable
information, especially if a sub-category structure is required. You can work with
the Category Manager to understand the optimization strategy and how to
optimize the prices.

v World Wide Web - These web sites offer user manuals, product information
down to the equivalent unit detail, as well as valuable preferences and decision
trees:

v UPCdatabase.com
v Your company’s web site
v The manufacturer’s web site
v A specific UPC entered in a search engine of your choice, such as Google,

Yahoo!, MSN, etc.

Dropping Products
Since deleting products from the PIF is not optimal, you simply enter a value in
the PIF for the products to be dropped.

Products that are inactive or outdated can be dropped so that they are ignored
during the modeling and optimization processes. Since deleting products from the
PIF is not optimal, you simply enter a value in the PIF for the products to be
dropped.

Products are typically dropped from PIFs for the following reasons:
v Not all of the products on the PIF need to be attributed. Because OpenLink

exports all products in the retailer's product file, regardless of the POS data,
products can be on the PIF, but will never be used in the modeling or
optimization processes. To identify these marginal products in the PIF, look for
products with:

v Ref Customer Status or Ref DT Status = Discontinued
v Last Scanned Date > 90 days prior to the last scan for category
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v Avg Weekly Volume is less than or equal to one unit
v Products are non-saleable- Retailers often have non-saleable products listed in

the product for replenishment purposes. Items such as pamphlets, display items,
and shippers are included in the PIF, but do not need to be attributed because
they are not sold and will not affect the share model.

v Products are unidentifiable- Occasionally, a product description is not enough to
identify the UPC. Because the PIF includes both active and discontinued
products, UPCs often cannot be found through any website as well. When this
problem occurs, review the Customer Status field. If it is discontinued, drop the
product.

To drop a product, enter No in the Included in Model column. This will trigger
the modeling process to ignore the product, therefore eliminating it from the
optimization process as well.

When the PIF is imported, all dropped products will be automatically moved into
the DROPPED_FROM_MODELING Demand Group (if you have this system
setting enabled). If a product is manually moved into this Demand Group in the
PIF, Included in Model will be automatically set to No upon PIF import. If this
system setting is not enabled, dropped products will remain in their existing
Demand Group.

Note: The system setting for automatically moving dropped products to the
DROPPED_FROM_MODELING Demand Group should not be enabled if you
regularly include dropped products in rule groups and pricing actions in IBM Price
Optimization and IBM Price Management. This is because the automated
assignment of these products to the DROPPED_FROM_MODELING Demand
Group and NON_MODELED model category could create rule violations,
depending on the assignments of the other products in a rule group.

If you later choose to include a product in the modeling process by changing No
to Yes in the Included in Model column in the PIF, you should specify a new
Demand Group for the product. Products without Demand Groups will be
automatically assigned into the Default Demand Group along with new products.

Populating Demand Group Structures
Demand Groups are groups of highly substitutable products.

Demand Groups are groups of highly substitutable products. The price and
promotion of one item in the group directly affects demand for the other items.
Demand Group names can be up to 50 characters long. Examples of Demand
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Groups include LARGE EGGS, EGGS SUBSTITUTE, and DIET SOFT DRINKS. In
the PIF, you assign Demand Groups in the Demand Group column.

Before populating Demand Groups with products, consider the following:
v Seasonal products should be in their own Demand Group
v Products should have similar size: Trial sizes and industrial size (really large)

products should be in their own Demand Group
v Products should have similar price points since they are HIGHLY substitutable
v Think: How are the products merchandised on the shelf – what does the

customer see when making a purchasing decision?
v Think: What products will be cannibalized if I put one product on promotion?
v Always keep in mind how your average customer shops your category at your

store

Here are some best practices as you populate the Demand Groups in the PIF:
v Fill in Demand Groups in the “Demand Group” field
v Use custom filters to help
v Use your REF Level Fields (product hierarchy) information
v Move or hide columns on the PIF to put valuable information side by side

These are some rules for entering Demand Group names:
v Up to 50 characters long
v Alpha-numeric characters only
v Demand Group names should be ALL_CAPS
v Opt for smaller Demand Groups:
v As a general rule of thumb, Demand Groups should contain between 15-50

products
v Avoid single-product Demand Groups if possible
v Use suffixes to separate Demand Groups:
v PRM = Premium (for example, LOTION_PRM)
v ECON = Economy (for example, LOTION_ECON)
v TS = Trial sizes (for example, LOTION versus LOTION_TS)
v IND = Industrial or large sizes (for example, TOMATO_SAUCE versus

TOMATO_SAUCE_IND)

Equivalizing Size and UOM
Size and unit of measure (UOM) information from the data provider cannot always
be used for the modeling process.

Size and unit of measure (UOM) information from the data provider cannot always
be used for the modeling process. An understanding of consumer behavior is
required to apply the correct size and unit of measure for modeling. For example,
data on candy bars comes as follows:
v Hersheys almond bar 6 oz
v Milky Way bar 5.3 oz
v Three Musketeers bar 6.2 oz
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The consumer is not paying for each candy bar by the ounce. Instead, the
consumer is choosing a one count bar of candy. As such, the size should be 1, and
the UOM should be count (CT).

In another example, data on laundry detergent comes as follows:
v Tide 128 ounce (32 loads), $9.99
v Tide Ultra 64 ounce (32 loads), $9.99
v Tide 64 ounce (16 loads), $5.99

The consumer is not paying for the ounces in the package. Instead, the consumer is
paying for the number of loads completed by each product. By changing the size
and unit of measure to the number of loads, the products can be equivalized, and
the size/UOM relative to the price makes more sense.

Two UOMs within a Demand Group is not preferred, but is sometimes necessary.
For example, nail polish remover has both ounce and count UOMs. If the
distribution of products in each UOM is equitable, then this is not necessarily a
problem. The modeling process will assign a unique equivalent value to each
UOM. If one UOM value does not have a sufficient sampling, however, the median
price of that UOM might be skewed.

Scrubbing Brand Names
Brand assignment in the attributing process is extremely important to ensure
consistent brand rules.

Brand assignment in the attributing process is extremely important to ensure
consistent brand rules. Examples such as the following should be addressed:
v The brand may represent the manufacturer instead of the brand. In some

categories, such as cereal, the Brand field is actually the manufacturer (for
example, General Mills, not Cheerios). The Brand name should be changed on
the PIF to reflect the actual brand, so that rules can be applied in Everyday Price
Optimization and Everyday Price Management.

v The Brand name is not consistent. Brand names will often be inconsistent (for
example, Natural Grain comes in as NaturalGrain, and Natural Grain or Starkist
comes in as Strkst. SK, or Stkst) due to the many people who may have
managed a category’s data throughout the years.

v The Brand name is sometimes not provided, and needs to be completed in the
PIF.

Everyday Price Optimization and Everyday Price Management
Attributes

Product Relationship attributes are not required for the modeling process, but are
used for Everyday Price Optimization and Everyday Price Management rules.

Product Relationship attributes are not required for the modeling process, but are
used for Everyday Price Optimization and Everyday Price Management rules.
Include these additional attributes in your product information file (PIF) if you are
planning to create optimization scenarios in the Price application. You can assign
values to these optional attributes while the Modeling team processes the models
for the required attributes described in Chapter 6, “Attributing for Modeling,” on
page 91.
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The Product Relationship attributes establish pricing relationships between
different line groups, sizes, brands, or other types of classifications in optimized
scenarios.

Note: Products that have been dropped from modeling in the PIF will still be
included in optimized scenarios in Everyday Price Optimization and Everyday
Price Management if they have been assigned Product Relationship attributes and
are still active. If you do not want to include a product in a pricing action, it
should not have any Product Relationship attributes assigned to it.

Related Topics

Chapter 6, “Attributing for Modeling,” on page 91
“Attributes Table”
“Understanding the Category” on page 100
“Assigning Line Groups” on page 108
“Assigning Size Family and Size Class” on page 108
“Assigning Brand Family and Brand Class” on page 109
“Assigning Other 1 & 2 Family and Other 1 & 2 Class” on page 110

Attributes Table
Refer to the following table for the Product Relationship attribute column
descriptions, allowable values, and from where the pre-populated data on the PIF
comes from.

Refer to the following table for the Product Relationship attribute column
descriptions, allowable values, and from where the pre-populated data on the PIF
comes from.

Attribute Name Attribute Description Allowable Values for
Category - how to
complete PIF

Data Source - where
is pre-populated data
coming from?
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Size Class Applied in IBM
OpenLink or IBM
Price Management.
Each item in a Size
Family is given a
number/level: 8 oz =
SMALL, 16 oz =
MEDIUM, 24 oz =
LARGE

Allowable Size Class
formats are size
classes that are
defined for the
category in IBM Price
Management. If the
Size Classes have not
yet been defined, use
the default Size
Classes
(XXX-LARGE,
XX-LARGE,
X-LARGE, LARGE,
MEDIUM, SMALL,
X-SMALL, XX-
SMALL,
XXX-SMALL), which
can later be modified
in IBM Price. 50
characters maximum.

Do not include Bonus
products or
Trial/Travel sizes in
Size Class.

Blank

Size Family Applied in IBM
OpenLink or Price
Optimization. Size
Family is used to set
rules for pricing on
how different sizes of
the same product
should be priced on
an absolute basis (for
example, Small <
Medium < Large),
and on a relative
basis based on the
equiv price (for
example, the large
should be a better
value than the
medium.

Alphabetic, 50
characters maximum

Blank

Brand Class A value which
differentiates two
products with a
family. In this case,
Brand Class
differentiates
products within a
Brand Family.

NATIONAL,
PRIVATE LABEL, or
define as needed, 50
characters maximum

Retailer's product
file, usually blank
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Brand Family A value which links
two products
together for the
purpose of
comparison through
rules. The Brand
Family is usually the
type and size of the
product being
compared across
brands.

Alphabetic, no illegal
characters (&, /, *),
50 characters
maximum

Retailer's product
file, usually blank

Line Group Line price group
value sent by retailer

Alpha-numeric, no
spaces or illegal
characters (&, /, *),
50 characters
maximum

Retailer's product file

Is Pre Priced Indicated pre-priced
product, supplied by
the retailer.
Populated with a 1 if
the product is
pre-priced. A
pre-priced product
will NOT change
price during the
course of the
optimization.

Pre-priced product =
1

Non-prepriced
product = 0

Default is 0; if the
value comes from the
retailer,1 indicates a
pre-priced product

Other Class1 A value which
differentiates two
products with a
family. In this case,
Other Class1
differentiates
products within an
Other Family1.

Numerical/
Alphabetic, 50
characters maximum

Blank

Other Family1 A value which links
two products
together for the
purpose of
comparison through
rules. The Other
Family1 grouping of
products can be
based on any
characteristic of a
product.

Numerical/
Alphabetic, 50
characters maximum

Blank

Other Class2 A value which
differentiates two
products with a
family. In this case,
Other Class2
differentiates
products within an
Other Family2.

Numerical/
Alphabetic, 50
characters maximum

Blank
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Other Family2 A value which links
two products
together for the
purpose of
comparison through
rules. The Other
Family2 grouping of
products can be
based on any
characteristic of a
product.

Numerical/
Alphabetic, 50
characters maximum

Blank

Reviewing for Pre-Priced Products
A rule must be placed on pre-priced items to ensure that the price does not move
during the optimization.

Pre-priced products have a stamped price. Pricing regulations are placed on these
items to ensure that prices do not exceed the stamped price. As a result, a rule
must be placed on these items to ensure that the price does not move during the
optimization.

On the PIF, the Pre Priced column is populated with a 1 or a 0 (Pre-priced product
=1; Non-pre-priced product = 0. Most products are not pre-priced, but some
categories (such as salty snacks) have many pre-priced items.

If the field is blank, these are some ways to identify a product as being pre-priced:
v The letter combinations (PP, PPC) are found in the product description
v The product description has a price in the field
v Another supplied attribute has a designate for a pre-priced product
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Assigning Line Groups
A Line Price Group consists of “like” products that are priced equally, such as
different flavors or scents of the same product.

A Line Price Group consists of “like” products that are priced equally, such as
different flavors or scents of the same product. Line Groups are used by the Line
Group rule.

Line Group values are usually sent by the retailer, so you may not need to change
the Line Group column at all. If you make a change in the Line Group field in the
PIF, the new information will be sent to Everyday Price Optimization and
Everyday Price Management.

Assigning Size Family and Size Class
Size Family and Size Class ensures that Everyday Price Optimization and
Everyday Price Management will always recommend that larger sizes are a higher
price than smaller sizes, and larger equivalized sizes of the same product are less
than the smaller equivalized size.

About this task

Size Family and Size Class ensures that Everyday Price Optimization and
Everyday Price Management will always recommend that larger sizes are a higher
price than smaller sizes, and larger equivalized sizes of the same product are less
than the smaller equivalized size (for example, Twinlab Vitamin C 30 CT will have
an optimized price that is less than Twinlab Vitamin C 60 CT, but the 60 count will
be a better value per tablet). The larger size is a better value.

Size Family and Size Class can be modified from the Edit Content screen. For
more information, see “Editing Content in the Edit Content Page” on page 119.

Note: Size Family names should only be used within the same brand.

The following example shows how Size Family and Size Class are used:

In this example, the Size Family (Contadina Sauce) is what links the three products
together. The Size Class (Small, Medium, Large) differentiates each product within
the family. The allowable values for Size Class are:
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v XXX-SMALL
v XX-SMALL
v X-SMALL
v SMALL
v MEDIUM
v LARGE
v X-LARGE
v XX-LARGE
v XXX-LARGE

Note: A free product should not be seen as a larger size. For example, a 12 ounce
shampoo and a 15 ounce (12 + 3 free) shampoo are actually the same size.

To assign Size Family and Size Class:

Procedure
1. Sort the PIF by brand, and then by size.

Note: If the product descriptions are complete, you can sort by product
description first.

2. Look for natural groupings, and assign structures. Be aware of bonus products,
and double check product pricing.

Assigning Brand Family and Brand Class
The Brand Family name ties the products together, and the Brand Class
differentiates products within a brand.

About this task

The Brand Family and Brand Class values are used for Everyday Price
Optimization and Everyday Price Management. The Brand Family name ties the
products together, and the Brand Class differentiates products within a brand.

The following example shows how Brand Family and Brand Class are used:

To assign Brand Family and Brand Class:
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Procedure
1. Sort the PIF by size, and then by brand.
2. Look for natural groupings, and assign structures.

Assigning Other 1 & 2 Family and Other 1 & 2 Class
Other Family/Other Class is often used to create relationships to support pricing
strategies such as "good, better, best" or "lowest price".

Other Family and Other Class establish other relationships when Brand
Family/Class is already being leveraged. Other Family/Other Class is often used
to create relationships to support pricing strategies such as "good, better, best" or
"lowest price".

Other Family/Class can be used for various Price rule objectives where:
v Family ties products to be compared by size
v Class differentiates the products within the family

IBM Omni-Channel Merchandising provides you two sets of Other Family/Other
Class values, which is why you have Other Family 1/Other Class 1 and Other
Family 2 /Other Class 2.

Note: Always use the Other 1's together and the Other 2's together, or the rule will
not work during optimization.

The following examples illustrate how Other Family/Other Class values are used:

Example 1: Good-Better-Best Strategy (economy vs. premium), where the retailer
wanted the following:
v Straw brand = good
v Sticks brand = better
v Brick brand = best

Example 2: Lowest price strategy, where the retailer wanted one brand to be the
lowest price on the shelf, regardless of other brand strategies within the category:

Lowest brand = Super Saver
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Importing the PIF
Use this procedure to import the PIF.

About this task

Once all of the values in the PIF are completed, the PIF can be imported back into
OpenLink. These are some helpful tips to follow prior to the import:
v Save the PIF to a place that you will remember
v The PIF can be imported open or closed
v Delete any formulas (Paste Special > Values)
v Turn off any filters in the PIF file
v Delete any additional columns (moved columns are OK)
v Delete any additional spreadsheets in the Excel workbook

To import the PIF:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category to import, and select Import Data. The Import Data

dialog box displays.

3. Click Browse to locate the PIF.
4. Click Continue. An automated email will be sent to your email account (the

user who imported the PIF), the Alert Inbox in the top right of the application,
or to both if you have subscribed to receive an alert when the PIF has
completed importing. See “Alert inbox” on page 22 for more information about
subscribing to the alerts.
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Note: If you receive an immediate error after clicking Continue, check the
following:
v The PIF is the first spreadsheet in the Excel workbook
v The name of the PIF (Excel spreadsheet name) is not too long

5. Open the email to view the import status message. It will either indicate that
the PIF was imported successfully with no errors, or will list import errors.
v This is an example of a success message:

v These are some examples of error messages:
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v In all three cases, you can edit the PIF to fix the errors and re-import the PIF.

Conducting Final Checks
After the PIF has been attributed and imported back into OpenLink, you conduct
some final checks to ensure that the product information is clean for the modeling
process.
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After the PIF has been attributed and imported back into OpenLink, you conduct
some final checks to ensure that the product information is clean for the modeling
process.

The Model Health report presents metrics to show the status of the active models
used by the Everyday Price Optimization and Everyday Price Management, and
Promotion Planning & Optimization services for a given category. It can help you
to determine when to re-model or perform a model refresh based on user-defined
thresholds.

Related Topics

“Running Equivalent Units”
“Conducting Integrity Checks” on page 117
“Editing Content” on page 119
“Auto-Assigning Demand Groups to New Products” on page 133
“Viewing Model Health” on page 122

Running Equivalent Units
The Equivalent Unit check looks for products that are outside of the acceptable
limits for highly substitutable products.

Because Demand Groups are groups of highly substitutable products, the products
should be relatively close in price. For example, a $2.59 toothbrush and a $34.99
electric toothbrush should not be in the same Demand Group.

The Equivalent Unit check looks for products that are outside of the acceptable
limits for highly substitutable products. Products are considered out of bounds if
their sizes are greater than or less than 50% of the Median Demand Group size, or
an equivalent price is less than or greater than 5% of the price ratio.

Equivalent Units can be run from either the Category Manager page, or the
Category Workspace page.

Related Topics

“Running Equivalent Units from the Category Manager Page”
“Running Equivalent Units from the Category Workspace Page” on page 115

Running Equivalent Units from the Category Manager Page
Use this procedure to run Equivalent Units from the Category Manager page.

About this task

To run Equivalent Units from the Category Manager page:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.

The # with POS to be Equivalized column in the Detailed tab shows the
number of products with POS data for which Equivalent Units needs to be run
before the category can change to Completed in the attributing process. You can
also edit the page to display the # to be Equivalized column to display the
total number of products for which Equivalent Units needs to be run. This
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information may be useful for non-modeled categories.

2. Right-click on a category, and select Run Equiv Units. The Run Equivalent
Units Calculation dialog box displays.

3. Set Update Database to update the modeling database with the equivalent unit
values. This must be done before modeling can begin, and should be done for
refresh processes or subset optimizations.

4. Set Recalculate for all Products to calculate equivalent units for all products
within the category. This will update any existing equivalent units within the
category, and should only be done for an initial category optimization or a total
category re-model.

Note: The Recalculate for all Products option will delete modeling coefficients
for categories that are already modeled.

5. Click OK. The process will check that all unit prices and sizes of products are
within limits.

Note: The Update Database and Recalculate for all Products options should
both be set when getting ready to model. Otherwise, only the Update Database
option should be set.

Running Equivalent Units from the Category Workspace Page
Use this procedure to run Equivalent Units from the Category Workspace page.
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About this task

To run Equivalent Units from the Category Workspace page:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Category Workspace to open the Category

Workspace page.

3. Select a category in the Category panel, and then select one or more Demand
Groups in the Demand Group panel. All of the products in the selected
Demand Groups will display in the Assigned Product list in the middle of the
page. All products in the Default Demand Group will display in the
Unassigned Products panel.

4. Click the Validate button at the top of the page, and select Equivalent Units
Check. The Run Equivalent Units Calculation dialog box displays.

5. Set Update Database to update the modeling database with the equivalent unit
values. This must be done before modeling can begin, and should be done for
refresh processes or subset optimizations.

6. Set Recalculate for all Products to calculate equivalent units for all products
within the category. This will update any existing equivalent units within the
category, and should only be done for an initial category optimization or a total
category re-model.

Note: The Recalculate for all Products option will delete modeling coefficients
for categories that are already modeled.

7. Click OK. The process will check that all unit prices and sizes of products are
within limits. When the validation is running, the Validate button will display
as ‘Validation in Progress’, and all the panels will become read-only.
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8. Click the Refresh button. When the validation is complete, the fields with
errors will be highlighted for both the assigned and unassigned products. If
you hold the pointer over the field, an error tooltip will display that describes
the error. After modifying the field value, re-run the Equivalent Unit check.

Note: Because the columns in the Unassigned Products panel are not editable,
you must update the fields with errors in the Edit Content page. In this page,
filter by ‘Default Demand Group’ for the category to view the unassigned
products.

Note: The Update Database and Recalculate for all Products options should
both be set when getting ready to model. Otherwise, only the Update Database
option should be set.

Conducting Integrity Checks
You conduct integrity checks in the Category Breakdown page for the Demand
Group and the brand.

About this task

You conduct integrity checks in the Category Breakdown page for the Demand
Group and the brand. Fixes can be made in the Edit Content page for new
products or for few product changes, or in the PIF.

You can check for the following:
v Demand Groups with multiple units of measure
v Equiv errors (size and price) which are not accepted
v Many products in a Default Demand Group
v Products in a Default Demand Group with a scan history
v Brand name duplication due to spelling errors or data anomalies

To conduct an integrity check:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Category Breakdown. The Category

Breakdown page displays.

3. To check items related to the Demand Group, choose Category Breakdown -
Demand Groups in the Report drop-down menu. The Demand Group report
lists all Demand Groups for a model category.
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4. Aggregate Demand Groups. Review Demand Group structures to ensure that
anomalous Demand Group names do not exist. Also, Demand Groups that
were originally separated (for example, LOW_FAT_COOKIES and
NO_FAT_COOKIES) can be combined into a single Demand Group.

5. Check for multiple units of measure for the same Demand Group. If an error
exists, right-click on the row with the error, and select Edit Content to open
the Edit Content page.

6. Locate the products with different units of measure, and click in the UOM
column to change the unit of measure.

7. While you are in the Edit Content page, you can scroll to the right to check
for products in a Default Demand Group that have a scan history.

8. If unaccepted equiv errors exist, the number of products with these errors will
appear in the # of Products with Unaccepted Equiv Errors column in the
Category Breakdown page. To correct the errors, right-click on the Demand
Group, and select View Equiv Details to open the View Equiv Details page.

9. Look for products with the Has Error checkbox set, and scroll to the right to
see if the Price Error or Size Error checkbox is set. A price error exists if the
price is more than five times the median price in the Demand Group, or less
than one-fifth the median price in the Demand Group (the price is either
current retail or the base price from POS). A size error exists if the equiv unit
is more than 10 or less than .1 of the median Demand Group size.

10. To fix an equiv error, right-click on the row with the error, and select Change
UOM or Change Demand Group. The Change UOM or Change Demand
Group dialog box will appear.

11. Change either the unit of measure or the Demand Group, and click Continue
to save the changes.

12. To check items related to the Brand, choose Category Breakdown - Brands in
the Report drop-down menu. The Brands report lists all brands for a model
category.

13. Look for misspelled brands. In this report, you can click a brand name in the
Brand column to choose the correct name in the drop-down list.
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Editing Content
You can do a final edit of the product information.

You can do a final edit of the product information in either the Edit Content or
Category Workspace page. Most of the fields are editable. The Edit Content and
Category Workspace pages both display an online PIF. See “Editing Content in the
Category Workspace Page” on page 120 for more details about this page.

Note: Any changes made when editing content may change the number of
products with POS data to be equivalized. You should re-run the Equivalent Unit
check until all data is fixed and the # with POS to be Equivalized column in the
Detailed tab of the Category Manager page is zero. See “Running Equivalent
Units” on page 114 for more information.

Note: You must have the Enable Attributing permission set to access the Edit
Content and Category Workspace pages.

Related Topics

“Editing Content in the Category Workspace Page” on page 120
“Running Equivalent Units” on page 114
“Editing Content in the Edit Content Page”

Editing Content in the Edit Content Page
Use this procedure to edit content.

About this task

To edit content:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Edit Content to open the Edit Content

page.
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3. Choose the All Products report from the Report drop-down menu.
4. In an editable column, click in a field to change the value. Either a drop-down

menu or an editable field will display.

5. Click Save in the upper left corner to save your changes.

Editing Content in the Category Workspace Page
The Category Workspace page allows you to view products from different
categories, change attributes, and group products into Demand Groups in a single
location.

About this task

The Category Workspace page allows you to view products from different
categories, change attributes, and group products into Demand Groups in a single
location. You can easily move products to different categories and Demand Groups
using drag-and-drop functionality.

Note: The Enable Attributing permission is required for accessing the Category
Workspace page.

The Category Workspace has four main regions:
v Category panel - Shows the list of categories with the number of products in

each category, number of unassigned products, and the category’s status. Hover
over the error icon to see the number of validation errors, including size errors
and average scan price errors. Note that if the number of validation errors is
zero, validations may not have been run.

v Demand Group panel - Shows all the Demand Groups in the category with the
number of products in each Demand Group.

v Assigned Product list - Shows all the products in the selected Demand Group.
v Unassigned Product panel - Shows all the products in the selected category that

have not been assigned to a Demand Group
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.

To edit content:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Category Workspace to open the Category

Workspace page.
3. Select a category in the Category panel, and then select one or more Demand

Groups in the Demand Group panel. All of the products in the selected
Demand Groups will display in the Assigned Product list in the middle of the
page. All products in the Default Demand Group will display in the
Unassigned Products panel.

4. In an editable column in the Assigned Product list, click in a field to change
the value. Either a drop-down menu or an editable field will display.
Fields with validation errors, such as the Size column, will be highlighted. If
you hold the pointer over the field, an error tooltip will display that describes
the error. After modifying the field value, re-run the Equivalent Units Check
validation (see “Running Equivalent Units from the Category Workspace Page”
on page 115 for more information).

5. Click Save in the upper left side to save your changes.
Related Topics

“Running Equivalent Units from the Category Workspace Page” on page 115
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Viewing Model Health
The Model Health report allows you to understand how changes in sales history
and the assortment mix for categories impact previously executed models for those
categories.

The Model Health report (OpenLink > Model Health) allows you to understand
how changes in sales history and the assortment mix for categories impact
previously executed models for those categories. The report provides color
highlighting (traffic lighting) based on user-defined thresholds. The metrics
combined with the traffic lighting can help you determine when to re-model.

Individual metrics that have exceeded a given threshold and triggered a status
change are highlighted. Types of thresholds include the number of weeks since the
last model, the percentage of volume from new products, and the percentage of
new stores opened since the category was last modeled. The current values of
these metrics are displayed in the report.

The red, yellow, and green highlights indicate the following:
v Red - Model is in poor health - schedule a re-model this month
v Yellow - Model is in OK health - consider scheduling a re-model next month
v Green - (Default status of Health Status column when no threshold is exceeded)

Model is in good health - no need to re-model yet

See your system administrator to configure the traffic lighting thresholds. The
Model Health calculation is typically scheduled to run on a weekly basis, so the
metrics are updated every week. The frequency of this task is also set up by the
system administrator.

Related Topics

“Report Columns”

Report Columns
Use this reference to learn about the report columns in OpenLink.

This column... Has this meaning...

Health Status Red, Yellow, or Green depending on the
defined thresholds.

Indicates the overall health of the model.
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Category Name Category name

Division Division name

Annual Revenue Summation of revenue for the category for
the last year calculated from the most
recently loaded POS week back one year.

Ranks category importance.

# of New Products Products that started scanning since the
category was last modeled.

Measures assortment change related to new,
non-modeled products.

# of Active Products Products with active status (as specified by
the status import or PSR) and have scanned
at least once in the last year.

Indicates the size of the current assortment.

# of Weeks Since Model Number of weeks since the category was
last modeled.

Indicates the “age” of the underlying model.

% Volume from New Products Percentage of category volume represented
by new products that have entered the
category in the last 4 weeks of POS data.

Measures assortment change related to new,
non-modeled products.

% Revenue from New Products Percentage of category revenue that is
contributed by the new products in the POS
in the last 4 weeks of POS.

Measures assortment change related to new,
non-modeled products.

% Volume from Discontinued Products Percentage of category volume that is
represented by products that have been
discontinued since the category was last
modeled. This metric is intended to show
how much of the model depended on
products that have since been discontinued.
This metric uses the category volume for the
last 90 days of the last modeling period.

Measures assortment change related to
discontinued products.

% Revenue from Discontinued Products Percentage of category revenue from
discontinued products since the last model
date. This metric is intended to show how
much of the model depended on products
that have since been discontinued. This
metric uses the category revenue for the last
90 days of the last modeling period.

Measures assortment change related to
discontinued products.
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% New Stores Percentage of stores that have been opened
(new stores) since the category was last
modeled.

Measures non-modeled stores.

Health Report Last Run Date The last date that the category health metrics
were last calculated for the category.

The update is triggered by a scheduled task
in the Task Scheduler. It could be set up to
run after a POS data load depending on the
load time for POS data.

Indicates if metrics are up to date.

Creating Demand Group Relationships
A Demand Group relationship is provided for the statistician to help streamline the
modeling process.

A Demand Group relationship is provided for the statistician to help streamline the
modeling process. Cross terms between Demand Groups within a category are
noted in this matrix (either affinity, cannibalistic, or no relationship). An affinity is
a relationship in which a Demand Group is a complement to the other (for
example, Dry Hair Shampoo and Dry Hair Conditioner). A cannibalistic
relationship is one in which a Demand Group can substitute for the other (for
example, Normal Hair Shampoo and Oily Hair Shampoo).

The modeling process uses these cross terms to look for relationships between two
Demand Groups within a category. You can indicate the relationships either at the
product category level or the Demand Group level, according to your preference.

At the Demand Group level, you select a Demand Group at the top of the page
(the "driver" Demand Group), and all remaining Demand Groups are displayed in
the report (the "driven" Demand Groups). The cross term is assigned to the driven
Demand Group. The logic of the relationship is: the driver Demand Group
cannibalizes/prompts the purchase of the driven Demand Group.

At the product category level, you choose both Demand Groups on a single page.
You define their relationship, and define if the relationship reciprocates. This may
be the easiest method if you have only a few relationships to create.

As an alternative, Demand Group relationships can be exported, manipulated, and
then imported back into OpenLink. Editing a matrix in Excel may be easier if you
have a lot of Demand Groups and relationships to create.

Demand Group relationships are not automatically created so that you have the
ability to choose relationships based on actual sales activity. If data is left on its
own in the system, cross-terms might be discovered in the data, but they may not
be accurate. For example, the retailer often promotes both 17" and 19" monitors at
the same time. As a result, the volume of these two Demand Groups spikes at the
same time. The model might think that there is an affinity relationship between the
two Demand Groups, but the 19" sometimes cannibalizes the 17". So, it is better to
manually define Demand Group relationships in the application.
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Note: If modeling does not find a relationship between two Demand Groups, it
will not force one. Assigning Demand Group relationships simply tells the model
to search for this type of relationship.

Related Topics

“Assigning to Demand Groups”
“Assigning to Categories” on page 126
“Exporting Demand Group Relationships” on page 127
“Importing the Demand Group Relationship Matrix” on page 128

Assigning to Demand Groups
Use this procedure to assign Demand Group relationships at the Demand Group
level.

About this task

To assign Demand Group relationships at the Demand Group level:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Demand Group Relationships. The

Demand Group Relationships page shows all existing relationships for the
selected category.

3. Click View by DG to open the Demand Group Relationships by Demand
Group page.

4. Choose a driver Demand Group from the Demand Group drop-down list at
the top right-side of the page.

5. Click the coefficient in the Coefficient column, and choose No Relation,
Affinity, or Cannibalism from the drop-down list. This assigns a coefficient to
the driven Demand Group in the Driven DG column. The driver Demand
Group cannibalizes/prompts the purchase of the driven Demand Group.
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6. Set the Reciprocal checkbox if the relationship reciprocates (which will be true
in most cases). For example, laundry detergent is an affinity to fabric softener,
and fabric softener is an affinity to laundry detergent.
Non-reciprocal relationships only apply in one direction, for example, the
6-pack of AAA batteries cannibalizes the 2-pack of AAA batteries, but the
reverse is not true.

7. For each Demand Group, you can change the relationship in the Coefficient
column (No Relation, Affinity, or Cannibalism).

8. Click Save when you are done.

Assigning to Categories
Use this procedure to assign Demand Group relationships at the Category level.

About this task

To assign Demand Group relationships at the Category level:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Demand Group Relationships. The

Demand Group Relationships page shows all existing relationships for the
selected category.

3. Click New Relationship to open the Demand Group Relationships dialog box.

4. Choose driver and driven Demand Groups from the drop-down lists.
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5. Choose No Relation, Affinity, or Cannibalism from the Coefficient
drop-down list. This assigns a coefficient to the driven Demand Group. The
driver Demand Group cannibalizes/prompts the purchase of the driven
Demand Group.

6. Set the Reciprocal checkbox if the relationship reciprocates (which will be true
in most cases). For example, laundry detergent is an affinity to fabric softener,
and fabric softener is an affinity to laundry detergent.
Non-reciprocal relationships only apply in one direction, for example, the
6-pack of AAA batteries cannibalizes the 2-pack of AAA batteries, but the
reverse is not true.

7. Click Save when you are done. If the same relationship already exists, you will
see a message at the top of the Demand Group Relationships dialog box that
the new Demand Group relationship already exists. You can adjust the settings
in the dialog box and save the relationship again. Your new Demand Group
relationship will appear in the Demand Group Relationships page.

Exporting Demand Group Relationships
Use this procedure to export a Demand Group relationship.

About this task

A Demand Group relationship can be exported if many relationships are required
for modeling. You can modify the file for a given category, and then import the file
back into IBM OpenLink.

To export a Demand Group relationship:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Demand Group Relationships. The

Demand Group Relationships page displays.

3. In this page, click Export Relationships. The Demand Group relationship
matrix will result in an Excel .csv file in the following format. You can modify
the file by adding relationship coefficients with the appropriate reciprocal
setting (See “Modifying the Demand Group Relationship Matrix File” on page
128).

Note: OpenLink will export and import files in this format. You must
transform the .csv file into (and back from) a classic matrix layout if needed.
Contact your IBM representative if you need assistance.
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Related Topics

“Modifying the Demand Group Relationship Matrix File”

Modifying the Demand Group Relationship Matrix File
Use this procedure to modify the Demand Group relationship matrix file.

About this task

You can modify the Demand Group relationship matrix file, and add or change the
relationship coefficients and reciprocal settings. The Demand Groups in the matrix
must already exist in the correct categories.

To modify the Demand Group relationship matrix file:

Procedure
1. Create relationships between Demand Groups, and add Relation Coefficients.

The coefficient is assigned to the Related Demand Group. The driver Demand
Group cannibalizes/prompts the purchase of the related (driven) Demand
Group.
Valid relation coefficients are 1 and -1:
v 1 corresponds to an affinity/complementary relationship
v -1 corresponds to a cannibalization/substitute relationship

2. You can modify the Reciprocal setting as follows:
v Enter One Way if customers will purchase the Related Demand Group (such

as cough drops) when purchasing the Driver Demand Group (such as cough
medicine), but will not purchase cough medicine because they purchase
cough drops.

v Enter Two Way if the Driver and Related Demand Groups both have the
same influence on each other.

Importing the Demand Group Relationship Matrix
Use this procedure to import a Demand Group relationship matrix.

About this task

You can import the modified Demand Group relationship matrix file back into
OpenLink.

Note: Any changes in the current Demand Group relationship matrix in OpenLink
will be overridden by the import.

To import a Demand Group relationship matrix:
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Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Demand Group Relationships. The

Demand Group Relationships page displays.

3. In this page, click Import Relationships. The Import Demand Group
Relationships dialog box appears.

4. Click Browse to locate the Excel .csv file, and click Continue.

Marking Categories as Attributed
Use this procedure to mark categories as attributed.

About this task

Now that you are finished attributing, you can mark the categories as attributed.
This setting indicates that the products in the categories have passed all tests, are
cleansed, and are ready for modeling.

You can also later unmark a category as attributed. If any individual product
within the category should not be marked as attributed, you can clear its setting.
The # of Unattributed Products column in the Category Manager page will
update. You can also reference this column to see if new, unattributed products
have entered the category and are ready to be attributed. See “Locating New
Products” on page 131 for other ways to identify new, unattributed products.

To mark categories as attributed:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. In the Detailed tab, right-click on a category and select Mark Category As

Attributed. The Attributed column will show the current date, and the
Attributed By column will show your user name.
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3. If you want to later unmark the category as attributed, right-click on a category
in the Category Manager page, and select Unmark Category as Attributed.

To edit attributed products:
1. In the Category Manager page, right-click on a category, and select Edit

Content to open the Edit Content page. The Attributed checkbox is set for
each product in the category.

2. Clear the Attributed checkbox for the products that you do not want marked
as attributed. Any product that is not attributed is counted in the # of
Unattributed Products column in the Category Manager page.
Related Topics

“Locating New Products” on page 131
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Locating New Products
If new products have entered your categories and need attributing, there are
several report columns in IBM OpenLink and other applications that you can
reference to identify the new products.

If new products have entered your categories and need attributing, there are
several report columns in IBM OpenLink and other applications that you can
reference to identify the new products. Once you have located them as described
in this section, you can proceed with the attributing process as described in
“Attribute New Products” on page 145.

The following columns will be updated at the category level:
v The # of Unattributed Products value in the Category Manager page will be

increased.

v The # of New Products column will be updated in the Model Health report in
IBM OpenLink (see “Viewing Model Health” on page 122 for more information
about this report).

v If you are an IBM Price Optimization user, the # of New Products column will
be updated in the Category Activity report in the Manage Categories page.

To view the new products within the category, right click on a category in the
Category Manager page, and select Edit Content to open the Edit Content page.
The following columns in this page will identify the new, unattributed products in
the category:
v The Attributed checkbox will be cleared.

v The Included in Model checkbox will be cleared.
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v The Model Demand Group will be DEFAULT_DEMAND_GROUP.

Related Topics

“Viewing Model Health” on page 122

Notifying Modelers
After attributing, you can notify your Modelers that a category is ready for
modeling .

About this task

After attributing, you can notify your Modelers that a category is ready for
modeling for use in the Everyday Price Optimization and Everyday Price
Management, Promotion Planning & Optimization, or Markdown Optimization
applications by setting a category status in the Category Manager page. As the
Modelers complete their tasks, they can set statuses in the Modeling Categories
page. Once a status is set, an email notification is sent so that other users are
informed of the progress in the attributing and modeling process.

Note: You must subscribe to these alerts in the Alert Subscription page to receive
email notifications for each attributing or modeling action (choose Alert
Subscriptions from the Tools menu):
v Request Price/Promotion Model / Request Markdown Model - Users will

receive an email notification once an Attributer sets the Requested status to
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request the category to be modeled. A separate email notification will be sent to
users if a Modeler determines that a category is not ready to be modeled and
sets the Recalled status.

v Price/Promotion Model in Progress / Markdown Model in Progress - Users
will receive an email notification once a Modeler sets the In Progress status to
begin modeling the category.

v Release Price/Promotion Model / Release Markdown Model - Users will
receive an email notification once a Modeler sets the Released status to release a
model to production. A separate email notification will be sent to users if a
Modeler determines that a category is not ready to be modeled and sets the
Recalled status.

v Return Price/Promotion Model - Users will receive an email notification once a
Modeler sets the Returned status to return the category to the Attributers for
more attributing work.

To set an attributing category status:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. In either the Basic or Detailed tab, right-click on one or more categories, and

select Request Price/Promotion Model, or Request Markdown Model.
3. You can enter comments in the comment dialog box, and click OK. When the

dialog box closes, the Requested status and current date will display in the
Price/Promotion Model Status or Markdown Model Status column for each
category in the Category Manager. Also, an email notification with the
following information will be sent to all users that are subscribed to receive this
alert:
v Action - Price/Promotion Model Requested / Markdown Model Requested

v Category name and product category ID
v User ID (user name or email address)
v Date and time
v Any comments entered into the comment dialog box with the last status

change

Auto-Assigning Demand Groups to New Products
Before re-modeling a category, new products that have been added must be
assigned to Demand Groups.

About this task

Before re-modeling a category, new products that have been added must be
assigned to Demand Groups. You can schedule the Auto-Assign New Products
task in the Task Scheduler so that new products are automatically assigned to
existing Demand Groups based on their attributes. Any existing products in the
Default Demand Group that have not yet been assigned to Demand Groups will
also be automatically assigned. You can review the auto-assigned products and
approve the assignments, or manually re-assign different Demand Groups before
approving them. For more information about creating tasks, including the
Auto-Assign New Products task, see “Creating new tasks” on page 151.

The recommended workflow for preparing categories for a re-model is the
following:
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v Review the auto-assigned new products and change or approve their Demand
Group assignments.

v Run the Equivalent Unit check.
v Conduct integrity checks.
v Set the status that a category is ready for modeling (optional).

Note: You must have these permissions to conduct this process:
v Enable Auto-Assign New Products permission to review the auto-assigned

products.
v Enable Auto-Assign New Products Task permission to schedule the automated

task for assigning Demand Groups.

To review the Demand Groups assigned to new products:

Procedure
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category with unapproved auto-assigned products in the #

Unapproved Auto-Assigned Products column. The column will be highlighted
in yellow if the number of products is more than zero.

3. Select Review Auto-Assigned Products in the context menu.
In the All Products report that displays in the Edit Content page, the
unapproved and auto-assigned products are indicated by a checkmark in the
Auto-Assign Unapproved column. The date that the products were assigned to
Demand Groups is shown in the Auto-Assigned Date column.

4. Slide the scrollbar to the right to view the assigned Demand Groups in the
Model Demand Group column. Any new values are highlighted. You can also
click in this column to change the Demand Group selection in the drop-down
menu.
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5. Select one or more unapproved and auto-assigned products, and select
Approve in the right-click menu. The Auto-Assign Unapproved checkbox will
be cleared for each Demand Group assignment that you approve.

6. Click Save when you are done with your changes. When you return to the
Category Manager page, the # Unapproved Auto-Assigned Products column
will be updated.
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Chapter 7. Maintaining Your Category Hierarchy

OpenLink creates a Category Map to assign a category hierarchy structure to the
products from your product file.

IBM Omni-Channel Merchandising creates a Category Map to assign a category
hierarchy structure to the products from your product file. All subsequent loads of
product information into the application will use the Category Map. For efficient
processing, it is important to get the category hierarchy structure correct with the
initial product load.

You can change your category hierarchy structure and reconfigure it differently for
optimization purposes. For example, you can make adjustments such as breaking
large categories into smaller categories, combining categories, and moving your
products into new categories. After the changes, you conduct the product
attributing process to prepare the data for modeling.

Related Topics

“Importing the Category Map”
“Re-categorizing Products” on page 141
“Setting the Product Hierarchy Override” on page 147
“Managing Categories” on page 149

Importing the Category Map
The Category Map with your product hierarchy is usually already imported into
OpenLink at the beginning of implementation.

About this task

The Category Map with your product hierarchy is usually already imported into
OpenLink at the beginning of implementation. If not, you must first import your
category information in an Excel spreadsheet to populate the Category Mappings
page.

Note: If you are using the improved product hierarchy data schemas, you can use
the Product Hierarchy Mapping page instead. For more information, see “Product
Hierarchy Mappings” on page 139.

To import a Category Map:

Procedure
1. Choose OpenLink > Category Mappings to open the Category Mappings

page.
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2. Right-click on any row in the report and select Export Table to export the
report columns into an Excel spreadsheet. The Export dialog box displays.

3. Click Export. Click the refresh button in the upper right corner of the Export
Status dialog box until the file has finished exporting.

4. When the status for your file has changed to Finished, click the file name in the
Export Status dialog box to open the spreadsheet file.

5. Complete the fields in the spreadsheet, as described in the following table. The
columns must be in the correct order, or the import will fail.

In this column... Add this information...

Column A Level 1 hierarchy (typically a category name)

Column B Level 2 hierarchy (typically a classification)

Column C Level 3 hierarchy (typically a
sub-classification name)

Column D Category name. Optimization category that
you want to see in the Promotion, Price, or
Markdown service.

Column E Update existing products already in the
database with the map.

v 1 - Yes

v 0 or blank - No

6. Save your Excel file to a convenient location.
7. Close the Export Status dialog box, if it is still open.
8. In the Category Mappings page, click Import Mapping. The Import Product

Hierarchy to Category Mapping dialog box displays.
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9. Click Browse to locate your mapping Excel file, and click Submit. The
Category Mappings page will contain the information from your file (you may
need to refresh the page first). The Product Update Status column will display
the Waiting to update existing products status for those existing products that
you indicated that you wanted updated with the new map.

Note: If the mapping file contains errors, the Import Product Hierarchy to
Category Mapping dialog box will list each error and the row number. You
must correct these errors in the mapping file and re-import.
Related Topics

“Product Hierarchy Mappings”

Product Hierarchy Mappings
You can use the Product Hierarchy Mappings page to define categorical levels for
each product within your product hierarchy.

About this task

As an alternative to the Category Mappings page, you can use the Product
Hierarchy Mappings page to define categorical levels for each product within your
product hierarchy. The Product Hierarchy Mappings page allows you to include
up to ten sub-categorizations for each product. You can simplify the categorization
or re-categorization process by:
v Dynamically mapping sub-levels using an intuitive hierarchy tree
v Assigning products quickly, using simple filters to hierarchically organize all

products

You can also export and import Product Hierarchy mappings. For more
information, please see “Importing and Exporting Product Hierarchy Mappings”
on page 140.

Note: You must have the Use Product Hierarchy Tree permission set to access the
Product Hierarchy Mapping page.

To use the Product Hierarchy Mappings page:

Procedure
1. Choose OpenLink > Product Hierarchy Mapping. You will see a hierarchy tree

of all mapped products, as well as uncategorized products. As you select and
expand nodes, the Product Hierarchy tree will dynamically update, fetching the
requested data.
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2. In the Category column, click in the row for the item you wish to categorize.
3. If you want to find a specific portion of the product hierarchy to categorize, use

the search field. Once you enter all or portion of the node name you are
looking for, click Find to see the results.

4. To show the result in the Product Hierarchy to see how other similar products
are categorized, click Show in Hierarchy.

5. Enter the name in the field to filter the category list using search-ahead
functionality.
If a match is not found, the field will be highlighted in red when you click
away from the field. You can delete the name and try again, or create a new
category by clicking Add Category at the top of the page. After adding the new
category in the Add Category dialog box, click Create. The new category will
be available to choose from the category list.

6. Once you have added a new category or modified an existing category name,
the Update Existing Products checkbox will be set, indicating that the products
will be moved to the new category when you save your changes. If this
checkbox is cleared, the products will not be moved to the new category.

7. You can make any adjustments to the category names in a product's hierarchy,
as needed. The new or changed categories will be in bold.
One of the following icons will display in the Status column:
v

The category for this product has changed, and one or more of its children in
the hierarchy have changes.

v

The category for this product has changed, and its children in the hierarchy
have inherited the changes.

v

One or more children in the hierarchy have changes.
8. Click Save to commit your mapping changes for new or updated products, or

Revert to Last Save to revert to the previously saved changes.
Related Topics

“Importing and Exporting Product Hierarchy Mappings”

Importing and Exporting Product Hierarchy Mappings
Use this procedure to import and export existing Product Hierarchy mappings.

About this task

Rather than creating mappings in the Product Hierarchy Mapping screen, you can
export mappings to Excel and modify them manually. To export existing Product
Hierarchy mappings:
1. Navigate to Data > Export and select Product Hierarchy Node to Category

Mapping from the Report drop-down:
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2. Click Export.
3. Click the appropriate link on the Export Status screen to download the

mappings file.
4. Edit the file using Excel or the editor of your choice.

When you have finished editing the file, you can import it back into OpenLink:
1. Navigate to Data > Import and select Product Hierarchy Node to Category

Mapping from the Data Type drop-down
2. Click Browse and locate the edited file containing your Product Hierarchy

mappings.
3. Click Import.

For more information about properly formatting imports for Product Hierarchy
mapping, please contact your IBM representative.

Re-categorizing Products
Products may need to be re-categorized due to merchandise hierarchy changes
such as a "reclass" process, or if they were accidentally placed in the wrong
category.

About this task

Products may need to be re-categorized due to merchandise hierarchy changes
such as a "reclass" process, or if they were accidentally placed in the wrong
category. These steps must be completed to successfully move items in OpenLink
and ensure that they are ready for forecasting in IBM Omni-Channel
Merchandising services:

Procedure
1. Create a new optimization category, if you decide that it is needed for

particular products.
2. Move the item in the Edit Content page or Category Workspace page.
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3. Conduct the attributing process.
4. Conduct the modeling or model refresh process.
5. Decide to use the original product hierarchy or the IBM Omni-Channel

Merchandising product hierarchy going forward.
Related Topics

“Creating a New Optimization Category”
“Moving Individual Products to Categories” on page 143
“Moving Uncategorized Products to Categories” on page 144
“Attribute New Products” on page 145

Creating a New Optimization Category
Use this procedure to create a new optimization category.

About this task

You can create new optimization categories in OpenLink.

To create a new optimization category:

Procedure
1. Choose OpenLink > Category Mappings to open the Category Mappings page

.
2. Enter a new category name in the New Category field and click the New

Category button. The new category is available in the Category Name
drop-down menu in this page.

3. If you want to select the new category for an existing category hierarchy, click
next to the category name, and select the new category name in the drop-down
list.
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4. To move all products in the hierarchy structure to the new optimization
category, set the Update Existing Products checkbox.

5. Click Save in the upper left corner of the Category Mappings page. The
Product Update Status column will display the Waiting to update existing
products status. Refresh the page until the process has completed and the
message disappears.

Moving Individual Products to Categories
Use this procedure to move a product between categories.

About this task

You can easily move individual products to new categories in the Edit Content
page, or in the Category Workspace page.

To move a product between categories in the Edit Content page:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on the category with the product that you want to move, and select

Edit Content from the context menu. The Edit Content page displays.

3. Choose the All Products report from the Report drop-down menu.
4. For the product that you want to move, click in the Opt Category column to

select a new category from the drop-down list of categories. This will assign the
product to the new optimization category.
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5. Click Save in the upper left corner of the Edit Content page. The product is
moved into the destination category and into the Default Demand Group and
default model category for the new optimization category.

To move a product between categories in the Category Workspace page:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Category Workspace to open the Category

Workspace page.

3. Select a category in the Category panel, and then select one or more Demand
Groups in the Demand Group panel. All of the products in the Demand
Groups will display in the Assigned Product list in the middle of the page.

4. Select and drag each product from the Assigned Product list to a category in
the Category panel. When you see the product name projected over the
category that is underneath the bolded line, release the mouse button. The
product will be added to the destination category’s Default Demand Group.

Moving Uncategorized Products to Categories
If the application does not recognize a new product hierarchy from the product
file, the products are moved to the default optimization category, uncategorized.

Once all product data has been imported into OpenLink, any subsequent re-loads
of the product file will use the IBM Omni-Channel Merchandising categories and
not the original retailer product hierarchy. If the application does not recognize a
new product hierarchy from the product file, the products are moved to the default
optimization category, UNCATEGORIZED. You can assign them to a category in
either the Edit Content page or the Category Workspace page. See “Moving
Uncategorized Products to Categories” for more details.
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Attribute New Products
Use this procedure to attribute new products in the category.

About this task

Once products are approved into a new optimization category, they must be
assigned a Demand Group structure and equivalized in the new category structure.
You can attribute the products directly in the Edit Content page, or the Category
Workspace page.

This process ensures that the products entering the category are included in the
forecast. If the products are not assigned a Demand Group structure, they will be
excluded from the forecast, resulting in a disparity between predicted and actual
results. See Chapter 5, “Preparing to Attribute,” on page 83 for more information
about the attributing process. See “Equivalizing Size and UOM” on page 102 for
more information about equivalizing sizes and UOMs.

Note: You must have the Enable Attributing permission set to access the Edit
Content and Category Workspace pages.

To attribute new products in the category in the Edit Content page:
1. In the Category Manager page, right-click on the category with the product

that you want to attribute, and select Edit Content from the context menu.
New products in a category are typically not attributed, not modeled, and have
a Default Demand Group.

2. Click in the Model Demand Group column, and choose an existing Demand
Group from the drop-down list. This will automatically assign the appropriate
model category to the product.

3. Complete the remainder of the attributing process in this page to ensure that
the category is ready for modeling.

4. Click Save in the upper left corner of the Edit Content page.

Chapter 7. Maintaining Your Category Hierarchy 145



To attribute new products in the category in the Category Workspace page:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Category Workspace to open the Category

Workspace page.

3. Select a category in the Category panel. All of the unassigned products are
stored in the category's Default Demand Group and will display in the
Unassigned Product panel. New products in a category are typically not
attributed or modeled.

4. Select and drag each product from the Unassigned Product panel to a Demand
Group in the Demand Group panel. When you see the product name projected
over the Demand Group that is underneath the bolded line, release the mouse
button. The product will be added to the destination Demand Group.

With the Demand Group selected, you can also drag a product directly to the
Assigned Products list in the middle of the page. The product will be added to a
new row below the bolded line.

Related Topics

“Creating New Demand Groups”

Creating New Demand Groups
Use this procedure to create a new Demand Group.

About this task

New Demand Groups available to choose from can be created in the Demand
Group Manager page, or in the Category Workspace page.

Note: You must have the Enable Attributing permission set to access the Category
Workspace page.
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To create a new Demand Group in the Demand Group Manager page:
1. In the Category Manager page, right-click on the category for which you want

a new Demand Group, and select Demand Group Manager from the context
menu. The Demand Group Manager page displays.

2. Click New Demand Group. A new Demand Group named
New_DemandGroup is added to the Demand Group Manager. You can click
this name field to change the name, but it must be unique.

Note: The Demand Group name cannot have more than 50 characters.

3. Click Save in the upper left corner of the Demand Group Manager page. The
new Demand Group is now available throughout the application.

To create a new Demand Group in the Category Workspace page:
1. In the Category Workspace page, in the Demand Group panel, click New in

the top right corner.
2. Enter a unique Demand Group name in the New Demand Group dialog box,

and click Create.
3. When you click OK in the status message that appears, the new Demand

Group will be added to the end of the Demand Group list.

Setting the Product Hierarchy Override
Use this procedure to set the product hierarchy override.

About this task

When you make a change to a product hierarchy, it does not flow back into the
retailer system so that several product hierarchies can be managed for optimization
purposes. Because retailers send data to the system each week, it is important to
ensure that changes to the product hierarchy are not overwritten with subsequent
retailer data loads. You can clear the Use Map setting in either the Edit Content
page or Product Level Details page so that the imported Category Map will
always override any new retailer product file category mapping.
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Note: If the retailer product file has a major restructure, you may want to check
the Use Map setting so that the large-scale category changes are captured with the
next product file load.

To set the product hierarchy override in the Edit Content page:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on the changed category hierarchy, and select Edit Content from the

context menu. The Edit Content page displays.
3. In the All Products report, be sure that the Use Prod Map checkbox next to

each product is cleared. A blank in this checkbox ensures that the Category
Map will always override the retailer product file category mapping each time
it is imported. This is the default setting.

To set the product hierarchy override in the Product Level Details page:
1. Choose OpenLink > Category Mappings to open the Category Mappings

page.
2. Right-click on the changed category hierarchy, and select View Product Level

Details from the context menu. The Product Level Details page displays.
3. In the Product Map Details report, be sure that the Use Map checkbox next to

each product is cleared. A blank in this checkbox ensures that the Category
Map will always override the retailer product file category mapping each time
it is imported. This is the default setting.

Configuring PIF Attribute Columns
You can configure your PIF to include additional fields which are helpful for either
attributing purposes or Everyday Price Optimization and Everyday Price
Management rules.

About this task

You can configure your PIF to include additional fields which are helpful for either
attributing purposes or Everyday Price Optimization and Everyday Price
Management rules. Selecting these product attributes and determining their order
in the PIF is an administrative procedure that you only need to do once for all
users in your company.

These reference fields are helpful in attributing:
v Ref Level 1-12 code and description
v Ref Attribute 0-9

These product relationship fields are only needed for optimization rules in the
Price application:
v Line Group (also useful in Promotion Planning & Optimization)
v Pre-price
v Size Family
v Size Class
v Brand Family
v Brand Class
v Other Family 1
v Other Class 1
v Other Family 2
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v Other Class 2

Note: You must have the Enable Configure PIF Columns permission set to
configure the PIF columns.

To configure the PIF attribute columns:

Procedure
1. Choose OpenLink > Configure PIF Columns to open the Configure PIF

Columns page. The names of the columns as they will appear in the PIF are
listed, along with sample attribute values from a record in the product
database. The sample values can help you determine if the columns will be
useful for the attributing process.

2. Set the attribute columns in the Include column that you want included in the
PIF export. By default, the following columns will be set, which you can clear:
v Size Class
v Size Family
v Brand Class
v Brand Family
v Line Group
v Is Pre Priced
v Level1Descr
v Level2Descr
v Level3Descr
v Level4Descr
v Level5Descr
v Level6Descr

3. You can click in the Order column to change the column order. These attributes
will all appear in a block to the right of the other attribute columns in the
exported PIF.

Managing Categories
Use this procedure to rename categories.

About this task

After re-organizing your category hierarchy, or moving all products in one
category to another, some categories may become obsolete. You can easily delete
these categories in the Category Manager page to reduce clutter.

You may have adopted new naming conventions for your categories, or may have
given a category an incorrect name. You can also rename categories within the
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Category Manager. You cannot, however, rename those categories that are
considered reserved, such as the default UNCATEGORIZED category.

Note: You must have the Enable Category Delete permission set to delete product
categories, and have the Enable Category Rename permission set to rename
product categories.

To rename categories:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Rename from the context menu.

Note: A confirmation message will display if there are any unfinished
modeling jobs for the category. Renaming the category could cause the
modeling jobs to fail. Click Yes if you want to proceed with the renaming.

3. In the dialog box that appears, enter a unique category name and click Save.
The category name will be changed in the Category Manager.

To delete categories:
1. Choose OpenLink > Category Manager to open the Category Manager page.
2. Right-click on a category, and select Delete from the context menu. A category

with the following conditions can be deleted:
v No product is in, or currently moving into the category
v No scenario, CPI, Category Group, Rule Group, or product group is in the

category
v No promotion, calendar, or package is in the category
v No markdown plan is in the category

3. If all the criteria are met, a confirmation message will appear. Click Yes to
proceed with the deletion.

Note: Any mappings with a deleted category will be removed from the Category
Mappings page. See “Importing the Category Map” on page 137 for more
information about this page.

Related Topics

“Importing the Category Map” on page 137
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Chapter 8. Task scheduler

The Task Scheduler is used to manage automated tasks in the IBM Omni-Channel
Merchandising services.

A task is a IBM Omni-Channel Merchandising procedure or workflow with
well-defined inputs, outputs, and dependencies. Examples of tasks are modeling
jobs, imports, exports, Product Status Resolver activity, and automated Price
Updates. Tasks can be scheduled with start times and dates, as well as frequencies.
You can also view a history of task executions.

Related Topics

“Creating new tasks”
“Editing tasks” on page 157
“Deleting tasks” on page 157
“Viewing task execution history” on page 158

Creating new tasks
Use this procedure to create new tasks. New tasks can be created and scheduled in
the Task Scheduler page.

Procedure
1. Choose Admin > Settings > Task Scheduler to open the Task Scheduler page.

The page lists all tasks by task type, task definition and description, the latest
start date, the latest run status (Scheduled, Started, Running, Finished, Error),
the next start date, the task status (Active, Inactive, Completed), and the user
who started the task.

Note: If the Task Scheduler service is not available, you will see an error
message and will be unable to create tasks. Contact your IBM Omni-Channel
Merchandising Representative for assistance.

2. Click New Task to open the New Task dialog box.
3. To define a task, select one of the following Task Types and Task Definitions,

and then input the relevant Task Details:

Task Type... With this Task Definition With these Task Details

Import Staging Import - Import data using the IVA framework.

Rapids - Import bulk data using the Rapids framework.

Description - A description of the task used as an identifier.

Data Type - (Applicable to Staging Import and Rapids) The type
of data to be imported.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Post Import Action/Simple Action - Describes the action after
the data is imported:

Approve - Brings the imported data into the database.

Validate - Stops after the import process after data validation.
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Task Type... With this Task Definition With these Task Details

Export Promotion Forecast Export - Exports the forecasts for unit
volume at the store, product, week level.

MC Performance Detail Export - Exports the performance
details from the Master Calendar.

Enhanced MC Performance Detail Export - Exports the
performance details that belong to promotions on the Public
Calendar.

Enhanced Event Details Export - Exports the events and
associated details that belong to promotions on the Public
Calendar.

Event Details Export - Exports the events and associated details
that include stores and LGCs.

Promotion TPM Export - Exports promotion details for
integration with SAP TPM.

Markdown Price Export - Exports recommended prices to stores
when a scenario has been approved for implementation.

Campaign Details Export - Not currently in use.

Package Details Export - Exports the packages and associated
details that include package header information, location groups,
product groups, and product group details.

Display Planning Export - Exports all Display Plan information
from the Display Planning feature.

Custom Export - Exports customized data types, such as
Product to Product and Line to Line relationships. This is
primarily used by IBM Omni-Channel Merchandising Technical
Services.

Price Scenario Export - Exports details of a Price Update. This
export includes all fields from the All Prices report.

Assortment Export - Exports Planogram-Cluster Product data, a
configurable set of product attributes and metrics, Date
Approved, and Cluster Details (Stores). Also includes an
optional Cluster-Store file that lists the mappings of stores to
clusters. Exports all scenarios that have been marked for
approval.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Export Task Definition - Customized export task definitions.

Incremental export or full export - Incremental exports will
export only elements that have changed since the last export.
Full export will export all elements.

Aggregate at geography level or national level - Level at which
forecasts are exported.

Export File Directory - Directory where the exported file is
stored.

Export File Compression Threshold - Threshold for
compression specified in bytes. Exported files that are bigger
than the threshold are compressed and stored in the export
directory.

Markdown Only:

Export Recommendation Period - Exports recommended prices
from either the current week or the current to last week.

Price Recommendation - Exports all price recommendations or
only the price recommendations which changed from the
previously exported prices.

Export Markdown Price Threshold - A threshold value for
exporting new recommended prices compared to the previously
exported recommended prices. For example, a value of 0.10
means that the difference between the previous and current
recommendations should be at least 10 cents.

Exclude Already Exported Recommendation - If set to Yes,
excludes any recommended prices that have already been
exported. If set to No, any recommended prices that have
already been exported will be re-exported.

Price Delivery Base Price Delivery - Base prices for stores and products at the
division level.

Base Price Delivery (zone level) - Base prices at the zone level.

Express Pricing - Exports express prices directly to stores
outside of the regular scenario process.

Express Pricing (zone level) - Reads from zone-level export
tables to produce an express price export file

Transfer Price - Produces an export file containing transfer
prices

Base and Transfer Price - Produces an export file containing
base prices and transfer prices

Custom Delivery - Used internally.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Division - The division for the process.
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Task Type... With this Task Definition With these Task Details

Scenario and
Data
Maintenance

Price Scenario Delete - Deletes unused and outdated scenarios
in Everyday Price Optimization and Everyday Price
Management.

Competitor Data Delete - Clears out old competitor data from
the database that is older than a specified number of days.

Scenario Archive - Archives scenarios that are older than a
specified number of days to improve system performance (180
days is recommended). The following types of scenarios are not
included in the archive:

v Production scenarios

v The last scenario run for a category-division

v Scenarios marked as “Keep”

v Permanently deletes scenarios that are in Pending Delete
status (Scenario Purge)

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Category - The category for the process.

Division - The division for the process.

Competitor - The specific competitor(s) for the competitor data
soft delete.

Older Than (# of days) - The number of days (taken from the
scenario run date) after which the data will be deleted.

Price
Maintenance

Price Update - Runs a process that looks for data changes and
then executes a Price Update. These are the primary types of
data changes that can trigger a Price Update:

v New vendor costs

v New competitive information

v New Compliance

v New products

v New VAT rates

v Zone structure

Recalculate - Recalculates scenarios for which IBM
Omni-Channel Merchandising has auto-imported price override
data. These scenarios have a status of Recalculate! Optimized
prices have been changed and belong to the category and
division selected for the task.

Rules Price - Schedules the rules pricing process for Rules Based
Pricing scenarios, detecting changes and automatically running
rules pricing.

Price Approval - marks all scenarios as Approved for Export if
they have not been exported, and are visible on the Production
Price Approval screen. To be notified when products are
automatically approved, subscribe to the Automated Price
Approval Task Status alert.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Category - The category for the process. Categories can be
multi-selected using Ctrl-click, or Shift-click to select multiple
adjacent categories.

Division - The division for the process.

Data Type (Optional) - The data files that must be loaded via
IBM Omni-Channel Merchandising OpenLink before a Price
Update is run. If a data file for a category/division fails to load,
an email notification is sent. The process will run for the
category/divisions with successfully loaded data.

Product Status
Calculation

Product Status Resolver - Runs the PSR process to impute the
status at the store-product level based on the sales history.

Product Statistics Summary- Runs a process to calculate various
Summary Statistics from the sales data.

Opt Product Statistics - Runs a process to calculate the average
price and cost at the product level, and the active products with
modeling coefficients at the store level. This should be run prior
to linking stores.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Category - The category for the process. Categories can be
multi-selected using Ctrl-click, or Shift-click to select multiple
adjacent categories.

Workflow OpenLink Workflows - Workflows to automatically load the
data, such as product, cost, and location, in the correct
sequences.

OpenLink Auto Data Load - Allows inbound data to be loaded
automatically soon after the data files arrive at a pre-configured
frequency. This workflow eliminates the need to schedule data
load processes or other workflows based on the time when data
files are expected to arrive.

Note: You must have the Enable OpenLink Auto Data Loading
permission to enable this task.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Workflow - The workflow for the process.

Poll Interval (in minutes) - The frequency at which the
workflow will search the file system for new data files. It is
recommended that the poll interval be set at 10 minutes or
greater.

Poll Duration (in hours) - The length of time that the workflow
will poll for new data files. This parameter is used to confine all
data loads to a fixed time frame.
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Task Type... With this Task Definition With these Task Details

Modeling Modeling Task - Runs a modeling job. Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Product Category - The category for the process.

Base Modeling Job - Modeling job associated with the product
category. Every recurrence will be a copy of the base modeling
job.

Optimization Markdown Re-optimization - Runs a Markdown
re-optimization.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Category - The category for the process.

Division - The division for the process.
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Task Type... With this Task Definition With these Task Details

Others Notification Summary - Accumulates email messages and sends
them to users in batch either daily or weekly.

Event Time Based Locking - Runs a process that locks events
that have exceeded their lock thresholds.

Model Health Calculation - Runs a model health calculation for
all categories. This updates the Model Health report.

TLog MBI Calculation - Runs a calculation for the market
basket metrics. This updates the MBI metrics in the Market
Basket Insights report in the home page and in the Promotion
Optimization product picker. It uses transaction log data that
has been pre-processed and validated by IBM Omni-Channel
Merchandising OpenLink. This task should be configured to run
once a week.

CompPrice Rollover - Loads competitive prices from
Competitive Price History datastore into zone-level competitive
price entries.

Auto-Assign New Products - Runs a process for assigning
existing Demand Groups to new products in IBM Omni-Channel
Merchandising OpenLink. You can run it for all categories
(default), or for one or more selected categories in the Category
drop-down menu.

Margin Based Cost Calculation - Runs a process for calculating
costs from user-defined cost margins for products.

Markdown Plan Scenario Purge - Permanently deletes
Markdown plans and scenarios that have been soft-deleted in
Markdown Optimization.

Expand Store Distribution - Copies modeling coefficients for
new products from existing stores to new stores so that they can
receive forecasts across the full set of stores in the Promotion
Optimization application. New products have no history in the
new stores for estimating the modeling coefficients used for the
forecasts.

Note: You must have the Enable Copy Coefficients Across Stores
Task permission to enable this task.

Expand Store Distribution for CP - Copies modeling
coefficients for new products from existing locations to new
locations so that they can receive forecasts in the Promotion
Optimization application.

Note: You must have the Enable Copy Coefficients Across
Stores Task permission to enable this task.

Collision Detection - Used to run collision detection checks on
a regular basis, validating that there are no collisions between
items on the Team and Public Calendars.

Data Import Monitor - Checks recent data imports to be sure
that they fall within expected ranges for size and load time. It
also checks for abnormal data loads and missing files, sending
an alert as appropriate if there are errors.

Display Plan Validation - Checks to make sure that Display
Plan characteristics do not collide, providing alerts as
appropriate if there are errors.

Event Validation - Detects whether collisions occur between
events created in Event Planning, providing alerts as appropriate
if there are errors.

Marketing Calendar Aggregation - Pre-aggregates forecast and
actual data for events created in Event Planning, making those
calculations available during future planning.

Description - A description of the task used as an identifier.

Active/Inactive - (Common for all tasks) The schedule for the
task is active if this checkbox is set. If it is cleared, the Task
Scheduler will not execute the task.

Category - (Applicable to Auto-Assign DGs) The categories for
which Demand Groups will be assigned to their new products.

Markdown Only:

Date Type - If Plan Start Date is chosen, all plans with a Plan
Start Date earlier than the specified Cutoff Date value will be
deleted. If Plan End Date is chosen, all plans with a Plan End
Date earlier than the specified Cutoff Date value will be deleted.

Cutoff Date - The cut off date (in MM/DD/YYYY format) for
deleting the plans. All plans with either a Plan Start Date or
Plan End Date earlier than this date will be deleted.
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Task Type... With this Task Definition With these Task Details

Promotion Data
Maintenance

Promotion Purge - Permanently deletes promotions that have
been soft-deleted in Promotion Management and Optimization.

Auto Predict Promotions - You can choose to automatically
predict promotions by date range, calculation status, workflow
status, and category. You can specify the schedule on which you
would like the auto-prediction to run. You can also re-predicts
promotions to apply updates such as re-modeling of categories
or re-calibration of models. This task will re-predict promotions
that satisfy certain conditions.

In the Task Scheduler, enable promotions that are on the Public
Calendar to qualify for auto-prediction using the following
conditions:

v Select promotions to auto-predict by workflow status. You can
select any combination of the following statuses:

– Draft

– On Public Calendar

– On Team Calendar

– On Team and Public Calendar

v Define a time window for the dates of promotions that will be
auto-predicted. For example, you can specify an
auto-prediction of all promotions set to begin between six and
eight weeks from today's date. This would prevent
auto-prediction for promotions set to begin within the next six
weeks.

v Set the end date and time to end an auto-prediction.

The Promotion Task Scheduler options are controlled through
the system settings. Contact your IBM representative for more
information about the system settings.

UEF Allocation Purge - Permanently deletes UEF allocations
that have been soft-deleted in Promotion Management and
Optimization.

Location Group Class Purge - Permanently deletes Location
Group Classes that have been soft-deleted in Promotion
Management and Optimization.

Promoted Price Conflict Report - Runs the Promoted Price
Conflict Report.

Update Product Count - Updates product count to reflect the
most current count.

Promotion PosDaily Purge - Permanently deletes Daily POS
data that has been soft-deleted in Promotion Management and
Optimization.

Promotion Product Category Purge - Permanently deletes
Product Categories that have been soft-deleted in Promotion
Management and Optimization.

4. You can schedule a task to occur once at a specified time, time zone, and on a
specified date, or you can create a recurring schedule by specifying the
frequency of recurrence, the time of the recurrences, and the range of
recurrences.
These are the Range of Recurrence options:
v No end - The task will recur forever (default).
v End after - The task will complete and will no longer be active after the

specified number of occurrences.
v End by - The task will complete and will no longer be active after the

specified date. The end by date should not be earlier than the start date.
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A recurrence has the following restrictions to prevent unused tasks from
slowing system performance:
v The recurrence of a custom task cannot be greater than 59 minutes.
v The recurrence of an hourly task cannot be greater than 23 hours.
v The recurrence of a daily task cannot be greater than 6 days.
v The recurrence of a monthly task cannot be greater than 11 months.
Note that there is no recurrence limitation for Weekly and Yearly tasks.

Note: A weekly task will only execute on one day per week, for example,
every Monday. If you must schedule a weekly task to run on more than one
day of the week, a task for each day must be created.

5. Click Save when you are done entering the task details. The new task will
appear in the Task Scheduler page.
Related Topics

“Editing tasks”

Editing tasks
Use this procedure to edit tasks.

About this task

An existing task can be edited if the task status is Active. You edit a task in the
Task Scheduler page.

Procedure
1. Choose Admin > Settings > Task Scheduler to open the Task Scheduler page.

Note: If the Task Scheduler service is not available, you will see an error
message and will be unable to edit tasks. Contact your IBM Omni-Channel
Merchandising Representative for assistance.

2. Select a task, right-click, and select Details to open the Edit Task dialog box.
3. You can edit your selections for the Task Type and Task Definition. You

cannot change the start date of a schedule for a task if the task was executed
one or more times. The number of occurrences cannot be less than or equal to
the number of times that the task has already executed on the schedule.

4. Click Save when you are done with your edits. The edited task will appear in
the Task Scheduler page.

Deleting tasks
Use this procedure to delete tasks.

About this task

An existing task can be deleted if it is scheduled to start or it has already started.
The task will be removed from the Task Scheduler page.

Procedure
1. Choose Admin > Settings > Task Scheduler to open the Task Scheduler page.
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Note: If the Task Scheduler service is not available, you will see an error
message and will be unable to delete tasks. Contact your IBM Omni-Channel
Merchandising Representative for assistance.

2. Select a task.
3. Select Delete.
4. Click Yes in the confirmation message that appears. The deleted task is

removed from the Task Scheduler page.

Viewing task execution history
Use this procedure to view a task execution history.

About this task

You can view a history of the task executions, including the start time, job status,
and the user who started the task.

Procedure
1. Choose Admin > Settings > Task Scheduler to open the Task Scheduler page.
2. Select a task.
3. Select Execution History to open the Task Execution History dialog box. The

summary at the top shows the task type, description, task definition, and
frequency of the task. All the executions of the task are listed, including the
start time, run status, and the user who started the task.
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Chapter 9. Getting help and support

IBM Omni-Channel Merchandising is designed to be user-friendly, but every once
in awhile you might have a question on a feature. IBM Omni-Channel
Merchandising offers multiple help and support solutions which are designed to
assist you in finding the answers you need quickly.

Related Topics

“Release notes”
“Online help”
“Printable user guide” on page 160
“Contacting IBM Omni-Channel Merchandising customer support” on page 161
“Logging a support case” on page 162
“Disabling pop-up blockers in Internet Exporer” on page 166
“IBM Omni-Channel Merchandising education and Training” on page 168
“Documentation questions and comments” on page 168

Release notes
In order to support quarterly upgrades to IBM Omni-Channel Merchandising
customers, Release Notes are posted directly in the application under the Help
menu. Each Release Notes document contains the following information:
v Release Overview - The general overview and focus of the current IBM

Omni-Channel Merchandising application release.
v New Features - Summary descriptions of the new release features.
v Fixed Bugs - IBM Omni-Channel Merchandising strives to close all customer

bugs as soon as possible. Fixed bugs are documented in the Release Notes.
v Known Issues - Descriptions of known issues with the current release and any

workaround instructions. Known issues will be fixed in subsequent releases.

Online help
Every IBM Omni-Channel Merchandising software service offers a help function.
This help function is designed to automatically present information that is
pertinent to the screen you are currently viewing.

Related Topics

“Accessing online help”
“Navigating help” on page 160

Accessing online help
Use this procedure to access online help.
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About this task

The Online Help will open in another window. If you have a pop-up blocker on
your computer you will need to disable it before using the Online Help. See
“Disabling pop-up blockers in Internet Exporer” on page 166 for more information.

Procedure
1. Access Online Help by clicking on the question mark icon in the upper right

corner of the page.
2. In the drop-down menu, click on Online Help to open the Online Help.

Navigating help
The Online Help system is designed to mimic the layout of a printed book. You
can navigate from one section to another by clicking on the book icons on the left
panel. Clicking on a book chapter opens it to reveal topic pages. Click on a topic
page to bring up the details in the right panel.

Above the book pages are four main navigation buttons: Contents, Index, Search
and Favorites.
v Contents - This button will show all of the available Online Help topics in book

form. This is the default view when you first open Online Help.
v Index - This button lists all of the available Online Help topics in alphabetical

order.
v Search - This button allows you to search for a specific term in the Online Help.

Enter the search term in the box and click Go! to display the results.
v Favorites - This button allows you to save a short list of specific topics to a

personal quick reference list. You can access your saved favorites at any time by
clicking on the Favorites button.

Printable user guide
Each of the IBM Omni-Channel Merchandising software services has a complete
user guide which is accessible as an Adobe Acrobat PDF file. The PDF file can be
viewed electronically or printed out and read as a traditional paper manual.

To access the PDF file, look for the Adobe Acrobat icon in the upper-right corner of
the Online Help screen. Click on the Adobe Acrobat icon to load the PDF.
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In order to properly view the PDF, you will need to have the latest version of
Adobe Acrobat Reader installed on your system. You can download Adobe Acrobat
Reader from Adobe's website at:

http://get.adobe.com/reader/.

Contacting IBM Omni-Channel Merchandising customer support
Personalized assistance is available directly from IBM Omni-Channel
Merchandising Customer Support for any issues you may encounter.

The IBM Omni-Channel Merchandising Customer Support team can be reached via
phone, email or the web.

When contacting support you should have the following information available:
v Your name
v Your company
v Your phone number
v Detailed description of your issue
v Priority level of issue

Related Topics

“Phone support”
“Web support”

Phone support
IBM Omni-Channel Merchandising Customer Support is available via phone at
+1-866-460-0501.

This is a toll free number for US-based customers. If you are calling from overseas,
please be aware that your phone company may assess charges for the call.

Phone hours
IBM Omni-Channel Merchandising offers three Customer Support teams in order
to ensure maximum availability.
v The USA-based support team is available Monday through Friday from 6am to

6pm PST.
v The Europe-based support team is available Monday through Friday from 8am

to 5pm CET.
v The Japan-based support team is available Monday through Friday from 8am to

5pm JST.

IBM Omni-Channel Merchandising observes Daylight Savings Time. If your
location does not observe Daylight Savings Time, please adjust the times
appropriately.

Web support
IBM Omni-Channel Merchandising Customer Support can be reached from the
IBM Omni-Channel Merchandising login page at www.mydt.demandtec.com.
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In order to connect to the Customer Support portal where you can begin logging
cases, you will need to first log in using a free web support account.

If you already have a web support account, you will need to request a new
password by entering your username and then clicking the Forgot your password?
link. A temporary password with log in instructions will be sent to your email
address. If you do not yet have an account, register on the Customer Support web
portal to gain access.

Related Topics

“Logging a support case”
“Reviewing a submitted case” on page 165
“Using the customer support portal” on page 165

Logging a support case
Logging a support case with your feedback, problem, or question is a simple
process. You will also receive email notifications when new information about
resolving your issue is available.

About this task

Procedure
1. Once you have logged in successfully, you will see the IBM Omni-Channel

Merchandising Customer Support portal.
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2. To enter a support case, click the Create New drop-down list, and select Case.

3. Enter the information in the New Case page. The required fields have a red
vertical bar next to the fields.
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v Contact Name - Enter your full name (required)
v Status - (Required by default, but read-only)
v Priority - Choose a priority level for the issue:

– P1 Critical - You cannot use the application, or the implementation
schedule will be severely impacted by a lack of system stability

– P2 Urgent - Your ability to perform common business functions is
hampered

– P3 Important - Minor features are not functioning as expected
– P4 Necessary - You have general inquiries and/or feature requests
– P5 Modeling Request - You have a modeling request

v Product - Choose the IBM Omni-Channel Merchandising application you
were using when the issue was found (required)

v Found in version - Choose the version of the IBM Omni-Channel
Merchandising application

v Sub Product 1 - Choose the related area of the IBM Omni-Channel
Merchandising application

v Sub Product 2 - Choose the related area of the IBM Omni-Channel
Merchandising application (if available)

v Subject - Enter a meaningful title for your issue (required)
v Description - Enter a detailed description of your issue (required). Include a

list of all the steps required to replicate the issue. This will help Customer
Support diagnose the problem and respond to you in a timely manner.

4. Click Submit. You will see a confirmation that your request was received with
a ticket number. Your case will be stored in your customer portal, which you
can later review, make changes, and then re-submit. See “Reviewing a
submitted case” on page 165 for detailed information.

5. Alternatively, click Submit & Add Attachment to include an attachment to
help illustrate the issue, such as a screen capture, and submit. The size of the
attachment can be up to 5 MB.
Related Topics

“Reviewing a submitted case” on page 165
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Reviewing a submitted case
You can open and review your cases that you previously submitted to Customer
Support. You can also edit cases and re-submit them, or close cases that no longer
need attention.

Procedure
1. Log in to the IBM Omni-Channel Merchandising Support Center web site.
2. Click the Cases tab. A summary of your recently viewed cases displays in the

center of the customer portal.
In the View drop-down list, you can choose to view all of your cases, only
your open cases, or your recently viewed cases (the default).

3. Click the case number to open the case. You can click the Edit button in the
Case Detail section to edit details of your issue and re-submit. You can also
enter new comments, add additional attachments, view suggested solutions,
and review the current progress of the support case.

4. Click the Close Case button to close the case if it is no longer valid, or does not
require feedback from Customer Support. You cannot delete cases from the
portal.

Using the customer support portal
The IBM Omni-Channel Merchandising Customer Support portal provides a
central location for all your support needs. The tabs at the top of the page let you
easily access different types of information.

Tabs

v Home tab - The main page of your customer portal. You can click the My
Profile link to edit or update your user profile information.

v Cases tab - The page to create, edit, and view cases.
v Solutions tab - Search and view solutions to common issues. You can choose to

view all solutions, most commonly viewed, or only those which you have
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recently viewed. You can also search cases by the first letter in the case title.
Solutions can be searched directly from the Find Solutions search field at the
bottom of the Home tab.

v Documents tab - Search and view supplemental documents to help with using
the IBM Omni-Channel Merchandising applications or learning more about how
Customer Support processes and manages cases.

Search

The Search area is available in the sidebar of all tabs within the portal. You can
search for your cases using a keyword that you enter, or an exact phrase in
advanced search.

Advanced search searches additional fields in cases, including notes, descriptions,
and comments. It allows you to do the following:
v Use operators, such as AND, OR, and AND NOT to refine your search.
v Add quotation marks around multiple keywords to perform an exact phrase

match, such as "receive error when enter values in the Edit field".
v Add an asterisk to the end of your keyword to search for items that start with

the word, such as receive*.

Create New Case

The create new case drop-down list is available in the sidebar of all tabs within the
portal.

Recent Items

You can open your recently viewed items, such as cases, documents, or case
solutions.

Disabling pop-up blockers in Internet Exporer
Use this procedure to allow pop-ups for a website.

About this task

If you are using software that disables pop-up browser windows, you may need to
disable this feature in order to successfully use IBM Omni-Channel Merchandising.
IBM Omni-Channel Merchandising uses pop-up windows in various places
throughout the application, such as when you export files to Microsoft Excel.

To allow pop-ups for a particular website like IBM Omni-Channel Merchandising
you need to add that site to an approved sites list.

Procedure
1. Open Internet Explorer 7.
2. Choose Tools > Internet Options from the menu bar. The Internet Options

dialog box displays.
3. Click the Privacy tab.
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4. You can see the Pop-up Blocker settings at the bottom of the window. If you
want to completely disable the Internet Explorer 7 Pop-up Blocker ensure that
the box next to Turn on Pop-up Blocker is unchecked. If you want to keep the
Pop-up Blocker enabled, but add IBM Omni-Channel Merchandising to an
approved white list, click the Settings button. A white list is a list of approved
sites which are ignored by the Pop-up Blocker and allowed to function without
interference. You may be familiar with the concept of a white list from your
email program which allows you to add selected email addresses to a white list
so those addresses can then bypass the spam filter. This works in a similar
manner.

5. In the Pop-up Blocker Settings dialog box type the name of the site (Ex:
mydt.demandtec.com for IBM Omni-Channel Merchandising and click the Add
button.

Note: These instructions are for Internet Explorer 7. If you are using third party
pop-up blockers, such as software from Google, MSN or Yahoo!, the
instructions may differ.
Related Topics

“Single use disable for pop-up blockers” on page 168
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Single use disable for pop-up blockers
If you do not want to disable the pop-up blocker on your system, you can use the
Control key as a single use shortcut to temporarily disable the Internet Explorer 7
pop-up blocker. Simply hold down the Control key while clicking on any web link.

IBM Omni-Channel Merchandising education and Training
IBM Omni-Channel Merchandising Education offers in-depth training sessions on
all software services.

You may attend release training by viewing e-presentations that explain the new
features for each release. These are available via a web-based e-learning system
which is available to you anytime that is convenient for you. Contact your project
leader or your IBM Omni-Channel Merchandising trainer for more details.

Documentation questions and comments
IBM Omni-Channel Merchandising encourages you to contact us with any
suggestions, ideas, questions or comments regarding the Online Help.

IBM Omni-Channel Merchandising encourages you to contact us with any
suggestions, ideas, questions or comments regarding the Online Help. You can
reach the Technical Publications team directly at jessicae@us.ibm.com.
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Chapter 10. Glossary

This glossary includes terms used throughout the application.

Activity-Based Costing: An accounting system that allocates costs of all activities
to each item (rather than spreading costs uniformly across all items, which is what
simpler methods like traditional cost accounting do), so that you know exactly
how much it costs to sell an item once you include all supply chain costs such as
transportation, labor, and overhead.

Accrual Fund: Either an allowance, or a funding method used to allocate trade
funds to accounts. When it is applied as an allowance, the manufacturer agrees to
pay the retailer a set amount for every case that they buy during the year (this can
include all base volume and all promoted volume). In return, the retailer agrees to
run a set number of promotions for the manufacturer throughout the year. The
difference between an accrual fund and a case allowance is that, with the accrual
fund, one deal is done for the entire year's worth of promotions, and with the case
allowance, different terms are negotiated for each event.

When the accrual fund method is used for trade fund allocation, it is used to
decide how many trade funds will be allocated to a specific account. Retailers
usually set accrual funds aside to fund only promotions.

Ad: Promotion of a good in various media channels, including print, radio, and
television.

Ad Allowance: A dollar amount that the retailer receives for every case that the
retailer purchases from the manufacturer (paid after the ad has run).

Ad Zone: A collection of stores that offer the same advertised promotion.

Allowance: The amount of discount that the retailer receives from the
manufacturer. There are two types of allowance: performance allowance and
non-performance allowance.

Assortment: The mix of items that retailers stock. They periodically review their
assortment to figure out which items should be discontinued, and which new
items should be added.

Backhaul: A term used in logistics when a truck picks up another load for a return
trip after unloading its original haul.

Backhaul Allowance: The manufacturer provides the retailer with a backhaul
allowance based on every case of product that the retailer collects from the
manufacturer's warehouse using contracted trucks.

Base Price: The regular non-promoted shelf price.

Basis Point: A basis point is the smallest measure used to quote financial return.
One basis point equals one one-hundredth of a percent. For example, the difference
between a net profit margin of 2.25% and 2.50% percent is 25 basis points.

© Copyright IBM Corp. 2002, 2016 169



Bayesian Inference: A highly sophisticated approach to statistical modeling that is
useful in sparse data environments. Bayesian Inference is based on theories by Rev.
Thomas Bayes, who lived over 200 years ago. Phil Delurgio is one of a handful of
experts outside academia experienced in building large scale, robust Bayesian
models.

Bayesian Shrinkage: A Bayesian methodology whereby information is borrowed
across products and stores in order to intelligently "shrink" model estimates and
moderate extreme values.

BOGO: "Buy One Get One" Free. A promotion tactic often used to give consumers
an incentive to buy and stock up on a product.

Blocks: See Store Zones.

Brand: The name (usually trademarked) that a manufacturer assigns to a group of
items. The brand name is not always the same as the manufacturer name, since a
manufacturer can own several brands. For example, Clorox brands include: Clorox,
Pine-Sol, Armor All, Brita; Proctor & Gamble brands include: Tide, Mr. Clean, and
Cover Girl.

Brand Class: Classifications of brands. Brand classes let you create brand
relationships between products so you can set rules for optimizations. For example,
you might put generic sodas in a Private label brand class and Coke in a National
label brand class.

Brand Class Rule: A constraint applied between brands that dictates their price
relationship. Example: Premium brands are always more expensive than economy
brands.

Brand Family: Brand families let you further define subsets of a brand class. For
example, you might have Coke and Pepsi products in a National label brand class
and Generic soda A and soda B in a Private label brand class. To set a rule that
controls the price relationship between Coke and Generic soda A, you must put
the Coke products in a Coke brand family and Generic soda A in a Generic A
brand family.

Brand Manager: The Brand Manager charts the strategy and tactics surrounding
the Brand plan (for example, which new products get developed, and which
marketing mix events will occur). The marketing research department supports the
Brand Managers.

Business Rules: Constraints on the optimization that allow rules to describe
strategies or policies that are important in guiding the outcome of the optimization
to suit the customer's needs.

Cannibalization: The negative effect on sales of a product when a consumer buys
one product instead of another (often due to pricing, promotion, or new desirable
attributes). For example, when a new flavor of yogurt is introduced, it may
cannibalize sales of other flavors or brands of yogurt. While consumers may not
buy more yogurt overall (category expansion), they may alter the choice of their
usual product for the new one.

Category: A collection of related products that are substitutes or complements.
Retailers use categories to group and manage products (for example, produce,
dairy, and frozen foods).
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Category Manager: A person responsible for all merchandising activities for a
category of products, including price, promotion, placement, and assortment.

Category Plan: All promotions for one category that intersect in time with a
specified date range. They are the basis for category predictions and forecasts, and
allow accurate what-if analyses of different promotion plans.

Chain: A branded collection of stores with one owner (for example, Longs, and
Winn-Dixie).

Client: The user-interface application installed at the customer site.

Coefficient: A number representing the relationship between a dependent variable
(for example, sales volume or share) and an independent variable (for example,
base price or discount).

Comp Shop: A technique used by retailers to find competitor prices. For example,
if Longs has Dove soap on its "comp shop list", or if Longs "comp shops" Dove, it
means that Longs regularly conducts store checks at competitor stores to make
sure that they meet or beat the competition's price on Dove. This is also referred to
as a Competitor Price Audit.

Competitive Prices: Prices that are perceived to be a good value compared to what
the competition is charging.

Competitor Prices: Prices that the competition (other stores that consumers could
choose to shop instead) is charging for the same items.

Competitor Price Rule: An example of a business rule, this feature allows users to
enforce rules that ensure that prices are competitive. For example, you could
impose a rule that says prices on cereals are within 5% of competitor prices.

Complementary Products: Items that consumers usually buy together. The classic
example is hot dogs and hot dog buns.

Constraint: A rule that forces the optimization to generate results that fall within a
certain range.

Consumer: A person that buys items at a store.

Consumer Demand Model: A system of equations that predicts how much
consumers will buy depending on factors such as price, seasonality, and
promotions.

Consumer Response Model: See Consumer Demand Model.

Consumer Loyalty: The affinity that consumers have for a product or retailer that
makes them more likely to purchase a specific product, or shop at a specific store.

Contribution Margin: The dollars remaining after variable costs are subtracted
from adjusted gross margin. A more accurate measure of profit than gross margin.

Contribution Margin%: Contribution margin divided by revenue.

Cost of Capital: The costs associated with carrying merchandising inventory.
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Cost of Goods: The amount of money that the retailer pays the manufacturer for
the product. It can be specified in terms of a case, pound, unit, or ounce, for
example.

Cost Per Incremental Unit: Original price minus promoted price plus any trade
funds.

Cross-Elasticity: The relationship between the purchase of one product and the
purchase of another. If the products are completely independent, the cross-elasticity
is zero. If products are complementary, the cross-elasticity is positive. If products
are substitutable, the cross-elasticity is negative.

Cross-Elasticity of Demand: See Cross-Elasticity.

Deal: Promotional pricing for a good.

Demand: The amount of a product that will be purchased at a particular price.

Demand Curve: Demand over a range of prices over a period of time.

Demand Group: A collection of highly substitutable products. The price and
promotion of one item in the group directly affects demand for the other items.

Discount Price: The sale price of a product (also known as Temporary Price
Reduction).

Display: A form of in-store promotion to draw attention to a particular product or
line of products.

Drop Ship Method: When middlemen avoid carrying costs of inventory by
sending single unit orders for products to manufacturers (or major stocking
distributors), who drop ship the merchandise directly to the customers of the
middlemen.

DSD: Direct Store Delivery. Shipment from manufacturer to retail store which
bypasses any middlemen such as distributors or wholesalers.

EDLP: Every Day Low Pricing. Wal-Mart is the leader in EDLP, building trust
among consumers by offering low prices every day. Others choose to have higher
everyday prices but promote or discount heavily.

End Cap: A display at the end of an aisle.

Equivalent Retail Price: Price per equivalent unit, calculated by taking shelf price
divided by the standardized unit of measure.

Equivalent Unit: A standardized unit of volume using equivalization.

Equivalization: The assignment of a standardized unit of measure to a product
based on the product's description and the spread of sizes/counts that apply to
that description. This allows direct comparison across a wide range of sizes. For
example, both one case of Coke and two 12-packs of Coke = 1 equivalent case.

Event: A group of promotions arranged around a theme. They are used to group
promotions for long-term planning, the creation of media such as circulars, FSIs,
advertisements, wraps, and event-specific planning meetings.
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IBM Price Optimization and Price Management: IBM Omni-Channel
Merchandising software system that helps retailers and manufacturers maximize
profits by setting the optimal price for every product in every store.

Financial Modeling: A process that enables retailers to understand the cost drivers
of their business, including fixed and variable supply chain costs. See
Activity-Based Costing.

Fixed Cost: A cost that does not vary depending on production or sales volume.

Flat Fee: A lump sum of cash that the manufacturer pays to the retailer to secure a
display or an Ad. It can be viewed as the fee for renting the display space or for
the ad space even though it is not a direct payment for either one.

Forward Buy: The purchase of an amount of product that exceeds immediate
needs to take advantage of favorable pricing offered for promotions.

Gross Margin: Revenue minus product cost.

Gross Margin%: Gross margin divided by net sales, expressed as a percentage.

Gross Margin Rule: Constraint requiring optimization results to be within a gross
margin range.

Gross Profit: See Gross Margin.

Gross Profit%: See Gross Margin%.

Incremental Value: Forecasts the promotion's incremental profit change and cost
per promoted product value by stripping out everyday business results. It is often
considered the true indicator of a promotion's worth.

KPI (Key Performance Indicators): A set of measurements to assess success
against predefined core objectives.

Labor Rate: An hourly labor cost including wages and benefits.

Last Digits: The digits in a price after the decimal point.

Line Pricing: Assigning a group of similar products the same price, usually across
flavors (for example, 6 packs of soda, or all boxes of Jello).

Loyalty Card Program: A program that consumers sign up for to enjoy discount or
reward programs in return for tracking of consumer behavior patterns. Also called
Frequent Shopper Program.

Magic Price: A price at which demand increases dramatically. For example, pricing
a 6-pack of soda at $1.99 may result in an unusually high demand vs. pricing it at
$2.00.

Markdown: The amount by which a price is reduced to boost sales.

Merchandising: The promotion of products, including coordinating production
and marketing, and developing advertising, display, and sales strategies.
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Multiples: Price statements in which multiple products are offered at a particular
price, for example 2 for $1.00.

Net Margin: See Net Profit.

Net Margin%: See Net Profit%.

Net Profit: Gross sales minus cost of goods sold, cost of operations, taxes, interest,
and depreciation.

Net Profit%: Net profit divided by revenue.

Non-Performance Allowance: Additional funding from the manufacturer to the
retailer that is not tied to promotions. Freight allowance, backhaul allowance,
spoilage allowance, and buying allowance are some examples.

Offer: The proposal that a manufacturer makes to a retailer about the products
that should be promoted, the manner in which these products should be promoted
(for example, Ad, Display, or TPR), the time in which the products should be
promoted, and the amount of money that the retailer will receive from the
manufacturer (in a lump sum of cash, or as a saving off of the cost of the product,
which are referred to as the deal terms).

Optimization: The process of finding the best formula (for example, prices,
product mix, and promotion plan) for achieving a given merchandising objective.

Overhead: All operational costs other than supply-chain costs.

Overhead Allocation: The amount of overhead costs attributed to a particular
product.

Panel Data: Tracking of individual consumer behavior over time to assess
individual consumption patterns, impact of promotions, and switching behavior.

Pantry Loading: The act of stocking up on a product because it is on sale or
promotion. Also known as Time Cannibalization or Stockpiling.

Performance Allowance: A discount that a retailer qualifies for after performing a
promotion. There are two main types of performance allowances: Case Allowance
(based on the amount of product that is shipped from the manufacturer to the
retailer - shipment -based); and Scan Allowance (based on the amount of product
bought by the consumer from the retailer - consumption-based).

Performance Period: The period of time that the promotion will run. It is the time
when the promotion is performing, for example, when the product is on Display,
Ad, or TPR.

POS Data: Point of Sale information that is collected by scanners upon check-out.
POS Data shows the date, volume, and purchase price for all items sold.

Pre-Price: Products that have a price stamped on the packaging by the
manufacturer.

Price Check: Confirmation of the selling price or retail price for a product.
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Price Elasticity of Demand: The rate at which demand changes for a change in
price. Change in demand divided by change in price.

Price Gap: The price difference between two similar products.

Price Image: The consumer perception of a retailer's prices and value.

Price Zone: Group of stores that always have the same prices across products.

Product Costs: The wholesale cost, or vendor cost, that a retailer pays a
manufacturer.

Product Cube: The volume of space occupied by a product, expressed in cubic feet.

Product Elasticity: Price elasticity of demand for a particular product.

Product Groups: A group of products for a IBM Omni-Channel Merchandising
user.

Product Pairs: A set of two products that have a promotional constraint established
between them. For example, Dial White Bar Soap 3CT should be priced at 90% of
Dial Gold Bar Soap 3CT.

Product Share: The ratio (in terms of percentage) of the revenue of an individual
product (SKU) to the total revenue in one store.

Product Storage Type: The location in the store that houses a product. IBM
Omni-Channel Merchandising values equals shelf (frozen or refrigerated).

Profit: Revenue less variable costs, fixed costs, and ABC costs.

Promotion: A temporary product price adjustment and/or consumer benefit tied
directly to the purchase of a product.

Promotion Planning & Optimization: The IBM Omni-Channel Merchandising
software service that helps retailers and manufacturers optimize product
promotion decisions.

Replenishment Frequency: The number of times that store or DC inventory is
replaced in a given time period.

Retail Price: The selling price or shelf price a consumer pays for a product.

Return on Trade Funds: The incremental value of the promotion (value of the
promotion less everyday business) divided by trade dollars.

Revenue: The amount of sales in terms of dollars or local currency collected from
consumer or business-to-business transactions.

ROI: Return on investment (after-tax operating income/ net (depreciated) book
value of assets).

Sales: See Revenue.

Sales Volume: The number of units of products sold in consumer or
business-to-business transactions.
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Same-Store Sales: Same-store comparisons measure the growth in sales, excluding
the impact of newly opened stores.

Scanner Data: POS data collected by a barcode scanner. See POS Data.

Scenario: A set of constraints and rules applied to product, store, price, and cost
data that is optimized to achieve a particular business objective in terms of profit,
revenue, and volume. The term "scenario" may be synonymous with "promotion".

Seasonality: An underlying trend in consumer behavior based on the time of the
year (for example, the impact of Thanksgiving holiday on the purchasing behavior
of turkey).

Shelf Depth: The amount of space between the front of a shelf and the back of a
shelf.

Shelf Height: The vertical clearance of a shelf.

Shelf Width: The horizontal clearance of a shelf.

Single Product Rules: Optimization constraints applied to one product or SKU.

Size Class: An attribute assigned to a product to place the product in a particular
group based on size, volume, or weight. Size classes let you create size
relationships between products so you can set rules for optimizations. The
allowable size classes are XXX-Small through XXX-Large.

Size Family: Size Families let you further define subsets of a Size Class. For
example, you might have 12oz. Coke in a Small Size Class, and 16oz. Coke in a
Medium Size Class. To create a rule between the two, such as the 16oz. Coke is
always more than the 12oz., but not more than double the price, you must create a
Size Family named Coke. If you do not create that Size Family, the rule would end
up applying to all products in the 12oz. and 16oz. Size Class.

Size Group: A classification of a group of products based on their relative sizes
(for example, 0-8 oz = small, 9-12 oz = medium, >12 oz = large).

Size Rule: A predefined relationship between two similar products based on their
respective volumes, weights or counts.

SKU: Stock Keeping Unit. It is a number that a retailer assigns to a product.

Slotting Fees: The fees a retailer charges a manufacturer to insert or "slot" a new
product onto shelves.

Store-For-Store Sales: See Same-Store Sales.

Store Groups: A set of individual stores that should be treated as one unit to
achieve a business goal (for example, Region).

Store Traffic: The number of shoppers per unit of time.

Store Zones: A group of stores that share a set of prices. Also called Zones, Store
Prize Zones, or Blocks.
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Strategy: A set of pricing and promotion initiatives or activities that complement
each other to achieve a particular business goal.

Substitute Products: Products that consumers perceive as having the same or
similar utility. A substitute product is one that a consumer would purchase in lieu
of another product without giving up a significant amount of perceived value.

Time Horizon: A promotion's time span.

Time Series: A set of values of a variable at periodic points in time.

TPR: Temporary Price Reduction. A reduction in the consumer price of a product
for a temporary period of time.

Trade Funds: Funds offered by a manufacturer to a retailer for the promotion of a
set of products, also referred to as Trade Spend. These funds are usually allocated
to pay for promotional activities on the part of the retailer, including Ads,
Displays, and Temporary Price Reductions (TPR).

Trend: An underlying relationship within a group of data points.

Two Product Rules: A constraint or rule relating two products together.

Unit of Measure: The type of size measurement.

Unit Sales: See Sales Volume.

UPC: Universal Product Code. A number and bar code that uniquely identify an
individual consumer product issued by the manufacturer. The IBM Omni-Channel
Merchandising standard is 14 digits.

Variable Cost: An expense that is associated with producing, stocking, or
purchasing a SKU.

Vendor/Manufacturer: The company that makes the goods that the retailer buys.
The vendor considers three main merchandising activities when deciding how to
plan their promotion calendars and construct their offers: Displays, Ads,
Temporary Price Reductions (TPR).

Vendor Cost Change: Manufacturer-driven change in the purchase price of a
product.

Volume: The number of units sold for a particular SKU.

Volume Rule: A constraint on the volume range for a given product or group of
products within an optimization.

What-Ifs: Varying key assumptions to determine how the end results of an
analysis differ.

Zone Prices: Common prices implemented across multiple stores in an account.

Release
Planned set of new functionality for IBM Omni-Channel Merchandising
application suite that becomes available to all users on a specified date.
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Chapter 11. Quick Reference Guide

This section serves as a summary of all the key commands and features in IBM
OpenLink.

This section serves as a summary of all the key commands and features in IBM
OpenLink.

Related Topics

“Attributing Process”
“Using the PIF vs. the OpenLink UI” on page 181
“Demand Group Hints” on page 182
“Size/UOM Hints” on page 182
“Dropping (not included in model)” on page 182
“Product Information File (PIF) General Notes” on page 183
“PIF Details” on page 183

Attributing Process
The attributing process can be broken down into 11 basic steps.

The attributing process can be broken down into 11 basic steps.

Description Notes Tool

1 Approve/Reject
Category Moves

Check
"Uncategorized"
category for
orphaned products.

OpenLink

2 Run Product Status You do NOT need to
run the Product
Status if your
company sends a
status file each week.
Be sure to run the
PSR before
conducting the Price
Update process to
ensure products have
an updated status.

OpenLink

3 Export PIF Access the PIF
(Product Information
File) via the
automated message
in email or in the
application Inbox.

OpenLink
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Description Notes Tool

4 Edit Content Using
PIF

v Demand Group

v Size

v UOM

v Brand

v Included in Model

v Size Family**

v Size Class**

v Brand Family**

v Brand Class**

v Pre-Price**

v Line Group**

v Other Family 1 & 2
**

v Other Class 1 & 2
**

A PIF is an Excel
spreadsheet and
should be treated as
such. Any Formula
must be removed
before importing the
PIF back into
OpenLink. Do not
delete any rows from
the Product
Information File. If
products should not
be modeled, drop
them from the PIF.

Note: Line Group,
Pre-price, Size
Family/Size Class
and Brand Family/
Brand Class and
Other Family/Other
Class values can be
added to the
configurable PIF for
scenario preparation
purposes only; they
are not needed for
the modeling process.

Excel PIF

5 Import PIF Remove formulas
before importing the
PIF back into
OpenLink. Limit the
length of the file
name for import.
Check the import
automated message
for potential errors.

OpenLink

6 Run Equivalent Units Be sure that # with
POS to be
Equivalized is 0
before submitting
category to modeling.

OpenLink

7 Conduct Integrity
Checks

Use the Category
Breakdown reports:
Brand and Demand
Group aggregation.
Accept or fix errors
as needed.

OpenLink

8 Edit Content (if
applicable)

Double check brand
names and fix issues
from Equiv. Units as
necessary. This step
may prompt several
steps above to be
completed again.

OpenLink
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Description Notes Tool

9 Complete Demand
Group Relationships

If relationships do
not exist between
Demand Groups, the
Demand Group
Relationships matrix
does not need to be
completed. Found in
the Category
Manager page.

OpenLink

10 Mark Products as
Attributed

Marks products as
attributed. This also
"resets" the # of
Unattributed column
to zero so that new
products can be
easily identified after
initial attributing is
sent to IBM
Omni-Channel
Merchandising
statistician.

OpenLink

11 Set Category Status Alerts the IBM
Omni-Channel
Merchandising
statistician that the
category is ready to
be modeled.
Statistician receives
an email if
subscribed to receive
this alert notification.

OpenLink

Using the PIF vs. the OpenLink UI
Use this procedure to know when to use the PIF and when to use the Edit Content
functionality.

Use the PIF when:
v New Demand Group names must be established, usually occurring when/if the

following are true:
v The first time a category is Attributed
v A new product line is introduced to the category
v Greater than 1 year has elapsed since the last Attributing
v Attributing could be better accomplished ‘off line”, using the PIF
v Excel spreadsheet (e.g., out of the office, if the UI is unavailable, etc...)

Use Edit Content when:
v New Products need to be attributed for Price Maintenance.

Note: The new products must be entered into an existing demand group.
v Correcting Brand names (use the ‘Category Breakdown’ feature)
v Fewer than 20 products need to be attributed
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Demand Group Hints
Use this reference to further understand Demand Groups.
v Remember, Demand Groups are HIGHLY substitutable products.
v Products within a Demand Group should be relatively close in price and price

per UOM.
v Demand Groups may have suffixes to separate products which could belong in

the same Demand Group, but where price points are not equitable.
v PRM = Premium (higher price point, considered the best quality, designer

products)
v REG = Regular (Good products, average price point products)
v ECON = Economy (lower price point, considered the poorest quality, entry-level)
v TS = Trial size (typically merchandised in a separate part of the store)
v IND = Industrial or institutional size (not ‘highly substitutable’ with regular size

products)
v Separate Trial Size and Industrial Size products into their own Demand Group.
v Limit the use of 1-product Demand Groups to extreme circumstances.
v Remember, products within a Demand Group cannibalize each other

symmetrically. If asymmetric relationships exist within a Demand Group,
separate products into two Demand Groups and control relationships through
the Demand Group Relationship matrix.

Size/UOM Hints
Use this reference to further understand Size/UOM.
v UOMs should be consistent within a Demand Group.
v Trial Size or “Bonus” products should not be included in Size family/Size class

relationships.
v Sizes may need to be changed to reflect what the customer is truly purchasing

(e.g., Laundry detergent ounces to loads).

Dropping (not included in model)
Use this procedure to drop a product in the PIF.

You should NEVER delete a product from a PIF. Instead “drop” the product from
the PIF, which means that it will not be modeled.

To drop a product in the PIF:
v Change the Included in Model column to “No.”

What products should be dropped?
v Non-saleable Products
v Outdated Products
v Statistically insignificant Products (all 3 criteria must be met):
v Customer Status = discontinued
v Last Scan > 90 days before last scan for category
v Average Weekly Volume is VERY low
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v Products with no POS – Products lacking POS will not be modeled. These
products can be ‘dropped’ from the PIF or should be linked to existing products
if they are new/active products.

Product Information File (PIF) General Notes
Use this as a reference for PIF.
v Do not delete information from the PIF. If products should not be modeled, drop

them.
v PIFs should not contain any formulas to be successfully imported into DT

OpenLink.
v Only the first spreadsheet in the Excel workbook will be imported into DT

OpenLink. Delete any additional sheets containing pivot tables or formatting
prior to PIF import.

v PIFs can contain additional columns when importing. The import is looking for
the column headers so, don’t delete those!

v You can also re-order the PIF columns. The import does not care about the order,
just the first two rows of the column (the names of the column).

v Remember, once the PIF is imported, any changes you make in the OpenLink
application will NOT be reflected on your saved PIF excel spreadsheet. It is
recommended to re-export your complete PIF when you are finished with the
category.

PIF Details
Use this reference to further understand PIF Details.

PIF Attributes:

Note:

Name Description How to Complete Source

Ref UPC UPC from retailer Do not change UPC as defined by
the retailer

Ref Customer
Product Key

Retailer product
numbering system. If
not available, will
default to UPC.

Do not change UPC or retailer ID as
defined in map

Included in Model Place to "drop"
products so that they
will not be included
in the model. These
products are also not
in the scenario.

Change to "No" if the
product should not
be modeled

Default is Yes

Description Product description
to be sent to
Everyday Price
Management

Typically, is not
changed

Retailer description.
If retailer has more
than one description,
check with map.
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Name Description How to Complete Source

Demand Group Collection of highly
substitutable
products

Alpha-numeric, 50
characters maximum,
no spaces (use
underscore to
separate words).
Must begin with an
alpha character.

Default is
DEFAULT_demand
group

Size Size (Volume of
Measure) to be used
for Modeling at the
retailer/division/
category level. This
size can be inferred.

Numerical. If "free or
bonus" product,
include base size +
amount "free".

Retailer's product file

UOM Unit of Measure used
for Modeling and
Optimization. Should
be consistent within a
demand group.

Alphabetic

CT, OZ, LOAD,
SHEET, LB

Retailer's product file

Brand Corrected/inferred
brand to be used for
modeling. Brands can
be streamlined in the
PIF or on the
OpenLink Category
Breakdown page.

Alphabetic only, no
spaces or illegal
characters (&, /, "", *)

Retailer's product file

Ref DT Status Determined by
aggregating the
results of the Product
Status Resolver rules.

Do not change Result of Product
Status Resolver, if
run

Ref Customer Status The product status as
it is sent from the
retailer.

Do not change Retailer's location
status file; defaults to
ACTIVE if no value
is sent

Ref Current Retail Summary Statistic:
Average of current
retail price over the
last 12 months across
stores, if loaded

Do not change Retailer's price file

Ref Avg Scan Price Summary Statistic:
Volume-weighted
Average Scan price
over the last 12
months

Do not change From POS scan data

Ref Price per UOM Summary Statistic:
Price per UOM as
divided by
information on PIF

Do not change Calculated on PIF
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Name Description How to Complete Source

Ref Avg Weekly
Volume

Summary Statistic:
Average Weekly
Volume over the last
12 months across all
stores at chain level.

If the application
does not have a
record for a week,
the volume is not
counted as zero.

Do not change From POS scan data

Ref Cost Summary Statistic:
Cross store straight
average of cost sent
in the Current Cost
file, if available.

Do not change From POS scan data

Ref First Scan Date Date product first
scanned (across all
stores)

Do not change From POS scan data

Ref Last Scan Date Date product last
scanned (across all
stores)

Do not change From POS scan data

Product ID An IBM
Omni-Channel
Merchandising
assigned unique SKU
ID

Do not change System assigned

Highlighted rows indicate fields which should be completed in the PIF.

Name Description How to Complete Source

Size Class Applied in IBM
OpenLink or IBM
Price Management.
Each item in a Size
Family is given a
number/level: 8 oz =
SMALL, 16 oz =
MEDIUM, 24 oz =
LARGE

Allowable Size Class
formats are size
classes that are
defined for the
category in IBM Price
Management. If the
Size Classes have not
yet been defined, use
the default Size
Classes
(XXX-LARGE,
XX-LARGE,
X-LARGE, LARGE,
MEDIUM, SMALL,
X-SMALL, XX-
SMALL,
XXX-SMALL), which
can later be modified
in IBM Price
Management. 50
characters maximum.

Do not include Bonus
products or
Trial/Travel sizes in
Size Class.

Blank
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Name Description How to Complete Source

Size Family Applied in OpenLink
or Price. Size Family
is used to set rules
for pricing on how
different sizes of the
same product should
be priced on an
absolute basis (for
example, Small <
Medium < Large),
and on a relative
basis based on the
equiv price (for
example, the large
should be a better
value than the
medium.

Alphabetic,

50 characters
maximum

Blank

Brand Class A value which
differentiates two
products with a
family. In this case,
Brand Class
differentiates
products within a
Brand Family.

NATIONAL,
PRIVATE LABEL, or
define as needed, 50
characters maximum

Retailer's product
file, usually blank

Brand Family A value which links
two products
together for the
purpose of
comparison through
rules. The Brand
Family is usually the
type and size of the
product being
compared across
brands.

Alphabetic, no illegal
characters (&, /, *),
50 characters
maximum

Retailer's product
file, usually blank

Pre Priced Indicated pre-priced
product, supplied by
the retailer.
Populated with a 1 if
the product is
pre-priced. A
pre-priced product
will NOT change
price during the
course of the
optimization.

Pre-priced product =
1

Non-prepriced
product = 0

Default is 0; if the
value comes from the
retailer a value of 1
indicates a pre-priced
product

Line Group Line price group
value sent by retailer.

Alpha-numeric, no
spaces or illegal
characters (&, /, *),
50 characters
maximum

Retailer's product file

Other Family/ Other
Class 1&2

Establish other
relationships when
Brand Family/Class
is already being
leveraged.

Define as needed Blank
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Name Description How to Complete Source

Ref Level 1-12
Code/Desc

Generally product
hierarchy fields from
host system. May
help outline Demand
Group structure.

Do not change From Retailer data

Ref Attribute

0-9

If you send Location
or SKU attribute
values in your
location or product
file (typically sent by
your IT dept), you
can choose to
populate these values
on the PIF using the
attribute field on the
product table.

Do not change From Retailer data
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing IBM Corporation North Castle Drive Armonk, NY
10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing Legal and Intellectual Property Law IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
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IBM Corporation

1001 E Hillsdale Blvd.

Foster City, CA 94404

USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.

Other product and service names might be trademarks of IBM or other companies.

A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.
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